
 

Business Information Warehouse 

Reporting & Analysis 
 
 

        



BW Reporting and Analysis  2 

 
 
 
 
 
Course Contents 
 
 
Course Overview  

Unit 1:  Introduction to BW Reporting 

Unit 2:  Navigating in Reports 

Unit 3:  Business Content  

Unit 4:  First Steps in the BEx Query Designer  

Unit 5:  Calculated and Restricted Key Figures  

Unit 6:  Characteristics  

Unit 7:  Variables  

Unit 8:  Query Properties  

Unit 9:  Exceptions and Conditions  

 

 

 
 



BW Reporting and Analysis  3 

Course Overview  
 
The Business Explorer (BEx) is a component of the SAP Business Information 
Warehouse (SAP BW) that provides flexible reporting and analysis tools that you can 
use for strategic analysis and supporting the decision-making process in your 
organization.  You can use the BEx tool to display past and present data in differing 
levels of detail and from different perspectives, on the Web and in Microsoft Excel. 
 
In this course, you learn about the basic functions of SAP BW reporting, starting with 
navigation in existing reports, continuing on to creating your own query definitions in 
the Query Designer, and taking you through to using analyses on the Web and in 
mobile reporting. 
 
Target Audience 
 
This course is intended for the following audiences: 
 
• Project team members with a basic knowledge of data warehousing 
 
Course Prerequisites 
 
Required  Knowledge 
 
• Basic knowledge of data warehousing 
 
Recommended  Knowledge 
 
• Basic knowledge of HTML 
 
Course Goals 
 
This course will prepare you to: 
 
• Use SAP BW as a flexible analytical tool and structure reports for decision-making 

support in your organization. 
• Evaluate past and current data to different levels of detail and from different 

perspectives on the Web and in Microsoft Excel 
• Use the BEx Web Application Designer to create HTML pages with SAP BW- 

specific contents and save the Web applications as URLs 
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Course Objectives 
 
After completing this course, you will be able to: 
 
• Analyze reports in the Business Explorer Analyzer (BEx Analyzer) and on the Web 

by using the navigation functions 
• Outline the architecture and reporting structure in SAP BW 
• Activate queries from Business Content and use them in reporting 
• Evaluate the data set in the Business Information Warehouse by defining queries 

using the BEx Query Designer and executing them in the BEx Analyzer and on the 
Web 

• Use the BEx Web Application Designer to create HTML page that contain SAP BW-
specific contents and different tables, charts, or maps 

 
SAP Software Component Information 
 
The information in this course pertains to the following SAP Software Components 
and releases: 
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Unit 1 
 
Introduction to BW Reporting 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Describe the fundamental structures of SAP BW 
• Explain the reporting functions of SAP BW 
• Define the most important terminology used in reporting 
 
Lesson:   SAP BW Overview 
 
Lesson Overview 
 
This lesson deals with the fundamental structures of the SAP Business Information 
Warehouse. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Describe the fundamental structures of SAP BW 
• Explain the reporting functions of SAP BW 
• Define the most important terminology used in reporting 
 
Business Example  
 
You need a good overview of the structures and important terms in SAP BW in order to 
be able to use the available functions. Use this overview to reinforce the BW functions 
in the following scenarios, and to develop solutions. 
 
Data Warehouse System 
 
A data warehouse system serves primarily to stage information from various data 
sources.  This data and information, and the reports resulting from them, constitute the 
basis of successful business processes within a company. This type of system can be 
used by all employees in a company (that is, by managers, departmental heads, and 
all other employees). 
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Data Warehouse System 
 
The information is staged in various forms including personalized reports, freely 
definable queries, and predefined reports. Recipients of information can use these 
reporting and analysis functions to analyze the data for deviations and significant facts.  
In the Planning and Campaign Management areas, a data warehouse is used to carry 
out data analysis. The following issues might arise when using a data warehouse in the 
Retail Sector area: 
 
• Checking ranges of goods in order to identify slow moving items and big sellers 
• Analyzing regional locations to investigate the profitability of different branches  
• Investigating the effectiveness of market analyses 
• Evaluating customer surveys and complaints  
• Analyzing warehouse stock levels  
• Analyzing shopping carts using cash register receipts 
 
A concrete query might be: 
 
• What were the sales volumes for the Cosmetics, Electrical Goods, and Household 

Goods departments in the years 2000 and 2001 in New York and Washington DC? 
 
In brief, a data warehouse can: 
 
 
• Pool data from different, mostly heterogeneous sources 
• Overcome this heterogeneity on different levels (system, schema, and data)  
• Stage data in the form required by the user 
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What We Expect from a Data Warehouse 
 
Decision-makers urgently need reliable information from Production, Purchasing, Sales 
and Distribution, Finance, and Human Resources departments.  They require an up-to-
date and comprehensive picture of each individual business area and of the business 
as a whole.  This places considerable demands on data staging from the underlying 
data sources. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



BW Reporting and Analysis  8 

What We Expect from a Data Warehouse 
 
The information must be stored in a homogeneous and consistent form at a central 
location where it can be called up. Therefore, modern data warehouses require a 
separate database that an independent application environment can use to provide the 
required services objectively. 
 

Efficient analysis techniques with powerful multi-dimensional visualization are 
indispensable on the presentation side of the data warehouse. The system must be 
able to cope with the information needs of the various user groups.  
 
The demands made on the source systems are not so high.  What is needed here is 
an economic and comprehensive preparation of the data that is required by the data 
warehouse. 
 
The following demands are made on a data warehouse: 
 
• Standardized structuring and presentation of all company information  
• An easy-to-use, single-point of access to all company information 
• Sophisticated business reporting methods for self-service analysis at all levels  
• Fast and cost-effective installation  
• A high performance environment 
• Data staging from heterogeneous environment  
• Release of source systems and IT organization  
• Data access independent of the source system 
• Analysis of data over a specific period of time, and the storage of historical 

information (time-dependent master data) 
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SAP Business Information Warehouse  
 
The SAP BW allows you to analyze data from operational SAP R/3 applications or any 
other business application. You can also extract and analyze data from external 
sources such as databases, online services, and the Internet. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
SAP Business Information Warehouse 
 
The system (data storage, loading and reporting), which is preconfigured by Business 
Content for core areas and processes, allows you to examine the relationships in every 
area of your company. 
 
The realization of SAP BW aimed for the following: 
 
• Data warehousing system with optimized data structures for reporting and analysis  
• Separate system 
• OLAP engine and tools  
• Comprehensive data-warehousing architectural base  
• Automated data warehouse management 
• Preconfiguration using SAP global business know-how 
 
With these goals in mind, SAP has opted for a separate data-warehousing solution 
that handles reporting activities as an autonomous business component, even 
providing a separate server with its own database and SAP system:  SAP Business 
Information Warehouse. 
 
All of the requirements and objectives mentioned so far have been met in the 
conception and architecture of SAP BW. 
 
Having implemented SAP BW and its metadata repository (description of data), the 
customer has the clear advantage of being able to use the entire SAP know-how built 
up over the many years of experience in developing business software solutions.  SAP 
R/3 systems can be configured as source systems, and provide data for all SAP 
Business Content.  This is described later in more detail. 
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Terminology and Objects in SAP BW 
 
Now, an introduction to the important terms that are used in SAP BW will allow you to 
obtain an overview of terminology.  This overview will be consolidated for the individual 
topical areas in the corresponding units of SAP BW courses. 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Terminology I 
  
InfoObject 
 
Business analysis-objects (customers, sales volumes, and so on) are called 
InfoObjects in SAP BW. These InfoObjects can be divided into characteristics and key 
figures.  Characteristics can be further divided into units, time characteristics, and 
technical characteristics (for example, request ID). Key figures are all data fields that 
are used to store values or quantities (sales volumes, kilowatt-hours, costs, and so 
on).  Characteristics describe the affiliation of key figures. For example, costs belong to 
a cost center, whereby the cost center is a characteristic. 
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Terminology II 
  
InfoCube  
The central data containers that form the basis for reports and analyses in SAP BW are 
called InfoCubes. They contain key figures (sales volumes, incoming orders, actual 
costs, and so on) and a link to the characteristics (master data of the SAP BW system 
such as cost centers, customers, materials, and so on). Key figures and characteristics 
are InfoObjects. Each individual InfoCube should contain a self-contained dataset, 
since queries refer primarily to one InfoCube. Master data in the BW system consists of 
attributes of a characteristic (for example, the person responsible for a cost center), as 
well as hierarchies and texts of a characteristic. 
 
An InfoCube consists of several database tables that are linked according to the star 
schema.  They include a fact table that contains the InfoCube key figures, as well as 
several surrounding dimension tables that store the links to the characteristics. 
 
• Each InfoCube has one fact table and a maximum of 16 dimension tables. 
• Each fact table can contain a maximum of 233 key figures. 
• A dimension can contain up to 248 freely available characteristics. InfoCubes are 

stored in structures in the SAP BW system. If you want to store an InfoCube, you 
create a new folder or use an existing one.  This is similar to the method used 
when storing data on your PC: These folders are called InfoAreas in SAP BW. 
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Terminology III 
  
InfoProvider 
 
InfoProvider is the super-ordinate term for an object that you can use to create reports 
in Business Explorer (BEx). InfoProviders are objects or views that are relevant to 
reporting. 
 
InfoProviders include various database metaobjects that deliver data for query 
definitions.  The type of data procurement differs depending on the InfoProvider used. 
However, the type of data procurement has no influence on reporting. InfoProviders 
deliver data that can be analyzed using a query. There are two types of data stores.  
Physical stores include: 
 
• InfoCubes        
• ODS Objects        
• InfoObjects       
 
Logical views of physical data stores include: 
 
• InfoSets       
• RemoteCubes  
• Virtual InfoCubes        
• MultiProviders       
 
The previous figure gives an overview of SAP BW reportable objects, divided into data 
targets that contain physical data, and InfoProviders that only contain logical views.  
From the BEx view, only InfoProviders are accessed. The way in which the data is 
modeled is inconsequential to the BEx toolset. Operational Data Store (ODS) 
 
An ODS, a data store, stores data at the basic level (document level).  It is normally 
used to resolve and consolidate datasets.  These datasets are often from various data 
sources and/or source systems. 
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Administrator Workbench (AWB) 
 
Administrator Workbench (AWB) is a workplace for SAP BW administrators. AWB 
functions are used to configure, control, and administrate SAP BW. 
 
 
Business Information Warehouse Architecture 
 
SAP BW enables the analysis of data from operative SAP applications as well as all 
other business applications and external data sources such as databases, online 
services, and the Internet. 
 
Business Information Warehouse Architecture 
 
AWB functions allow you to control, monitor, and maintain all data procurement 
processes. 
 
SAP BW enables Online Analytical Processing (OLAP) for staging information from 
large amounts of operative and historical data. OLAP technology permits multi-
dimensional analyses according to various business perspectives. The BW server, 
which is preconfigured by Business Content for core areas and processes, allows you 
to examine the relationships in every area within your company.  Business Content 
provides targeted information to companies, divided into roles.  This helps your 
employees to carry out their tasks.  As well as roles, Business Content includes other 
preconfigured objects such as InfoCubes, queries, key figures, and characteristics. 
These objects facilitate the implementation of SAP BW. 
 
The Business Explorer (BEx) component provides users with extensive analysis 
options. 
 
 



BW Reporting and Analysis  14 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Reporting in SAP BW 
 
BEx is the SAP BW component that provides flexible reporting and analysis tools that 
you can use for strategic analysis and supporting the decision-making process in your 
company.  Employees with access authorization can analyze historical and current 
data at differing levels of detail and from different perspectives.  They can use the Web 
or Microsoft Excel. 
 
BEx allows a wide spectrum of users to access information in SAP BW. This can be 
done in Enterprise Portal from an iView that you can call alongside the applications 
where you extract the data, in the Internet or Intranet (Web Application Design), or 
using a mobile device (for example, WAP-enabled mobile telephones, and personal 
digital assistants). Web Application Design allows you to implement generic OLAP 
navigation in Web applications and in Business Intelligence cockpits for both simple 
and highly-individual scenarios. Highly individual scenarios with customer-defined user 
interface elements can be realized using standard markup languages (HTML). Web 
Application Design encompasses a wide spectrum of interactive Web-based Business 
Intelligence scenarios that you can modify to suit your requirements using standard 
Web technology. 
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The following is an overview of BEx functional areas: 
Portal Integration 
• Single point of entry 
• Role-based staging of information 
• Personalization 
• Integration of unstructured data 
 
Query, Reporting, and Analysis 
• Query design using the BEx Analyzer Multi-dimensional (OLAP) analysis 

Geographical analysis 
• Ad-hoc reporting 
• Alert 
• Publication of iViews 
 
Web Application Design 
 
• Web Application Design 
• Interactive analytical content Information cockpits and dashboards Basis for 

creating analytical applications Creation of iViews for a portal 
• Wizard-based visualization 
• APIs for additional, highly individual Web design 
 
Formatted Reporting 
 
• Pixel-precise layouts 
• Wizard-based layout definition 
• Static, formatted reports 
• Form-based reports 
• Predefined Crystal reports in Business Content 
• Publishing on the Web 
• User-friendly printing options 
 
Mobile Intelligence 
• Online and offline scenarios Support of WAP devices and PDAs Automatic 

device recognition 
• Publishing using the Web Application Designer 
• Device-specific tasks 
• Alerts and charts 
• Integration in the mobile portal  
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The following explains the individual functional areas of BEx: 
 
 
Query, Reporting, and Analysis 
 
The data basis of SAP BW is divided into self-contained business data areas 
(InfoProviders). The user analyzes the SAP BW dataset by defining queries for the 
InfoProvider.  You can determine the way in which the InfoProvider data is analyzed by 
selecting and combining InfoObjects 
(characteristics and key figures) or reusable structures in a query. Data analysis based 
on multi-dimensional data sources (OLAP reporting) allows you to analyze more than 
one dimension of an InfoProvider (for example, time, place, and product) at the same 
time. This means that you can make any number of variance analyses (plan/actual 
comparison and business year comparison). The data, which displays in the form of a 
pivot table, is a starting point for detailed analysis in order to answer a myriad  of 
questions. 
 
Web Application Design 
 
You can use the BEx WEB Application Designer to create HTML pages that contain 
BW-specific content such as tables, charts, and/or maps. You can save the Web 
queries as uniform resource locators (URLs) and access them from the Internet, 
Intranet, or mobile devices. 
The Web Application Designer contains an assistant that is called the Web Application 
Wizard.  This Wizard supports you when creating Web applications by providing an 
automatic step-by-step process.  This simplifies the design process. 
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Formatted Reporting 
 
The integration of Crystal reports into SAP BW enhances the BEx functional area by 
allowing you to created formatted reports. Formatted reports mainly involve pixel-
precise layout design and user-friendly printing options. 
 
Mobile Intelligence 
 
You can use BEx Mobile Intelligence to access Web applications even when on the 
road.  The following devices are supported: 
 
–       Personal digital assistant (PDA) with Windows CE 3.0 and Pocket Internet 
Explorer  
–       WAP-enabled mobile telephone  
–       i-Mode-enabled mobile telephone 
–       Mobile device with EPOC32 operating system (Nokia Communicator 9210) 
 
Different User Types in SAP BW 
 
New studies have shown that up to 70 percent of all OLAP system users are basic 
users.  Compared to the advanced users and query developers, basic users only use 
the system’s analytical functions on a very small scale.  This is because the basic 
users usually carry out predefined queries with fixed datasets. Therefore, most of SAP 
users need a simple user interface. 
 



BW Reporting and Analysis  18 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Different User Types 
 
However, the experienced users and query developers who design and carry out 
information analyses on several levels must be able to use a comprehensive and 
effective range of tools for their analyzing options. SAP catered to these various user 
needs when developing the Business Information Warehouse. 
 
 



BW Reporting and Analysis  19 

Unit Summary 
 
You should now be able to: 
 
• Describe the fundamental structures of SAP BW 

• Explain the reporting functions of SAP BW 

• Define the most important terminology used in reporting 
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Unit 2 - Navigating in Reports 
 
Unit Overview 
 
In this lesson, you use the various navigation options in the Business Explorer 
Analyzer (BEx Analyzer) and in a Web query, and you become familiar with the options 
of the Business Explorer Browsers (BEx Browsers). 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Use the navigation options in the BEx Analyzer and in a Web query 

• Use the functions of the context menu 

• Explain the functions of the navigation block 

• Use exceptions and conditions 

• Navigate with hierarchies 

• Call documentation in the query 

• Use Drag&Relate in a portal 

• Start your reports from the Business Explorer Browser 

• Organize your workbooks and links with the BEx Browser and set up access to 

individual roles 

• Outline the functions of the BEx Browser on the Web 

• Explain the functions of the Business Document Server (BDS) 
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Lesson:   Navigating in Reports 
 
 
Lesson Overview 
 
This lesson deals with the different options for navigating in the BEx Analyzer and in a 
Web query. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Use the navigation options in the BEx Analyzer and in a Web query 
• Use the functions of the context menu 
• Explain the functions of the navigation block 
• Use exceptions and conditions 
• Navigate with hierarchies 
• Call documentation in the query 
• Use Drag&Relate in a portal 
 
 
Business Example 
 
You want to analyze business key figures (for example, sales volumes or costs) within 
existing BW reports.  You use BW reporting options to analyze key figures.  There are 
BEx Analyzer reports and Web reports. 
 
Data sources used: 
• Role:  BW305_Reporting 
• InfoCube:  T_DALSEGM (MultiCube) 
• InfoCube:  T_M_CO (MultiCube) 
 
Reports used: 
• Query:  T_BW305_Q01 
• View:  T_BW305_Q01_V01 
• Template: T_BW305_TPL01 (Sales volume analysis I) 
• Query:  T_BW305_Q02 
• View:T_BW305_Q01_V02 
• Template: T_BW305_TPL02 (Graphical sales volume analysis) The initial view of 

the Web report displays the sales volumes of customers in the USA. The 
geographical map of the USA is divided into four areas.  Customers in these areas 
are identified by a red triangle.  They are also listed in a table.  The number of 
customers is restricted to the fifty best customers (by sales volume).  A ticker 
displays the sales volumes of the four geographical areas. 

 
• Query:  T_BW305_Q03 
• View:  T_BW305_Q01_V03 
• Template: T_BW305_TPL03 (Sales volume II) 
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The initial view of the Web report displays the sales volume and billed amount over 
two business years on a time axis.  The Web report also displays the sales volume for 
the distribution channels, available product groups, and materials. 
 
• Query: T_M_CO_Q01 (Cost center actual/planned) 
• Template:T_BW305_CO_start (CO analysis) 
 
The initial view of the Web report displays a comparison between planned and actual 
costs for all cost centers, broken down according to cost element.  The costs of 
important cost centers are also displayed as a pointer.  This allows you to recognize 
deviations at a glance. 
 
Caution: The following examples are based partly on BEx Analyzer queries and partly 
on Web queries.  The navigation options can be found in both query types and are 
sometimes demonstrated on BEx Analyzer queries, and sometimes on Web queries.  
The queries used have been modified to meet user-specific requirements (layout). 
 
Context Menu 
 
You call the context menu using the right mouse button in the BEx Analyzer, and the 
left mouse button in a Web query.  The context menu allows you to navigate in 
different ways within the report output and offers various functions depending on the 
cell context.  You can also choose to have a simplified context menu with a restricted 
number of features. If you want the context menu to have more functions, you can add 
an enhanced menu.  You can then use the Enhanced Menu and Basic Menu menu 
entries in the context menu itself to toggle between the two versions.  The basic menu 
contains a selection of the functions from the enhanced menu. 
 
For example, the Region characteristic appears in the drilldown.  Choose the Keep 
Filter Value function for the East characteristic value.  The data in the table is now 
filtered by the East value, and this characteristic value no longer displays in the 
drilldown.  You can see that the table is filtered by the East value in the navigation 
block or in the filter. 
 
Keep  Filter  Value 
 
You can select as filter value directly from the results area of an executed report. To 
do this, position the cursor on the filter value required, and choose Keep Filter Value 
from the context menu. The filter value is then displayed in the report and the report 
results are restricted to the filter value in question. 
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Keep Filter Value 
 
Select  Filter  Value  
 
The  system  provides  you with all  possible values for a particular characteristic or 
for a particular structure of a query.  Depending on the query setting, the values 
display as keys or as names.  You can select one or more values from this value set. 
You can select filter values for characteristics using value selection in BEx.  To select 
an individual value in a Web report, choose the value in question (the hand symbol 
indicates a hyperlink).  This adopts the value with no need for any additional action. To 
select more than one value, check the checkbox next to the required values, and 
choose Transfer.  You can also select a single value in this way. 
 
You can sort the specified values in ascending or descending order.  To do this, select 
the hyperlink that has the name of the characteristic or structure.  This link appears 
above the list of values. The first click sorts the values in ascending order, and the 
second sorts them in descending order. 
 
As well as selecting filter values, you can also use a search. This search has an effect 
on the selection list of single values. The values are restricted according to the search 
criteria. 
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Select Filter Value 
 
Filter and  Drilldown  according  to... 
 
Choose Filter and Drilldown according to to set a characteristic at a certain value 
(filter) and, at the same time, drilldown by a different characteristic on the same axis 
(row or column). 
 
For example, in the Filter and drilldown according to menu, choose the Becker Berlin 
characteristic value.  The data filter according to Becker Berlin.  The  Becker Berlin 
characteristic value then disappears from the drilldown. At the same time, the Area 
Code characteristic is drilled down. 
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Filter and Drilldown According to... 
 
Swap  Characteristic  with  ... 
 
Use the Swap x with... function to swap a characteristic or structure for another 
characteristic or structure. 
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Swap Characteristic with ... 
 
Swap  Axes 
 
Use the Swap Axes function to swap the axes of the query.  If, for example, the 
characteristics are in the rows, and the key figures in the columns, you can choose 
Swap Axes to have the key figures display in the rows and the characteristics in the 
columns. 
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Swap Axes 
 
Fix  Filter  Value  to  Axis Choose Fix Filter Value to Axis if you only want to see data 
for one characteristic value  and want the  characteristic  value to continue to appear 
in the drilldown. 
 
This function is primarily useful for chart and map Web items, as you can see the 
context of the data (that is, the filter) in the chart and map themselves. It is still possible 
to interpret the chart and map. 
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Fix Filter Value to Axis 
 
Goto 
 
You can use the Goto function to reach documents and other targets using 
report/report interfaces. 
 
Depending on the cell context in which you call the Goto function, the following 
options are available: 
 
• For reaching cells that contain a key figure, there is the Goto Display 

Documents function:  You reach the documents that correspond to the cell 
selection. 

• For reaching cells that contain a characteristic value, the following functions 
are available: 

 
– Goto → Display Documents: You reach documents in the master data area of 

the characteristic value. 
–  Goto → Documents for Navigation Status: You reach documents that 

correspond to the selection cell. 
• You can start another query on the Web (with the standard Web template) or 

other Web application, in which the input variables are filled from the selection 
conditions and element definitions of the selected cell of the sender query. 
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• You can start Web-capable reports, functions, and transactions within and outside 
of BW. 

 
You have the same options when working in BEx Analyzer reports. 
 
You have to define the sender/recipient assignment first so that the system offers 
targets using the report/report interface in the context menu under Goto. 
 
The report/report interface (R/RI) allows you to call parameterized programs from 
other programs, meaning that you are able to jump from one report to another report 
that contains more information.  From SAP BW, you can reach targets both within and 
outside of the BW system. You can go to the connected SAP R/3 system, or to another 
SAP System (from Service API release 6.10). 
 
You need the SAP Internet Transaction Server (ITS) and the SAP GUI for HTML in all 
SAP systems in which you wish to call up transactions over the Web. This makes the 
transactions Web-capable. 
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Goto 
 
Export  as  ... 
 
You can export the query data to Microsoft Excel 2000.  The query data is embedded 
like queries in the BEx Analyzer:  The navigation status and formatting remain 
unchanged.  You can see the restrictions of the filters and the data in the table. As on 
the Web, exceptions are highlighted. 
 
From the context menu (click with left mouse button on the text of a characteristic, 
characteristic value, structural component, exception description, or condition 
exception), choose Export as ... → Microsoft Excel 2000 Data. The system exports 
the data to a Microsoft Excel 2000 file. 
 
Caution:  The export of data to Microsoft Excel is supported from Microsoft Excel 
2000 forward. 
 
You can also export the query data to a CSV (comma separated value) file. Unlike 
when you export to Microsoft Excel 2000, you do not see the context for the figures, 
nor are the filters specified. The formatting (for instance, the way the exceptions 
display) is also not available in the CSV file. 
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Export 
 
Properties 
 
Choose Properties from the context menu if you want to make settings for the 
characteristic or key figure. 
 
Characteristics  
 
The options that are available for changing a characteristic depend on the properties of 
the characteristic - characteristics with/without attributes, characteristics with/without 
hierarchies. As well as general settings that can be made for all characteristics, other 
options display according the properties of the characteristic in question.  The dialog 
box contains up to three areas: 
 
1.      Show Following Attributes (characteristics with attributes) 
 
2.      Display hierarchy (characteristics with hierarchies) 
 
3.      Display of Hierarchy Nodes (characteristics with active display hierarchy) 
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Key Figures 
 
The options for changing key figures are divided into four areas: 
 
1.      Number Format 
 
You can set the scaling factor from one to one billion, for example. If you set it as 
1,000, the value 3,000 is displayed in the report as 3. 
 
2.      Sort Order 
 
3.      Calculations 
 
You can use this function to recalculate result rows and individual values that are 
displayed in the version according to particular criteria. 
 
4.      Calculation Direction 
 
The default direction of the calculation does not always meet your requirements.  
Therefore, you can use this area to define the direction: along the rows (default) or 
along the columns. 
 
These functions are explained in more detail later on in the course. 
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Properties 
 
Query  Properties 
 
The options for changing a query are divided into three areas: A fourth area displays 
information.  The areas are: 
 
• Data Formatting 

In Tabular View 
 

• Presentation Options 
Results Position  
Display of +/- Signs  
Display of Zeros  
Suppress Zeros 

 
• Display Options       

Display Scaling Factors  
Display Document Links  
Changed On 

Display Drag and Relate Links 
 

• Last Changed 
Owner 

Last Changed By 

Changed On 
Changed At 
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Query Properties 
 
Currency  Translation 
 
You can use the Currency Translation dialog box to determine the currency into which 
the key figures or structural components of a query convert. 
 
You have the following options for changing the currency of structures or structural 
parts: 
 
• Show Original Currency (default settings) You can use this setting to revert to the 

original currency after a previous conversion. 
• To carry out a currency conversion, proceed as follows: 
 
–       Choose a currency from the Currency Translation dropdown box. 
 
–       Choose a currency from the Acc. Trans. Type dropdown box. 
 
–       To use the conversion type from the query definition, select the Consider 

Translation from Query Definition field. 
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Currency Translation 
 
Context  Menu  Summary 
 
There are three basic places where you can call up a context menu within the results 
of a report: 
 
1.      On the name of a characteristic (for example, Sold-to Party) 
 
2.      On the key value of a characteristics (for example, Sold-to Party Becker) 
 
3.      On a key figure (for example, sales volume) 
 
The next table shows you these three places and the context menu that is called in 
each place. 
 
The contents of the enhanced context menus are listed in the description of the 
context menu functions.  You can use the Enhanced Menu and Basic Menu menu 
entries to toggle between the two versions. The basic menu contains a selection of the 
functions from the enhanced menu. 
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Context Menu Functions 1 
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Context Menu Functions 2 
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Navigation Block 
 
The navigation block in a Web query depicts the navigation status of a query in the 
form of a table.  The table displays all characteristics and structures of the query and 
their filter values.  You can change the navigation status, and add and remove 
characteristics and structures to an axis (rows or columns). You can filter according to 
single values, or remove filters again. 
 

You can use  to drilldown an InfoObject in columns, and  to do so in rows.  The 

InfoObject is then drilled down in the table, and the  symbol displays next to the 
InfoObject in the navigation block.  You can use this symbol to remove the drilldown 
from the table.  You can use          to select a filter value. You can restrict the drilldown 
by using the selected filter values in the table. The filter values are listed in the 
navigation block, and you have the option  of using        to remove the filter.  There is 
also  a context menu in the generic  navigation block that refers to the characteristic 
name (for example, base object).
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Navigation Block 
 
Exceptions and Conditions 
 
You can formulate conditions for efficient data analysis. The data is restricted in the 
Web application according to the conditions, so that only the part of the results area 
that interests you displays. 
 
Caution: Conditions have no influence on results rows.  The results row corresponds 
to the results row in the table without this condition. 
 
Exception reporting means selecting and highlighting deviating and critical objects.  
The deviations from defined threshold values (exceptions) are highlighted so that you 
can see deviations from expected results at a glance. Exception reporting allows you 
to determine critical objects in a query in your Web application. 
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Exceptions 
 



BW Reporting and Analysis  42 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Conditions 
 
 
Hierarchies 
 
The row display in the results area of a query can also display using a hierarchy. The 
use of hierarchies has to be activated for the characteristic (for example, cost 
element). The BW administrator does this in the Administrator Workbench (AWB).  
 
You can activate the hierarchy itself from the properties screen that you call up from 
the context menu for the characteristic. The hierarchy then displays in the executed 
query.  If you use a hierarchy, the context menu contains the following additional 
functions: 
 
• Collapse Hierarchy Node  
• Deactivate Hierarchy       
• Expand Hierarchy (Level 01, Level 02...) 
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Hierarchies 
 
Documentation 
 
You can use the Goto function from the context menu to display documents on various 
objects that you have created in the Administrator Workbench, in master data 
maintenance, or in the Web application, and you can create new documents. 
 
If there are documents on the content of a cell, and the Document Links function is 
switched on in the query properties, the system displays a symbol in the cell in 
question. You can then see at a glance that there is a document for this cell. Choose 

OK . The document displays in a new browser window. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



BW Reporting and Analysis  44 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Documentation 
 
Drag and Relate in a Portal 
 
The Enterprise Portal allows you to access applications from other systems and 
sources, such as the Internet or intranet. You use an single point of access to reach 
structured and unstructured information, including business data from data analysis, 
and content from Knowledge Management, the Internet, and the intranet. 
 
A portal facilitates the supply of information.  The unification environment enhances 
this capability by relating the data supplied to other data or Web sites, thereby finding 
relevant information. Drag&Relate (D&R) with the BW unifier allows you to execute 
BW applications or other transactions with BW content (as filter values) across system 
borders by connecting data from one application with data from another application. 
You merely select a business objects (for example, order) and drag it to another object 
(for example, a link to an external Web site) on the Web iPanel.  The system executes 
the actions 
(for example, displays the delivery status of the order). 
 
If you want to use Drag&Relate with the BW unifier, you need the following systems: 
 
• SAP Enterprise Portal 5.0 Support Package 04 
• SAP BW 3.0B 
• SAP BW unifier (= part of the SAP Enterprise Portal) 
 
 
The next figure displays a BW query in a portal (iView).  The Material field has been 
predefined as having the required Drag&Relate functionality (hyper-relational links).  If 
you drag the hyper-relational link Light Bulb 40Watt Clear from the Material column into 
the TRANSACTION MM03 DISPLAY MATERIAL in the iPanel, the material master 
record displays in the SAP R/3 source system. 
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Drag&Relate 
 
Lesson:   BEx Browser 
 
Lesson Overview 
 
This lesson teaches you about the options provided by the Business Explorer Browser 
(BEx Browser). 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Start your reports from the Business Explorer Browser 
• Organize your workbooks and links with the BEx Browser and set up access to 

individual roles 
• Outline the functions of the BEx Browser on the Web 
• Explain the functions of the Business Document Server (BDS) 
 
Business Example 
 
Employees of a company can also start their reports, transactions, and documents 
from the BEx Browser. They can administer the interface and the content of their BEx 
Browser display. It is also planned that the BEx Browser will be implemented on the 
Web in the future. Analyze your options. 
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BEx Browser:  Overview 
 
The BEx Browser allows you to access all documents types of the BW that are 
assigned to your role or stored in your favorites.  You can select and open documents 
assigned to you in the BEx Browser, and you can store and manage new documents 
there. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BEx Browser:  Overview 
 
You can work with the following document types in the BEx Browser: 
 
• BW workbooks 
• Documents stored in the BDS 
• Links (references to the file system, shortcuts) 
• Links to Internet pages (URLs) 
• SAP transaction calls 
• Web applications and Web templates 
• Crystal Reports 
 
The BEx Browser displays all of the user ’s roles and favorites. 
 
Users can maintain their favorites directly in the BEx Browser, or in the SAP Easy 
Access menu. 
 
Caution: Note that the role display in the SAP Easy Access menu can be switched on 
and off. 
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Working with the BEx Browser 
 
You can select and organize documents in the BEx Browser. 
 
You can define the spatial (location on screen) and graphical (color and symbols) 
display of all folders and their content.  You can maintain your favorites and add new 
folders and objects to them. These favorites also appear in your user-specific access 
menu (SAP Easy Access user menu). 
 
The BEx Browser provides the following functions: 
 
• Add new folders or documents 
 
– Select the right-hand area of the BEx Browser (storage area), and choose 
New from the context menu that you call up using the right mouse button. You can 
then create new objects (folders, workbooks, internet addresses, SAP transactions, 
documents and links). 
 
 
• Arrange documents spatially 
 
–       Select a document and use Drag&Drop to move it to the required position.  You 
can also assign a document to a folder using Drag&Drop.  The document symbol then 
adapts itself to match the color of the folder.  You can also determine the sequence of 
documents in the folders using Drag&Drop. 
 
• Assign folders spatially 
–       Select a folder and use Drag&Drop to move it to the required position. 
 
• Change the graphical display of folders 



BW Reporting and Analysis  48 

–       Select a folder, and use the right mouse button to reach the context menu. Then 
choose Choose symbol and color. Choose a folder symbol and/or the color of the 
object symbols. 
 
You can replace the folder symbols with company-specific images, and you can also 
use your own logo. 
 
• Copy folders or documents 
 
–       You can copy individual documents or entire folders with all subordinate 
documents into other roles, or copy tasks for favorites and roles.  Select the folder or 
document in question and use Drag&Drop to move it to the tree structure in the left-
hand side of the BEx Browser. If there are other hierarchy levels, the tree structure 
automatically opens up at the place where you have moved the folder or object to. If it 
is not possible to copy a folder or object into one of the folders in the tree structure, 
this is indicated by a change in the symbol. This can happen if you have no 
authorization to copy an object to a particular folder. 
 
• Create a link       
 
–       You can create links (shortcuts) to any files on your PC. You can also store BEx 
Browser objects as links on your Windows Desktop 
(using Drag&Drop): 
 
• Store documents 
 
–       You can manage any kind of file in the BEx Browser. These files are then stored 
in the Business Documents Service.  To do this, choose New → Document after 
calling up the context menu in the right-hand section of the BEx Browser.  Select the 
required document.  The document is then loaded into the BW system and you can 
access it from the BEx Browser. 
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BEx Browser Administration 
 
The administration of the BEx Browser has changed completely for Release 2.0. 
Existing channels and favorites that were maintained in the InfoCatalog before 
Release 2.0A can be converted to the new technology using the reports provided in 
BW Customizing. 
 
The following division of tasks is valid for the administration of contents displayed in 
the BEx Browser from Release 2.0. 
 
• You can select and organize documents in the BEx Browser.  You can define the 

spatial (location on screen) and graphical (color and symbols) display of all folders 
and their content. You can maintain your favorites and insert new folders of 
objects into your favorites (similar to the functions of the SAP Easy Access menu). 

 
• Role maintenance (activity group maintenance) is the basis of the administration 

of roles and tasks displayed in the BEx Browser.  You can use role maintenance 
(TRANSACTION PFCG) to create new roles (activity groups), assign users to 
these roles, and maintain authorizations. You can also generate links to 
transactions and Internet pages (URLs) and create new folders.  You can only 
maintain the spatial (position on screen) and graphical (colors and symbols) 
representation of folders and their content in the BEx Browser. 
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• All users can maintain their own favorites in the SAP Easy Access menu 

(TRANSACTION SESS). They can insert frequently used transactions or create 
new folders in their favorites.  You can only maintain the spatial (position on 
screen) and graphical (colors and symbols) representation of folders and their 
content in the BEx Browser. 

 
If you want to display your roles in the user menu (SAP Easy Access) as in the tree 
structure of the BEx Browser, make the following setting: in the initial access menu 
(SAP Easy Access), choose User Menu.  Choose Extras → Settings → Show first 
level. The names of the roles to which you are assigned now also display in your user 
menu.  
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Folder Symbols in the BEx Browser 
 
Creating Logos and Folder Symbols 
 
You can replace the folder symbols that are already available in the BEx Browser with 
company-specific images and your own logo.  The folder symbols are graphical 
indicators of folders that are created. They can be found in the right-hand side of the 
BEx Browser. The logo is depicted in the upper right corner of the white title bar of the 
BEx Browser. Different systems can have different folder symbols. However, all users 
of any particular system see the same symbols.  There are no user-specific folder 
symbols. 
 
A maximum of 32 folder symbols can be uploaded.  There are two symbols for each 
folder.  One of these if for the normal display of the folder, and the other is used if the 
folder is selected, for example, if the cursor is positioned over the folder. Only pairs of 
symbols (normal and selected) with sequential numbering can be uploaded. 
 

There must always be a logo with the name wdbblogo.bmp, since this file is used to 
check the validity of the folder symbols on the local PC. If you do not want a logo to 
display, you can use a transparent image for the wdbblogo.bmp file. 
 
Caution: Note the writing convention: There are spaces between the inverted 
commas, after exe., and after the forward slash. 
 
Choose Start → Run.  In the BEx Browser itself there is no command for uploading.  
During the upload process, the folder symbols are taken from the local directory for 
the system in question (c:\program 
files\sappc\sapgui\themes\bw\<SID>).  The user who uploads the folder symbols into 
the system needs authorization for TRANSACTION RRMB. 
 
You can not transport folder symbols between BW systems. Upload the folder 
systems to all BW systems. 
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BEx Browser on the Web 
 
You can use the BEx Browser on the Web to display the contents of the BEx Browser 
(roles, tasks, and favorites) in a Web browser.  This means that you can still use the 
BEx Browser on the Web even if you do not have a frontend installed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BEx Browser on the Web 
 
From the BEx Browser on the Web, you can call HTML pages and Web applications 
that were created using the BEx Web Application Designer and that contain one or 
more tables, charts, or maps.  You can also call other intranet and Internet pages. You 
can look for objects in the Browser. 
 
You need to release the function module for Web-based reporting in order to use the 
BEx Browser on the Web.  For information on the necessary settings, see 
TRANSACTION SPRO. Then choose SAP Reference IMG → BW Customizing 
Implementation Guide → Business Information Warehouse → Reporting-relevant 
Settings → Web-Based Settings. 
 
Caution:  These settings are only relevant if you have used the BEx Browser on the 
Web in BW 2.x and want to continue to use it in the old form for BW 3.x.  You have to 
release the appropriate function  
modules. In BW 3.x, you can include an overview of roles and favorites directly in a 
Web report as a Web item menu. If you only want to use the new function, you do not 
need to make these settings.  The new function offers the same options as the old 
version. 
 
You can not reposition folders and objects using Drag&Drop.  You can not maintain 
your own BW favorites in the BEx Browser on the Web. In contrast to the BEx 
Browser on the frontend, URLs that are not assigned to a folder are still shown in the 
tree structure.  
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Unit Summary 
 
You should now be able to: 
 
• Use the navigation options in the BEx Analyzer and in a Web query 

• Use the functions of the context menu 

• Explain the functions of the navigation block 

• Use exceptions and conditions 

• Navigate with hierarchies 

• Call documentation in the query 

• Use Drag&Relate in a portal 

• Start your reports from the Business Explorer Browser 

• Organize your workbooks and links with the BEx Browser and set up access to 

individual roles 

• Outline the functions of the BEx Browser on the Web 

• Explain the functions of the Business Document Server (BDS) 
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Business Warehouse Reporting 
 

 
 
 

Exercise 1 
 
 

Unit 2 – Navigation 
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Task 1  

Display the sales revenue data for all regional codes Average Delivery Time( 0D_PU_C01_Q001) set a 
filter for material Logic Monitor Flat 17CN and then remove the filter again.  

Task 2  

In the same query swap vendor with material and keep filter value on one of the key figures.  Save as a 
new workbook with the description BW305GR## Sales Spirit. 
 
Task 3 

In this task by using the same query you want to pick a range from 2/2001 to 12/2001.  From the BEx 
menu, save as a new workbook BW305GR## SalesRegion1. 
 

Task 4  

Now you want to know to know actual delivery time to Frankfurt 1612 plant.  Save your results as a new 
workbook BW305GR## SalesRegion2.  
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Business Warehouse Reporting 
 

 
 
 
  
 
 

Exercise 2  
 

Unit 2 – BEx Browser 
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Task 1 

 
Please create a folder My Folder, internet address www.sap.com 
Please, change the color and a picture and add a transaction RRMX.  Check your shortcuts to make 
sure they all work. 

 
 
 
Task 2 
 
Please, create a Folder in the navigation menu Web Queries.  Create a path to a query of your choice 
and place it into Web Queries folder.  When you are done, check that your shortcut is working. 
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Unit 3 - Business Content 
 
Unit Overview 
 
This lesson deals with Business Content (BCT) and the metadata repository. The 
lesson gives you an overview of the role- and task-related information models in SAP 
BW. You can use the HTML-based BW Metadata Repository to access information on 
metadata, for example, links to other objects, centrally. You can activate a query in 
BCT and then go on to execute the query in the Query Designer. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• List the advantages of Business Content 

• Use the metadata repository 

• Transfer objects from Business Content 

 
Lesson Overview 
 
This lesson deals with the Business Content and the metadata repository. You obtain 
an overview of the delivered objects and the Business Content information models. In 
the metadata repository, you can display the definition of all active objects that are 
delivered in Business Content, as well as links to other objects.  You can activate a 
query in Business Content and then go on to execute it in the Query Designer. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• List the advantages of Business Content 
• Use the metadata repository 
• Transfer objects from Business Content 
 
Business Example 
 
A large number of reports and key performance indicators (KPIs) are needed in your 
company. You can use the SAP BW system to check whether there are report 
definitions or InfoObjects delivered by SAP in Business Content that meet, or partially 
meet, your requirements. 
 
You use the metadata repository as an information source that allows you to obtain an 
overview of delivered objects.  You can display additional 
information there. You then activate the objects selected in Business Content. 
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Business Content:  Overview 
 
If you need a specific analysis, you should first check whether Business Content 
contains the query definition you need or a similar query definition. Business Content 
contains all objects that enable you to structure your reporting quickly, from data 
extraction from SAP source systems, to roles that supply employees in a company with 
information they need to complete their work.  These information models include: 
 
• Roles       
• Queries and workbooks (BW reports, and particular views of them) 
• InfoProviders that the reports are based on 
• InfoObjects that provide the characteristics and key figures used in your reports 
• Update rules and extractors for SAP R/3, mySAP.com business applications, and 

other selected applications 
 
Business Content has the advantage that all necessary and related objects can be 
activated at the same time.  Afterwards, all relevant data from the SAP source systems 
can be loaded into the BW system and analyzed immediately with Business Content 
queries. 
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Business Content 
 
Roles 
 
The objects are grouped together into roles for optimum use. A role corresponds to a 
specific function in a company, for example, purchasing manager. A role is linked to 
particular tasks, areas of responsibility, and the information requirements that result 
from them. 
 
There are roles for the different areas within your company. Targeted reports and 
applications are available for these roles, according to what employees assigned to 
the various roles need to do their job. 
 
Industries 
 
In the case of many industries, for example, Retail, Pharmaceuticals, Banking, and so 
on, roles and the objects that belong to them in Business Content are delivered to 
meet the needs of the individual areas. 
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Crystal  Reports 
 
Crystal Reports are also delivered with the BW release of Business Content. Crystal 
Reports are formatted reports whose layout is based on forms prescribed by law or 
are pixel-oriented.  This orientation makes the 
pixel-precise arrangement of report elements possible. Crystal Reports also offer 
enhanced printing functions. The Crystal Reports delivered in Business Content have 
been created on the basis of existing BW queries. 
 
You can use the Crystal Enterprise server component to publish these reports on the 
Web and make their applications available. 
 
If you want to create your own formatted reports in addition to the reports delivered by 
SAP as Business Content, you need the Crystal Reports Designer. The option of 
creating your own reports with the Crystal Reports Designer does not belong to BW 
standard functions but is part of the Crystal Enterprise - SAP Edition solution. 
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Crystal Report 
 
Analytical  Applications 
 
In conjunction with mySAP Enterprise Portal, the BW release delivers cross-
component applications such as analytical applications in the form of business 
packages. 
 
These business packages deliver targeted access to information for a process. They 
enable the analysis of this process, as well as the actions and reactions to it in the 
systems that deliver the data. 
 
The functions are independent of the operative, transactional systems. However, the 
analytical application can read the data from the operative systems and write back to 
them. 
 
The areas for analytical applications include Sales Analysis, Campaign Management, 
Market Exploration, Procurement Analysis, Production Analysis, Inventory Analysis, 
Customer Credit Management, and Packages for E-Analytics. 
 
Each business package consists of an overview page, the cockpit, and  additional 
target-oriented user interfaces known as worksets. 
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SAP  DemoContent 
 
You can also use SAP DemoContent with delivered examples.  The data is stored as 
flat files during installation on the BW server.  This allows demo scenarios from the 
Purchasing, Sales and Distribution, Financials, Profitability Analysis, Mobile 
Applications, ACNielsen, and SEM to be activated and displayed. 
 
The corresponding roles are: 
 
• Demo role (SAP_BW_0D_SAPDEMO) 
• Demo ACNielsen US (SAP_BW_0D_ACNUS1) 
• Mobile Executive (SAP_BW_0D_MOBILE_EXECUTIVE) 
 
In addition, the Demo Web Applications are delivered for the following roles: 
 
• Sales Cockpit (SAP_BW_SALES_COCKPIT) 
• Demo Role (SAP_BW_0D_SAPDEMO) 
 
Activate the Demo Role (SAP_BW_0D_SAPDEMO) in your system. The Demo Role 
contains a Web management InfoCockpit, GIS functions, and a Web application. 
 
Metadata Repository 
 
The metadata repository can be found in the Administrator Workbench 
(AWB) of the BW system. It contains definitions of all active objects delivered in 
Business Content, as well as their links to other objects.  The metadata repository is 
particularly suited to comparing your reporting requirements with objects and 
information available in Business Content, and to identifying objects that fully or 
partially meet your requirements. 
 
You can find the following information on all objects in your BW system in the metadata 
repository: 
 
Technical data 
 

Technical name, object version, content release, and description 
 
Graphical display 
For example, the data flow and star schema (the latter available only for InfoCubes) 
 
Additional objects 
For example, required objects, objects to which data is forwarded, and objects that 
supply data 
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Object Search in the Metadata Repository 
 
The description of a specific object in the metadata repository can be reached by using 
the following search options. 
 
1.      You can search for the object on which you want more information using the 
search function. 
 
Enter a search term to do this.  You can restrict the search to queries, InfoObjects, 
InfoCubes and ODS objects. 
 
2.      You can display the active objects in the system, arranged according to 
object type. 
 
If you click on an object type, for example Query, all the active objects of that type that 
are available in the system are listed. 
 
3.      You can display all objects in the system that are delivered with Business 
Content, arranged according to object type. 
 
If you click on an object type, for example Query, all queries delivered by 
SAP in Business Content are listed. 
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Business Content 
 
Business Content:  Initial Access 
 
Business Content can be found in the AWB of the BW system. 
 
You can use the bar on the left (indicated by A in the graphic) to choose how objects 
delivered in Business Content are to be listed in the middle section of the screen (B). 
The objects that you transfer are then listed in the right hand window (C). 
 

You can subdivide the objects into InfoProviders by InfoArea , for example. Under 

the InfoAreas  , the various assigned InfoProviders, such as InfoCubes , are 
listed.  
 

You can also sort by role  or object type . 
 

The drilldown by object type option is especially useful to compare an analysis 
demand with Business Content content. 
 

The query definitions delivered by SAP can be found in the middle section of the 

screen in the BW menu by object types, with a sub-entry of query elements . 
 
• Query Definitions       
• Global Structures for Key Figures 
• Restricted Key Figures 
• Calculated Key Figures 
• Variables       

You can find the Select Objects  option beneath the Query sub-node. Clicking on 
Select Objects brings you immediately to a selection menu with all the queries in 
Business Content. They are listed under the corresponding InfoAreas and 
InfoProviders.  An integrated search function makes it easier to find queries from 
specific areas.  
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Transferring Objects from Business Content 
 
When you have found the query definition you need, select it with the mouse and 
choose Transfer. The system then gathers together all the objects related to the query.  
This takes place as a background job. 
 
You can also copy several queries at the same time by choosing the control key when 
you select the definitions. 
 
Transferring Content Objects  
 
After objects have been gathered, the selected query displays in the right-hand window 
(C). If a green circle appears in the Active version available column next to the selected 
object, the object is already actively available in the system. 
 
If the object is only available in the system as the delivered version, the icon does not 
appear and the object can be transferred from Business Content in the active version. 
 
If an active version of the transferred object is already available in the system, a check 
mark appears in the Comparison column after the object has been gathered. 
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Query Gathered for Activation 
 
You can make the following settings in Business Content for gathering and activating 
objects: 
 
1.      Grouping 
 
Under Grouping, you can determine what is to be gathered. You can choose between: 
 
• Only Necessary Objects: 
 
Only objects that are needed to transfer the selected object from Business Content 
are gathered.  This is the minimal variant of Business Content transfer. 
 
• In Data Flow Before: 
 
All objects that give data to the object being activated are gathered. 
 
• In Data Flow Afterwards: 
 
All objects that receive data from the object being activated are gathered. 
 
• In Data Flow Before and Afterwards: 
 
All objects that give data to, or receive data from the object being activated are 
gathered.  This is the maximal variant of Business Content transfer. 
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2.      Collection Mode 
 
Under Collection Mode, you can choose between: 
 
• Collect Automatically: 
 
The objects are collected automatically after the object has been selected.  This is the 
default setting. 
 
• Start Manual Collection: The objects to be activated are only collected if you 

choose the Gather Dependent Objects function. 
 
3.      Type of Transfer 
 
You can choose the type of transfer: 
 
• Simulate Installation: 
 
The system tests whether errors would occur if the most important objects were 
transferred. The simulation serves as orientation help before activation. The result of 
the activation is shown by a green or red icon beneath the Simulation result header. 
 
• Install: 
 
The selected objects are activated directly. 
 
• Install in Background: 
 

The selected objects are activated in the background as a batch job.  This setting is 
useful if you want to activate a large number of objects. 
 
• Installation and Transport: 
 
The selected objects are activated and written to a transport request. 
 
4.      Display 
 
Under Display, you can choose between: 
 
• Hierarchy: 
 

The gathered objects display hierarchically according to their dependencies. 
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• List: 
 
The gathered objects display in a normal list.  
 
In the Gathered Objects window (C), there are the following columns: 
 
• In the Install column, the following Business Content objects are indicated by 

default: 
 
–       Objects transferred for the first time 
– Objects that have been redelivered by Business Content in a more recent 

version 
 
• In the Match (X) or Copy column, a checkbox displays if it is possible to compare 

the SAP delivery version with the active version. This indicator is set by default. If 
this is the case, your version is matched to the new SAP delivery version and 
enhanced.  If you remove this indicator, the new SAP delivery version is copied in 
its entirety. 

 
 

Business Content:  Executing an Activated Query in the 
BEx Analyzer or on the Web 
 
You can call queries activated in Business Content in the BEx Analyzer or on the Web. 
You can find the query in the Query Designer under the SAP Demo InfoArea by 
choosing SAP Demo Sales and Distribution: Overview → SAP Demo Sales and 
Distribution: Overview → Complete Overview Sales and Distribution. 
 
A search function helps you to find the query quickly. You can either enter the 
descriptive name or the technical name of the query. When you find the query, select it 
with the mouse and confirm with OK. If the corresponding InfoCube contains data, you 
will obtain the report result. 
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Unit Summary 
 
You should now be able to: 
 
•      List the advantages of Business Content 

•      Use the metadata repository 

•      Transfer objects from Business Content 
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Business Warehouse Reporting 
 

 
              
 
 

Exercise 3  
 

Unit 3 – Business Content 
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Task 
 
Obtain an overview of the SAP Demo Sales and Distribution:  Overview (0D_SD_C03).  Have a 
look at the list of characteristics and key figures for this InfoCube.  Display the network display for 
the data flow, and obtain an overview of the queries that are structured on this InfoCube. 
 
 
1. Log on to the BW server.  Choose SAP Menu to reach the SAP menu.  Call the 

Administrator  Workbench under BW Administration.  Open the metadata repository, and 
look for the InfoCube SAP Demo Sales and Distribution: Overview (0D_SD_C03) in the 
content objects. 

             
 
2. Have a look at the list of characteristics and key figures for this InfoCube.  Use the network 

data flow to obtain an overview of the queries that are structured on this InfoCube. 
    
3. Find the Billing Documents query (technical name 0D_SD_C03_Q007), and display the 

information on this query. Determine which role it is assigned to. 
 

  
 

4. Branch to the activated objects of the metadata repository and check whether the Billing 
Documents query is actively available in the system. 
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Unit 4 - First Steps in the BEx Query Designer 
 
Unit Overview 
 
This unit gives an overview of the BEx Query Designer tool and the individual objects 
that you require to create a query definition - the basis of every report. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
o Describe the functions of the BEx Query Designer 

o Define your own queries and modify these when necessary 

o Publish reports for analysis in the BEx Analyzer and on the Web 

o Describe the differences between the different InfoProviders 

o Select the InfoProviders according to their use in creating reports 

o Use the different elements of the InfoProvider in the Query Designer 
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Lesson:   Query Designer 
 
Lesson Overview 
 
This lesson presents the BEx Query Designer as an independent tool for defining 
queries in the SAP Business Information Warehouse. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
o Describe the functions of the BEx Query Designer 
o Define your own queries and modify these when necessary 
o Publish reports for analysis in the BEx Analyzer and on the Web 
 
Business Example 
 
You use SAP BW to define reports that enable standardized navigation functions in 
analyses, independent of the source operational system. 
 
You want to define simple reports, execute these, and make changes to the report 
definition. 
 
Calling the BEx Query Designer 
 
Using the SAP BW reporting functions, you can evaluate a dataset from an 
InfoProvider according to various characteristics and key figures. To do this, you define 
a query for your chosen InfoProvider in the BEx Query Designer. By selecting and 
combining the InfoObjects in a query, you determine the way in which data from the 
chosen InfoProvider is evaluated. 
 
You have various options for calling up the Query Designer: 
 
o From the BEx Analyzer open dialog box 
o As a separate program using Start → Programs → Business Explorer 
→Query Designer 

o Using the Web Application Designer (see the BEx Web Application Designer unit) 
o With Crystal Reports (Crystal Reports >=8.5 including CR add-ons for SAP) 
 
The Open Dialog Box 
 
If you choose to access the Query Designer from the BEx Analyzer, the SAP BEx: 
Choose Query dialog box is called before the Query Designer opens. 
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SAP BEx:  Choose Query 
 
This dialog box is context sensitive, which means that it offers different choices 
depending on the type of object selected: 
 
 

 
 
Within the relevant dialog box, you have the option of creating a new query or of 
finding and selecting an existing query. You can then change or execute the query. 
 
Functions of the BEx Query Designer 
 

The following figure gives an overview of the BEx Query Designer functions that you 
can call from the Query Designer toolbar. The functions are described within the 
context of query definition. 
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Functions of the Query Designer Toolbar 
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Creating a Query 
 
This section describes the most important functions required for creating, saving and 
modifying a query. 
 
To define a new query, start the Query Designer and choose New Query . In the 
New Query:  Select InfoProvider dialog box, select the required InfoProvider.  The 
following example uses the InfoProvider Customer Cube T_SDDEMO2 
(T_SDDEMO2) under InfoAreas → BW Training → BW Customer Training → 
BW305 Reporting. 
 
Once you have selected the InfoProvider, the Query Designer displays as shown in 
the following graphic. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Query Designer:  New Query 
 
The Query Designer is divided into six subareas: 
 
1.      Directory tree of the selected InfoProvider. 
 
Once you have selected the required InfoProvider, all available objects (dimensions, 
key figures, structures) display in the directory tree in the left screen area of the Query 
Designer. 
 
In this example, you can see the directory tree for the InfoProvider InfoCube 
Customer Cube T_SDDEMO2. 
 
2.      Columns 
 
You define the columns of your report in this area. 
 
3.      Rows 
 
You define the rows of your report in this area. 
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4.      Free Characteristics 
 
You transfer those characteristics into the free characteristics area that do not display 
in the initial view of the results when you execute the query in the BEx Analyzer or on 
the Web.  You can then integrate these characteristics into the results through 
navigation steps. You can also use free characteristics for selecting filter values in the 
report. 
 
5.      Filter 
 
The characteristics displayed in the filter appear neither in the drilldown nor as free 
characteristics in the query analysis. These characteristics are only used as global 
filters on the InfoCube data. 
 
6.      Preview (displayed in gray on the screen) 
 
This area gives a preview of the query results area. 
 
To create a query, you can expand or collapse the InfoProvider directories by choosing 
the plus or minus symbol. By expanding the key figure node in the InfoProvider tree, 
for example, you can display a list of all the key figures for the InfoProvider. 
 
o Use Drag&Drop to transfer the characteristics, key figures, and structures of the 

InfoProvider into the Filter, Rows, Columns, or Free Characteristics areas of the 
Query Designer.  

You can also transfer these characteristics using the keyboard and the clipboard.  
Choose CTRL+C to copy and CTRL+V to paste. 
 
You can also include characteristic attributes and variables in the query definition in 
this way. 
 
o You can use the right mouse button to call all of the functions that are in the 

current context menu.  To do this, first select the required query component, then 
select a menu entry from the context menu. 

o By double-clicking on an element in the query designer, you call a dialog box that 
offers the default function for that element. For example, if you double-click on a 
characteristic, the dialog box for restricting characteristics appears. 
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The following graphic shows the Query Designer with a query definition. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Defined Query 
 
The following definitions were made:  
 
o The characteristic Cal. Year/Month (0CALMONTH) was chosen as a global filter 

and restricted to the months January to April 2001. 
o The characteristic Country was selected as a free characteristic.  
o The key figures Incoming Orders Quantity and Incoming Orders EUR were placed 

in the columns. 
o The Sold-to Party characteristic, with addresses and account groups, was included 

in the rows.  The material was also included in the rows.  This was restricted to a 
range of materials. 

o The preview area shows how the report is structured. 
 

Once you have defined a query, choose Save Query  or Save Query As... . If 
you have not yet saved the query, you must enter a query description and a unique 
technical name. You can also choose where you want to save the query (in your roles 
or in your favorites folder). You can use Save Query As... to save existing queries 
under a different name. 
 

You can also execute a query immediately.  To do this, choose Quit and Use Query . 
 
If you have not yet saved the query, you must enter a query description and a technical 
name. 
 
Once you have saved the query, you have the following options: 
o You can execute the query in the BEx Analyzer and include it in a workbook.  To 
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do this, choose Quit and Use Query       . 
o You can display the query on the Web in a default view.  To do this, choose 

Display Query on the Web . 
o You can use the query in the Web Application Designer as a data provider for Web 

items. 
o You can use the query in the tabular display in Crystal Reports as a data source 

for formatted reports. 
 
The individual steps for creating a query and the various options for defining a query 
are described in more detail in the following section. 
 
Finding a Query 
In order to find a query for which you already know a part of the description or other 

information, choose Find . 
 
In the Search for Queries dialog box, enter the technical name or description of the 
query.  If necessary, you can restrict the search to additional criteria. 
 
Choose Find     . 
 
o If you are in the BEx Analyzer and have called the search function from the 

Choose Query dialog box, the query result displays as an Analyzer report. 
o If you are using the search function from the Query Designer, the query definition 

displays. 
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Finding a Query 
 
Changing a Query As a rule, report requirements are not final at the start of the 
conversion phase. Many new requirements often arise once users have discovered the 
range of options in the Query Designer. Therefore, reports are often subject to change. 
Depending on your current position in the Query Designer or Analyzer, you have 
different options for changing a query: 
 
o If you have called the Query Designer, in the SAP BEx Query:  Choose Query, 

select a query.  You can either select a query using the technical name or the 
query description. The queries are also listed under InfoArea under the relevant 
InfoProvider (which you used to define the query). 

o You have two options for changing the query definition from a report in the 
Analyzer: 

 
–       Choose Change Query (Global Definition). 
 
By doing this, you can change the query definition. 
 
– Choose Change Query (Local View). 

 
Changes made to the query here correspond to navigation in the report and are not 
saved in the query definition. 
 
If you are in the Change Query (Local View) mode, you can switch directly to the 
global definition by choosing Change Query (Global Definition)         
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Filtering Data in the Query Definition 
 
It is often necessary to restrict (filter) characteristics to specific characteristic values in 
your reports. For example, if you are interested in the sales volume of a particular 
branch of a worldwide corporate group, but the InfoProvider contains the sales volume 
for the entire organization, you can restrict the query definition to the relevant branch, 
so that only the key figure for this branch appear in the report. 
 
You can restrict (filter) the characteristic values of a characteristic in the Rows, 
Columns, Free characteristics, and Filter areas of the Query Designer. 
 
There are two ways of restricting characteristics: 
 
1.      By selecting a characteristic from the InfoProvider of the characteristic (in the 

tree structure in the left part of the screen) and double-clicking on the Values 
icon, the selection menu for fixed values displays. You can select single values 
or values from a value area. The fixed values selected appear in the directory 
tree under Values.  You can use Drag&Drop to  include these in your query 
definition. 

 
2.    You can also restrict a characteristic that you have already included in the 

definition.  Call the context menu for the characteristic and choose Restrict.  The 
Selection for ...  dialog box appears. 

 
The following figure shows the selection dialog box for the Material characteristic. 
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Selection Dialog Box for Filtering/Restricting a Characteristic  
 
You can find all of the characteristic values available for the chosen characteristic in 
the left screen area.  The right screen area contains the characteristic values that you 
want to use to restrict the characteristic. 
 
To select a characteristic value, highlight the relevant value in the left screen area.  You 
can select single or multiple characteristic values.  Using the Input field in the lower left 
area of the selection dialog box, you can find specific characteristic values by entering 
their description or technical name.  The found values are then automatically 
highlighted. 
 
You can then use Drag&Drop to move the highlighted values into the right screen 
area.  Alternatively, you can transfer the selected values using the arrow. If you want 
to remove the restriction, simply reverse the procedure. 
 
Including Text Elements in BEx Analyzer Reports 
 
You have the option of displaying different text elements as additional information in a 
query (for example, the author, last changed by, InfoProvider, etc.). These text 
elements are referred to as the header information of the query. 

o Choose Layout  and Display Text Elements. 
o You can either display all or individual (General, Filters, Variables) text elements. 
 
The text elements are displayed between the filter cells and the results area. You can 
move or delete individual text elements by moving or deleting the corresponding cells 
using Microsoft Excel menu functions. 
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Explanation  of  the  Text  Elements 
 
Author: 
User who defined the query. 
 
Last Changed by: 
User who last changed the query definition.  Navigation steps are not recorded as 
changes to the definition. 
 
InfoProvider: 
InfoProvider whose data is evaluated in the query. 
 
Query Technical Name: 
Technical name that you entered when you saved the query. 
 
Key Date: 
Contains the date for which the time-dependent master data is selected. You create 
a key date either in the query definition (in Query Properties) or provide the value 
using a variable (for more information, see the Query Properties unit). If no key date 
has been defined, the system date is taken as the key date. 
 
Changed At: 
Date and time at which the query definition was last changed. 
 
Status of Data: 
Time at which the data from the last request was posted to the 
InfoProvider.  This can be evaluated for reporting. 
 
For MultiProviders, the current InfoPackages are determined from the individual 
BasicCubes and from there, the one with the oldest date is referred to for the status of 
the data. 
 
Current User: 
User who currently has the query open or who has inserted it into a workbook. 
 
Last Refreshed: 
Data and time at which the query data was last refreshed. This is the time when you 
displayed the text elements (the system has to refresh the query in order to display 
the text elements). 
 
Variables, Filter Values, Conditions, Exceptions: 
Depending on the current query definition, additional text elements (variables, filter 
values, conditions, and exceptions) may also display. 
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Inserting Text Elements 
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Web Query  
 
Publishing the Query on the Web   
 
To publish the query on the Web, save it and choose Display Query on the Web. 
The query displays in a standard Web template.  You can change the Web template, if 
required. 
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Lesson:   InfoProviders and InfoObjects 
 
Lesson Overview 
 
The lessons deals with InfoProviders, which are used in Business Explorer reporting 
(BEx reporting). 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
•      Describe the differences between the different InfoProviders 
•      Select the InfoProviders according to their use in creating reports 
•      Use the different elements of the InfoProvider in the Query Designer 
 
Business Example 
 
Your enterprise uses the SAP BW system to create many different reports. Among 
others, you need to use reports about consolidated data, individual record reporting on 
document level, and master data reporting. 
 
You also want to find out the options for combining different data sources for reporting, 
without having to change the data store or the update mechanism. 
 
InfoProviders in SAP BW Reporting InfoProviders are objects for which you can 
create and execute queries in SAP BW. These include objects that physically store 
data - the data targets, such as InfoCubes, operational data store objects (ODS 
objects), and InfoObjects (characteristics with attributes or texts). They also include 
objects that do not contain any actual data, such as InfoSets, RemoteCubes and 
MultiProviders. InfoProviders are the objects or views relevant to reporting. 
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InfoProviders:  Overview 
 
o Data Targets 
 
Data targets are SAP BW objects that have their own data store (which physically 
contains data). These objects include InfoCubes, ODS objects and InfoObjects 
(characteristics with attributes or texts).  The system supplies data targets with data 
from the source systems using a load process (or by writing directly into the tables for 
transactional object types).  Data targets become InfoProviders if they are used in BEx 
reporting. 
 
Characteristic InfoObjects have to be included in the InfoProvider tree in the 
Administrator Workbench to make them available as data targets for flexible updates 
and as InfoProviders for reporting. 
 
 
InfoCubes  
An InfoCube is the central evaluation object for reports about aggregated 
(compressed) data.  In reporting, an InfoCube is a self-contained dataset (for 
example, a business area).  You can analyze this data in a BEx query.  The tables in 
an InfoCube are structured in a star schema (multi-dimensional data model). 
 
InfoCubes that have a data store in the SAP BW system are called BasicCubes (type of 
InfoCube that distinguishes them from virtual types, see below). 
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ODS Objects 
 
ODS objects store consolidated and cleansed data on a detailed 
(atomic) level.  In reporting, you use ODS objects for detailed reporting in SAP BW, 
for example, for reporting on individual documents. 
 
An ODS object describes a consolidated data set from one or more data sources. 
ODS objects are available for transaction data and for master data. You can analyze 
this data set in a BEx query. 
 
In contrast to multi-dimensional data stores for InfoCubes, data in ODS objects is 
stored in flat database tables. An ODS object contains a key (for example, document 
number, item number), as well as data fields, which can contain key figures or 
characteristics (for example, customer). You can update ODS object data into 
connected InfoCubes or into additional ODS objects in the same system or a different 
system. 
 
Characteristic InfoObjects  
Characteristic InfoObjects can have tables into which the master data information 
(attributes, texts, hierarchies) is loaded from the source system. 
Once you have included a characteristic InfoObject in the InfoProvider tree, you can 
use it as an InfoProvider for BEx reporting. 
 
You use these InfoProviders for master data reporting in SAP BW. 
 
o InfoProviders Without Their Own Data Store (Virtual InfoProviders): 
 
RemoteCubes 
A RemoteCube is an InfoCube whose transaction data is not physically managed in 
SAP BW, but stored externally in the source system. 
Only the multi-dimensional structure of the RemoteCube is defined and the master 
data loaded in the SAP BW system.  The data for reporting is read online from another 
system.  In reporting, you define queries on RemoteCubes in the same way as you 
define queries on BasicCubes. 
 
However, since the data is read online from the source system, the performance differs 
when you execute reports for RemoteCubes and, therefore, we recommend that you 
only use RemoteCubes in specific scenarios (with small quantities of data, relatively 
infrequent data requests due to a restricted number of users).  
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BW InfoSets 
BW InfoSets do not have a data store of their own, but instead connect flat tables 
using joins and, therefore, provide an additional semantic layer (reporting-relevant 
view) for BEx reporting. 
 
You can create BW InfoSets from ODS objects and characteristic InfoObjects with 
master data. 
 
BW InfoSets enable temporal joins with which you can create reports depicting 
changes over time.  For example, a link from document data in an ODS object to time-
dependent master data (for example, person responsible).  In addition to each 
individual record from the ODS object, you would also be able to report the valid 
master data values with a determined time characteristic that evaluates the internal 
fields for the validity interval (DATETO and DATEFROM) of the master data. 
 

MultiProviders  
 
A MultiProvider combines data from several InfoProviders and makes it available for 
use in reporting.  The MultiProvider does not contain any data itself.  Its data comes 
exclusively from the InfoProviders on which it is based.  You can create a MultiProvider 
from any combination of InfoProviders. 
 
MultiProviders are based on a union connection (union), unlike joins in BW InfoSets 
(intersection). 
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InfoCube Elements in the Query Designer 
 
Global Objects 
 
An InfoCube can contain global elements, such as, Calculated Key Figures (as can all 
other InfoProviders) that are available for all query definitions for this InfoProvider. 
These elements are defined on a global level for the InfoProvider and you can use 
them in many different reports. 
 
InfoCube Elements 
 
In accordance with its multi-dimensional structure, an InfoCube has Key Figures that 
display in their own folder in the Query Designer. Characteristics display in 
Dimensions. 
 
There are additional entries in the selection tree for a characteristic for its 
Compounding information (if the characteristic is compounded with a different 
characteristic, for example, cost center to controlling area).  If you include a 
characteristic that has compounding information in the query definition, the 
compounded characteristic is also automatically included in the definition. From the list 
of entries for Attributes, Characteristic Value Variables, and Values, you can use 
Drag&Drop to include additional elements in the definition. 
 
Detailed information about working with attributes and variables is provided in a later 
lesson. 
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Elements of InfoProviders and ODS Objects in the Query Designer 
 
The system generates the key figure Number of Records (1ROWCOUNT) for 
characteristic InfoProviders and for ODS objects and places them in the Key Figures 
folder. 
 
In the Dimensions folder, you find two different dimensions for each object type. For 
characteristic InfoProviders, the dimensions are Attributes and Key Part, in accordance 
with the definition of the master data tables.  For ODS objects, the dimensions are 
Data Part and Key Part. 
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InfoSets in the Query Designer 
 
The system also automatically generates the key figure Number of Records 
(1ROWCOUNT) for InfoSets. 
 
Two dimensions are provided for each InfoProvider in the InfoSet: Attribute and Key 
Part. Therefore, for an InfoSet composed of an ODS Object connected to a 
characteristic, four dimensions display.  The respective characteristics are then 
assigned to the dimensions. 
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MultiProviders in the Query Designer 
 
In the Key Figure folder of a MultiProvider, you can find the generated key figure 
Number of Records (1ROWCOUNT), if one of the InfoProviders included already 
contains this key figure, for example, in ODS objects. 
 
The Data Package dimension contains the generated characteristic InfoProvider 
(0INFOPROV), which enables you to specify a unique InfoProvider in the selection or 
the display to supply data for the query.  The values of this characteristic are formed 
from the (technical) names of the InfoProviders involved. 
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Unit Summary 
 
You should now be able to: 
 
o Describe the functions of the BEx Query Designer 

o Define your own queries and modify these when necessary 

o Publish reports for analysis in the BEx Analyzer and on the Web 

o Describe the differences between the different InfoProviders 

o Select the InfoProviders according to their use in creating reports 

o Use the different elements of the InfoProvider in the Query Designer 
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Business Warehouse Reporting 
 

 
              
 
 
 

Exercise 4 
 

Unit 4 – Introduction to BW Query Designer 
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Task1  

You are interested in finding out the incoming order values and the incoming order quantities of 
your customers for specific materials between January and April 2002. You want to enable the 
users of your report to select by specific countries. Create a new query with the following layout:  

   

 
 
Task 2  

(Optional)  

Create a report using the same InfoCube for the time period from May to July 2002 about the 
sales volumes of your customers from the sales organization Germany Frankfurt (1512), with 
the option of navigating by division, and a drilldown for the sales volumes on the months May to 
June.  
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Business Warehouse Reporting 
 

 
             
  
 
 
 

Exercise 5  
 

Unit 4 – InfoProviders and InfoObjects 
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Task  

InfoProviders in SAP BI  

 

1. What type of InfoProvider can you use to create reports?  

 

2. What objects does the term InfoProviders refer to?  

 
3. Which conditions does an InfoObject have to fulfill in order to be used as an 

 InfoProvider?  

 

4. Which InfoProviders are available for master data reporting?  

 
5. Which InfoProviders can contain generated characteristics or key figures?  
 
 
6. Which InfoProviders can I combine in a BI InfoSet?  
 
 
7. How many dimensions are displayed for an InfoSet in the Query Designer, if the InfoSet 

 consists of an ODS object and a characteristic InfoObject?  
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Unit 5 - Calculated and Restricted Key Figures 
 
Unit Overview 
 
This unit deals with how to define restricted key figures on InfoProvider and query 
levels. 
 
The properties of key figures are also discussed. The lesson shows an example of 
formula collision and explains the functions of the cell editor that can be used when 
implementing two structures in a query definition. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Explain the objectives and use of restricted key figures in information analyses 

• Define restricted key figures at the InfoProvider and query level 

• Use the enhanced selection function for selecting restriction values 

• Use the Exclude from Selection and Include in Selection functions 

• Explain the use of constant selection 

• Define new calculated key figures and explain their usage in reports 

• Define a calculated key figure when using a restricted key figure and include it in 

the analysis 

• Identify the various settings that can be made for properties of key figures, and 

use them in report 

• Carry out currency translation in the Business Explorer 

• Use the cell editor       

• Create global structures so that complex key figure structures can be reused 
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Lesson:   Restricted Key Figures 
Lesson Overview 
 
This lesson deals with how to define restricted key figures at the InfoProvider and 
query level. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Explain the objectives and use of restricted key figures in information analyses 
• Define restricted key figures at the InfoProvider and query level 

• Use the enhanced selection function for selecting restriction values 
• Use the Exclude from Selection and Include in Selection functions 
• Explain the use of constant selection 
 
Business Example 
 
You need restricted key figures in order to be able to define detailed reports. For 
example, you want to list sales volumes for individual time segments next to each 
other in the report.  If you create them at the InfoProvider level, you are then able to 
reuse the individual key figures in other reports. 
 
Restricted Key Figures 
 
Restricted key figures are (basic) key figures of the InfoProvider that are restricted 
(filtered) by one or more characteristic selections.  The key figure that is restricted by 
one or more characteristic selections can be a basic key figure, a calculated key 
figure, or a key figure that is already restricted. 
 
By using restricted key figures, you can focus the query result on certain values.  
Unlike a filter, whose restrictions are valid for the entire query, for a restricted key 
figure, only the key figure in question is restricted to its allocated characteristic value or 
characteristic value interval. Scenarios such as comparing a particular key figure for 
various time segments, or plan/actual comparison for a key figure if the plan data is 
stored using a particular characteristic can be realized using restricted key figures. 
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Defining Restricted Key Figures 
 
Use 
You can create restricted key figures at the InfoProvider level, or locally in the query 
definition.  Restricted key figures that are defined at the InfoProvider level are available 
in every query definition of the InfoProvider in question. 
 
Procedure 
 
1.      To define a restricted key figure at the InfoProvider level, from the Query 
Designer, choose Restricted Key Figure in the context menu on the left-hand side 
under Key Figure. 
 
To define a restricted key figure at the query level, use Drag&Drop to drag the key 
figure to be restricted into a Query Designer directory. In the context menu, choose 
Edit, or select the heading of the Rows or Columns directory and use the right mouse 
button to choose New Structure. Select the structure directory and use the right 
mouse button to choose New Selection from the context menu. The New Selection 
dialog box appears. 
 
2.      Enter a description of the restricted key figure into the text field. 
 
3.      If you select another key figure, use Drag&Drop to choose the key figure of the 

InfoProvider and place it on the right-hand side of the Selection window. 
 
4.      Use Drag&Drop to move the characteristic whose characteristic value you want 

to use to restrict the key figure to the right-hand side of the Selection window. 
 
5.      From the context menu of the characteristic, choose Restrict. 
 
6.      Select the characteristic values you require for the restriction. 
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7.      Confirm your entries by choosing OK. 
 
8.    For the definition at the InfoProvider level, you enter a technical name in the 

dialog box, and confirm your entry by choosing OK. The newly defined key 
figure can be found in the Restricted Key Figures directory. 

 
In the case of definition at the query level, the new restricted key figure is already part 
of the structure. 
 
Selection Conditions for the Selection of Filter Values When defining a restricted 
key figure, you want to select the restricting characteristics, individual characteristics 
values, value ranges, hierarchy nodes or characteristic variables. When selecting 
value ranges, the following operations are available: 
 
• Between 
• Greater than or equal to 
• Less than or equal to 
• Greater than       
• Less than 
 
You can include values in the selection or exclude values from the selection 
by selecting these options in the context menu of the relevant filter value. 
 
You can also remove the restriction of the characteristic values that appears in the 
selection dialog box and select displayed values based on their attributes or text by 
formulating selection conditions.  On the basis of this enhanced selection function, the 
characteristic values targeted by the demands of your report displays in the selection 
dialog box. 
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Formulating a Selection Condition 
 
Use  
You can select individual values and value ranges from a list or from a selected 
hierarchy in the selection dialog box.  The values available in the left-hand window are 
restricted to 100 values. You want to remove this restriction, and you want only 
characteristic values that match your specific criteria to be offered in the selection 
dialog. 
 
Prerequisites 
You have selected the characteristic for which you want to use characteristic values for 
restriction and chosen Restrict in the context menu using the right mouse button. 
 
Procedure 
 
1.      Choose the yellow arrow in the bottom left-hand corner (Display Other Values) to 
reach the Selection Condition dialog box.  You can formulate selection conditions here 
and deactivate the restriction to 100 values. 
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If you set the Number of values displayed to All, and there are a large number of 
characteristic values, this may cause a long wait when selecting values. 
 
2.      In the Restriction(s) window on the left-hand side, choose the attribute that you 
want to use to restrict the selection. 
 
3.      Choose the required operator. 
 
You can use the following operators: 
 
• Equal to       
• Greater than or equal to 
• Less than or equal to 
• Less than 
• Between 
• Contains Pattern 
 
4.      Enter a characteristic value.  If you want to use the value selection help function, 
choose the button to the right of the third field labeled with the three periods. 
 
5.      To adopt the restrictions, choose the arrow pointing to the right.  The dialog box 
remains open so that you can add further restrictions to your selection condition. 
 
6.      Choose OK. The list of available values in the left-hand window of the selection 
dialog box is now restricted according to your formulated selection condition. 
 
The Text attribute is offered in the Restriction(s) window on the left-hand side if: 
 
1.      In the InfoObject maintenance for a characteristic, in the Business Explorer 
settings, you set that the characteristic presentation contains text (Only Text or Text 
and Key). 
 
2.      Text is available for the characteristic. 
 
In this case, the operators Equal to and Contains Pattern are available. You can 
formulate the following selection conditions, for example: Display all products with the 
text toothpaste. 
 
Constant Selection 
 
In the Query Designer, you use selections when defining a restricted key figure to 
determine the data that you want to display at runtime. You can use navigation steps 
to further restrict your selections at runtime.  The Constant Selection function allows 
you to mark a defined selection as being constant. As a result of this setting, 
navigation and filters no longer have an effect on the selection in question. 
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Determining Constant Selection 
 
Use 
Constant selection allows you to easily select reference variables that do not change 
at the report’s runtime. 
 
Procedure 
 
1.      In the context menu of the restricted key figure, choose Edit, or in the context 
menu of a structure, choose New Selection if you want to make the setting as soon as 
the selection is created.  You reach the Edit Restricted Key Figure or New Selection 
dialog box. 
 
2.      In the context menu of the characteristic InfoObject that you want to use to 
restrict the key figure, or that you want to use in the selection, choose Constant 
Selection. 
 



BW Reporting and Analysis  112 

Lesson:   Calculated Key Figures 
 
Lesson Overview 
 
This lesson deals with how to define calculated key figures at InfoProvider and query 
level. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Define new calculated key figures and explain their usage in reports 
• Define a calculated key figure when using a restricted key figure and include it in 

the analysis 
 
 

Business Example 
 
The use of complicated calculations for information analysis is the order of the day.  
This requires various mathematical functions such as percentage functions and totals 
functions. You need basic key figures and restricted key figures or calculated key 
figures that you have already defined to define your calculated key figures.  For 
example, you use the restricted key figures for two specific years to calculate the 
difference between the sales volumes of 
the years in question. 
 
Functions for Defining Calculated Key Figures 
 
In the Query Designer, you can use a formula to calculate key figures that are not in 
the InfoProvider by using basic key figures, restricted key figures and existing 
calculated key figures in the formula definition. 
 
Below are examples and explanations of the functions available as operators when 
you define a calculated key figure. 
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Percentage  Functions 
 
Percentage Variance (%) 
<Operand 1> % <Operand 2> 
gives the percentage variance of operand 1 from operand 2. Example:  Planned Sales 
Volume % Actual Sales Volume gives the percentage by which the actual sales 
volume exceeds the planned sales volume. 
 
Percentage Share (%A) 
<Operand 1> %A <Operand 2> 
Gives the percentage share of operand 1 of operand 2. 
Example: Sales Volume %A Incoming Orders specifies the percentage share of sales 
volume made up of incoming orders. 
Percentage Share of Result (%CT) 
%CT<Operand> 
Specifies how high the percentage share is in relation to the result. The result means 
the result of aggregation at the next level (interim result). 
%CT Incoming Orders specifies the share of incoming order values of each individual 
characteristic value (for example of each customer) in relation to the characteristic’s 
result (for example, customer of a division). 
 
Percentage Share of Overall Result (%GT) 
%GT <Operand> Specifies how high the percentage share is in relation to the overall 
result. The overall result means the result of aggregation at the next level in the list. In 
the calculation of the overall result, the dynamic filters (filters that were not already 
defined in the Query Designer) are included. 
 
Data  Functions 
 
Counts 
 
COUNT(<Expression>) 
Delivers the value 1 if the expression named in <Expression> is not equal to 0.  
Otherwise, delivers the value 0. 
 
NDIV0 (x): Is equal to 0 with division by 0, otherwise x. 
 
NDIV(<Expression>) 
Delivers 0 if the expression named in <Expression> gives a division by 0 
in the calculation. Otherwise, the result is the value of the expression. Is used to  
•      Avoid the output of an error message 
•      Continue calculating with a defined result 
 
Result 
 

SUMCT <Operand> 
 

Delivers the result of the operand in all rows or columns (see Percentage 
Functions %CT). 
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Overall Result 
 

SUMGT<Operand> 
 

Delivers the overall result of the operand (see Percentage Functions 
%GT). 
 
Report Result 
 

SUMRT<Operand> 
Delivers the report result of the operand (to distinguish between the overall and the 
report result, see also Percentage Functions %GT and %RT). 
 
Mathematical  Functions 
 
These include:  
• Maximum Minimum Absolute Value 
• Smallest integer value larger than operand 
• Division (integers) 
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Calculated Key Figures 
 
Defining Calculated Key Figures 
 
You can use all basic key figures of the InfoProvider in question, as well as the newly 
defined restricted and calculated key figures of the InfoProvider, to define new 
calculated key figures.  You can define calculated key figures at both the query level 
and the InfoProvider level.  At the query level, the calculated key figure is valid only for 
the query in question.  If you create a calculated key figure at the InfoProvider level, 
you can use it in all queries that are based on the same InfoProvider. 
 
Defining Calculated Key Figures at the InfoProvider level 
 
1.      Select the Key Figure directory, and choose New Calculated Key Figure from the 

context menu. You reach the New Calculated Key Figure dialog box. 
 
2.      Enter a description of the calculated key figure into the Text field. 
 
3.      Define the required formula using basic key figures, restricted key figures, 

formula operators, and functions.  You can use Drag&Drop to transfer the formula 
components into the formula field. 

 
Key figures always have the same units when a query is executed. This means that 
the formula is semantically incorrect if you add a currency unit (for example, EUR) to a 
unit of weight 
(for example, kg). If you want to calculate values without using units, you should use 
the Value Without Dimension function. See Data Functions. 
 
4.       Check the formula definition and choose Formula Syntax Check. 
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Caution:  The Formula Syntax Check function only checks the syntax of the formula.  
It does not check whether the formula is semantically sound, for example, whether 
the units are compatible. 
 
5.      Choose OK. In the Properties of the Calculated Key Figure dialog box, assign a 

technical name, and choose OK. 
 
If you choose Enhance, the dialog box is enhanced with aggregation behavior or 
exception aggregation options. 
 
6.      The new calculated key figure is available under the Calculated Key Figures 

folder, and can be included in the definition using Drag&Drop. 
 
Defining Calculated Key Figures at the Query Level 
 
To define calculated key figures at the query level, you have to include key figures 
needed for the calculation in the query definition, and choose New Formula from the 
context menu of the Key Figure structure.  These formulas are available only locally in 
the query definition. 
 
If you are defining calculations in the columns as well as in the rows, a formula 
collision can occur in the interfaces of the two formulas.  You can therefore, define 
which of the formulas is to be used. 
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Boolean Operators 
 
Boolean operators constitute a particular example of functions that are available as 
operators when you define a calculated key figure. With the help of the Boolean 
operators, you can make comparisons within formulas. 
 
You can use the following operators: 
 
• is less than < 
• is not equal to <>       
• is greater than > 
• is less than or equal to <=  
• is equal to = 
• is greater than or equal to >= 
• logical NOT, AND, OR, and logical exclusive OR XOR 
 
Example:  Costs < Sales Volume.  This expression delivers 1 if the sales volume is 
larger than costs.  It delivers 0 if the costs are larger or the same as the sales volume. 
 
Example: Costs and Sales Volume. This expression delivers 1 if the values for costs 
and sales volume are not equal to 0. Otherwise, it delivers 0. 
 
You formulate if - then - else queries in this way.  
 
Example:  IF sales volume > 100,000 THEN sales volume * 5% ELSE sales volume * 
2% can be described using the following formula: 
 
(Sales volume >100000) * sales volume * 0.05 + (sales volume <= 100000) 
* sales volume * 0.02  
 
This works because at least one side of the calculation will always be multiplied by 
zero. 
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Lesson:   Properties of Key Figures 
 
Lesson Overview 
 
This lesson deals with the properties of key figures.  The lesson provides an example of 
formula collision and explains the functions of the cell editor that can be used when 
implementing two structures in a query definition. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Identify the various settings that can be made for properties of key figures, and 

use them in report 
• Carry out currency translation in the Business Explorer 
• Use the cell editor 
• Create global structures so that complex key figure structures can be reused 
 
 
Business Example 
 
You company has asked you to optimize reports.  You are going to make various 
settings in the properties of the key figures.  You also need query definitions with two 
structures for more complex analyses.  You need the option of using the cell editor to 
address each individual cell of the matrix that is used by both structures. 
 
Properties of Key Figures 
 
The various components of a query have specific properties that reproduce important 
functions. Call the Properties dialog box from the context menu for the key figure for 
which you want to define properties.. 
 
In the Properties of the Selection/Form dialog box for a structure part, you can set a 
range of functions.  
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Properties of the Selection/Form 
 
Description 
 
Here you can change the automatically determined key figure description 
(basic key figure, restricted key figure, calculated key figure) here. Structure parts can 
contain more than one line as a description. 
 
Caution: The total length of all characters in all lines including the line break character 
is limited to 60 characters. 
 
You can use text variables in the description. 
 
Technical name 
 
You can assign a unique technical name to structure parts such as key figures.  This is 
optional. 
 
When accessing external interfaces (such as Crystal reports, in URLs, or through OLE 
DB for OLAP), the structure parts must have a technical name so that it can be 
accessed without error. 
 
Display 
 
You can choose whether the key figure is to be highlighted in the report here.  You can 
hide key figures that you only need for calculating formulas and do not want to display 
in the analysis. 
 
You can also mark as selection as constant so that this selection can no longer be 
changed by navigation and filter at runtime. 
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Number Display 
 
You can set the scaling factor in the Number Format area. 
 
Note that scaling factor does not automatically display in the report.  You have to set 
the scaling factor display separately in the query properties. 
 
You can define the number of decimal places here and reverse the +/- signs. 
 
Note: The reverse +/- signs is only a display function. It has no influence on 
calculation in formulas. 
 
Calculations 
 
You can use this function to recalculate result rows and individual values that display in 
the version according to particular criteria. 
 
Example: You want to calculate the result on the basis of the average of all displayed 
sales volumes instead of on the basis of total sales volume. Example: You want to 
display individual values normalized to the result of overall result. 
 
You can use the Cumulated function to ensure that the cells of a column are presented 
from top to bottom, and the cells of a row are displayed from left to right. 
 
Currency Translation  
 
In the Query Designer, you can set a currency conversion key and a target currency in 
the Properties dialog box for a structure part. 
 
Formula Collision 
 
The Formula Collision function only displays in the Properties dialog box if two 
structures are used in the query definition and both contain formulas.  In places where 
the two formulas collide, it is not clear how the system should calculate.  You can 
therefore choose the formula you want to use to calculate the value. 
 
Enhance 
 

In the Properties of the Calculated Key Figure dialog box, you can also select an 
exception aggregation for a special characteristic for the calculated key figure. 
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Properties of the Calculated Key Figure 
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Currency Translation 
 
A currency translation in the Business Information Warehouse can take place at two 
points. 
 
When the data is updated in the InfoProvider, a currency can be determined for use 
with each key figure. When analyzing data in the Business Explorer, you can determine 
the currency conversion key and target currency for each structure part separately.  
You choose a currency conversion key that has been created in the Administrator 
Workbench.  If necessary, enter the required target currency into the Target Currency 
dropdown box. 
 
If you want the target currency to be flexibly determined at the runtime of the report, 
you can include a currency variable.  Choose Variable Entry to do this. A default menu 
appears when you start the report, where you can select the target currency you want. 
 
All value key figures of the query can be translated into one common target currency 
with a currency translation key in the report. 
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Reusable Structures in Queries 
 
Structures are combinations of characteristics and key figures (of basic key figures, 
calculated key figures, or restricted key figures) of the InfoProvider. A structure can be 
used in a planned/actual comparison or in a contribution margin scheme. 
 
Structures can also be used in several queries for the same InfoProvider.  In order for 
this to be possible, you need to save them as reusable structures. In order to make a 
distinction, we call structures that are not stored as reusable structure local structures. 
Local structures are only used in one query. 
 
 
1.      Call up the context menu in the heading of the Rows or Columns directory. 
Choose New Structure. 
 
2.      In the context menu of the new structure, choose New Selection.  In the  New 
Selection dialog box, use drag and drop to choose characteristics and key figures of 
the InfoProvider that you want to use in the new structure. Restrict one characteristic 
or key figure. Define a new formula for calculations. 
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Creating Reusable Structures 
 
1. Select the structure that you want to reuse.  Choose Save as… from the context 

menu (right mouse-click) and enter a technical name and a description. 
 

2. The saved structure is now available in the structure directory of the InfoProvider 
tree.  You can use the structure for the definition of new queries for this 
InfoProvider. 

 
Changes made later to global structures affect all queries in which they were used.  If 
you only want to make local changes in a particular query, you can choose Remove 
Reference in the context menu for the structure, and thereby, change the reusable 
structure into a local structure. 
 

Changes made later do not affect the definition of the reusable structure, nor the 
queries that you made with this reusable structure. 
 
Cell Editor 
 
 
• Cell editor allows direct definition of specific cells in a query. 
• Cells are the intersection of two structures in a query definition. 
• The Cell Editor can only be used in query definitions where there are two 

structures. 
 
Note: One structure will hold only characteristics while the other structure holds only 
key figures. 
 
•      Cells can be formulas, selections, references or auxiliary cells. 
 
The Cell Editor is a function of the BEx Query Designer.  You can select the editor if 
the query definition contains two structures.  You can define a maximum of two 
structures in a query definition.  One of these structures can contain key figures.  You 
use characteristic values in one structure, and key figures in the other. 
 
Defining Exception Cells 
 
Use 
 
Cell-specific definitions allow you, in addition to the implicit cell definitions resulting 
from the formulas created, to explicitly define formulas and selection conditions for 
cells, thereby overwriting the implicitly generated values. This function allows you to 
create more detailed queries. 
 
You can also define cells that have no direct relationship to the corresponding structure 
parts.  These cells do not display; they do serve as containers for auxiliary selections 
or formulas. 
 
 
Caution: A cell is the intersection of two structure elements. The term Cell in the 
function of Defining Exception Cells should not be confused with cells in MS-Excel. 
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The formulas or selection conditions that you define for a cell are always effective at 
the intersection of two structure elements.  If a drilldown characteristic has various 
characteristic values, the cell definition is always effective at the intersection of the 
characteristic value with the key figure. 
 
 
Procedure 
 
 
1.      In the Query Designer, choose Define Cells           to reach the Cell Editor 
functions. 
 
2.      You can now use four different functions. 
 
New Selection 
 
• Select a cell in the Cell Definition dialog box, and use the right mouse button to 

choose New Selection. 
 
• Define the required selection. 
 
• Enter a description for the selection and choose OK. 
 
New Formula 
 
• Select a cell in the Cell Definition dialog box, and use the right mouse button to 

choose New Formula. 
• Define the required formula.  Enter a description for the formula and choose OK. 
 
 
New Cell Reference 
 
Each cell that you define can be reused in formulas.  If you want to reuse the value of 
the implicit generic cell definition that automatically occurs at the intersection of two 
structure parts of a query, select this cell in the Cell Definition dialog box, and choose 
New Cell Reference using the right mouse button.  The description arising from the 
two structure parts automatically appears in the cell.  You can now refer to this cell. 
 
Additional cells 
 
Choose Additional Cells if you need additional cells for auxiliary selections or 
formulas. 
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Unit Summary 
 
You should now be able to: 
 
• Explain the objectives and use of restricted key figures in information analyses 

• Define restricted key figures at the InfoProvider and query level 

• Use the enhanced selection function for selecting restriction values 

• Use the Exclude from Selection and Include in Selection functions 

• Explain the use of constant selection 

• Define new calculated key figures and explain their usage in reports 

• Define a calculated key figure when using a restricted key figure and include it in 

the analysis 

• Identify the various settings that can be made for properties of key figures, and 

use them in report 

• Carry out currency translation in the Business Explorer 

• Use the cell editor 

• Create global structures so that complex key figure structures can be reused 
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Exercise 6  
 

Unit 5 – Restricted Key Figures 
 
 
 
 
 
 
 
` 
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Task 1  
Define two restricted key figures that depict the sales volume for the period leading up to 2002 and for the 
year 2002 itself. For the definition of two further key figures, you use the enhanced selection conditions to 
restrict the sales volume for each sold-to party to the selected materials.  

Create a new query using 
 

1. InfoProvider: SAP Demo Sales and Distribution overview Cube (0D_SD_C03) in the BW305 
Reporting InfoArea with the characteristic Sold-to  party (0D_SOLD_TO) in the rows.  
As global filter user Division (0D_DIV) restricted to High Tech, and  
Sales Organization (0D_SALE_ORG) restricted to Sales Organization 1616 
Define a new restricted key figure at InfoProvider level.  We will limit the basic key figure Sales 
Volume to a January 2002. 
Description: GR01 OpenNetValue2002 
Technical name: BW3057A01. 

  
   

2. In the same query, define restricted key figures at query level. This key figure is to display Net 
Value in stat.Cur for period of January 2002 to December 2002.  Description: GR##Net Value in 
stat.Cur 2002.  Define another restricted key figure Net Value in stat.cur. restricted to all the 
materials that contain Flat Screen in their description. 
 

Caution: You must distinguish between upper and lower case when searching. 

a) Description: OpenNetValue2002MonitorFlat. 
Choose OK.    

b) Save the query by clicking  
c) Description: GR##BW305RestrictedKeyFigures. 

Technical name: BW3057B##. 
Now execute the query       
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Task 2  
You use selections when defining the restricted key figure to determine the data that you want to 
display at runtime. Use the Constant Selection function to easily select reference sizes that can not 
change at runtime.  
 
1. Create a new query based on the InfoProvider Cube (0D_SD_C03).  Place the characteristic 

Material (0D_MATERIAL) into the rows. Use the characteristics Sales Organization 
(0D_SALE_ORG) as the global filter, restricted to the sales organization Germany Frankfurt (1512).  
Place the InfoObject Cal. year / month (0CALMONTH) into the free characteristics, and restrict it to 
the single values 03/2002.  Create a restricted key figure open orders and restrict it to period 
6/2002.  Make a copy of the 1st key figure and make sure that the second one has only values that 
are coming from the InfoProvider.  Put constant selection on both of them.  What happened to the 
query when you did that? 
Define two new key figures.  
Description: SalesCurrentQuarter.  
Description: SalesValueCurrentQuarter.  

 

Save the query 

Description: GR##BW305SelectionofConstants. 

Technical name: BW3057C##. 

Now execute the query.  
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Exercise 7  
 

Unit 5 – Calculated Key Figures 
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Task 1  
Generate a report that represents the sales volumes and Net Value of the first two quarters of 2002 as 
well as the first half-year with percentage changes.  
 

1. Create a new query based on the InfoProvider SAP Demo Sales and Distribution overview Cube 

in the SAP Demo InfoArea. In the rows, create a structure with the following name: Description: 

GR## Quarterly Comparison 

 Technical name: BW3059A##. 
 This query contains the first and second quarters of 2002. The structure should also  include 
the first half-year as a sum of the first two quarters.  

  
 

2. In the columns, include the basic key figures Open Order  net value and Net value in 
 statistic currency. Define a new calculated key figure that calculates the percentage  share 
of the Open Order in relation to net value of Net Value.  Description:   %Share Open Order of 
Net Value 

 
  

3.  Save the query  

 Description: GR##BW305FormulaCollision. 

 Technical name: BW3059C##. 

Now execute the query. If necessary, carry out a currency translation. At the point where the 
1st half 2002 and % share open orders of net value calculations cross, there is a formula 
collision.  Decide which of the formulas you want to be valid for the calculation of the values 
at the point of collision, and make the appropriate setting in the properties of the key figure or 
calculated formula.  

 
Task 2  
You need information on the share of the sales volume for the individual quarters in relation to the 
first half -year. You define a new calculated key figure that uses the value from a particular cell for 
calculation.  
 
1. In the query definition GR## BW305 Formula Collision (BW3059C'##), define a new 
 formula that calculates the share of the sales volumes for the individual quarters in 
 relation to the sales volume for the first half-year. Use the cell editor to do this. Select  the 
sales volume for the first half year there as a reference cell.    
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Exercise 8  
 

Unit 5 – Properties of Key Figures 
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Task 1  
Generate a report that represents the sales volumes and Net Value of the first two quarters of 2002 as 
well as the first half-year with percentage changes.  
 

1. Create a new query based on the InfoProvider SAP Demo Sales and Distribution overview Cube 

in the SAP Demo InfoArea.  

In the rows, create a structure with the following name:  

Description: GR## Quarterly ComparisonB 

 Technical name: BW3059B##. 
 This query contains the first and second quarters of 2002. The structure should also  include 
the first half-year as a sum of the first two quarters.   
 
2. In the columns, include the basic key figures Open Order and Net value in stat cur. Define a new 

calculated key figure that calculates the percentage share of the Open Order in relation to net 
value of Net Value.  Description: %Share Open Order of Net Value.  Make sure only formula 
is visible in the query.  

 

3.  Save the query  

 Description: GR##BW305FormulaCollisionB. 

 Technical name: BW3059CB##. 
Now execute the query. If necessary, carry out a currency translation. At the 
point where the Half Year 1 and Percentage Variance of Quarters calculations 
cross, there is a formula collision with the calculated key figure % Share Open 
Order of Net Value.  Decide which of the formulas you want to be valid for the 
calculation of the values at the point of collision, and make the appropriate 
setting in the properties of the key figure or calculated formula.  In the currency 
conversion key dropdown, select Average rate – current rate.  In the target 
currency dropdown, select US Dollars (5 dec).  Click OK, save the query, and 
execute it.  You may get some warnings. 
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Task 2  
You need information on the share of the sales volume for the individual quarters in relation to the 
first half -year. You define a new calculated key figure that uses the value from a particular cell for 
calculation.  
 
1. In the query definition GR## BW305 Formula CollisionB (BW3059CB'##), define a new 
formula that calculates the share of the sales volumes for the individual quarters in relation to the 
sales volume for the first half-year. Use the cell editor to do this. Select the sales volume for the first 
half year there as a reference cell.    
 Description: Share of Open Order of Overall Open Order forHalfYear1.  

 Save the key figure structure you defined as a reusable structure.  

 Description: GR## OpenNetValue AnalysisB  

 Technical name: BW3059HB##.  
 Save the query and then execute it. Take a look at your report.  
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Unit 6 - Characteristics 
 
Unit Overview 
 
With SAP BW your managers are better informed on all levels in order to make 
decisions and react quickly, which is necessary in today’s dynamic markets. In 
addition, the use of hierarchies and structures in combination with hierarchies is 
discussed in this unit. 
 
You can create your own hierarchies in SAP BW. To do this, you use time-dependent 
hierarchy structures and linked nodes. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Describe the various properties of characteristics and their use in adjusting reports 

to your requirements 

• Demonstrate the benefit of using display attributes to describe characteristics in 

more detail 

• Describe the difference between using display attributes and navigation Display 

characteristics and key figures in a hierarchy 

• Define how the hierarchy is displayed in the report 

• Combine hierarchies and structures 

• Restrict characteristics to hierarchy nodes 

• Define your own hierarchies in BW 

• Create time-dependent hierarchy structures 

• Use link nodes in the hierarchy definition 
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Lesson:   Properties and Attributes of Characteristics 
Lesson Overview 
 
This lesson deals with the properties of characteristics and the various options for 
enhancing reports with additional information in the form of attributes. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Describe the various properties of characteristics and their use in adjusting reports 

to your requirements 
• Demonstrate the benefit of using display attributes to describe characteristics in 

more detail 
• Describe the difference between using display attributes and navigation attributes 
 
Business Example 
 
Reports are often used as the basis for decision-making. In order to implement 
measures resulting from these reports without losing time, it is often necessary to 
collect additional information quickly, such as a contact person and the telephone 
number of a sold-to party or the person responsible for a cost center.  Including this 
information in your reports in the form of attributes saves valuable time. 
 
Properties of Characteristics 
 
The various components of a query have specific properties that reproduce important 
functions. You call the properties dialog box from the context menu for the 
characteristic for which you want to define properties, by selecting Properties. 
 
In the Characteristic Properties dialog box, you can make settings for a range of 
functions that affect the key figures for this characteristic in the query drilldown. 
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Characteristic Properties for Characteristic ... You can define the following 
properties for characteristics:  
 
Description 
The text provided in the InfoObject maintenance appears here. You can change the 
text and display it in the query. 
 
Display As 
This is where you determine how characteristic values display, as long as they values 
were created in the InfoObject maintenance for the characteristic: 
• No Display Key and Name  
• Name and Key Name 
• Key Long or Medium Name 
 
Display of Results 
 
• Suppress Results Rows 
 
You can structure the appearance of your report by using this function to determine 
whether the results rows are displayed Always, Never or With Only One Value. 
 
• Normalized to You can use this function to normalize key figure values to a specific 

characteristic. When values are normalized, the key figures display as a percentage 
of the chosen result. 

 
You can select the Query Result, Overall Result, and Result (interim result) as the 
reference value. 
 
The characteristic is normalized only if it is in the drilldown. 
 

• Cumulative 
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This function aggregates the values of the characteristic values (the nth value is 
aggregated with the n+1 value). 
 
Sorting 
 
You can make settings for sorting within the characteristic. You can use the following: 
 
The characteristic itself, sorted by key or name 
 
All attributes of the characteristic sorted by Key or Name 
The sort sequence is either Ascending or Descending. 
 
You cannot use the attribute that you have selected for sorting in the display. 
 
Display Hierarchy 
 
You can display and make the necessary settings for the characteristic hierarchically. 
 
Attributes 
 
Characteristics can be described in more detail through attributes.  For example, you 
can assign the attribute Telephone Number to the characteristic Sold-to Party to 
display the telephone number of the sold-to party. 
 
You assign attributes to characteristics in the InfoCube maintenance. You can maintain 
them as purely Display Attributes or as Navigation Attributes. You can show 
Display Attributes in a report in the drilldown.  However, navigation steps are not 
possible.  (For example, you cannot choose values from a display attribute as a filter.) 
 
To include a display attribute in the drilldown, open the index for the characteristic.  
Once in the Attributes index, drag the required attribute into the query definition. 
 
To select a display attribute of a characteristic that is already in the query definition, 
from the context menu of the characteristic, choose Attributes. 
 
In the Attribute Properties for a specific attribute for a characteristic, you can set the 
display functions as key, name, and so on. 
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You can use Navigation Attributes for defining queries in reporting in the same way 
as characteristics.  They display in the dimension of the characteristic to which they 
belong. 
 
In order to use an attribute as a navigation attribute, note the following: 
 
1.      You have to flag the attribute as a navigation attribute in the InfoObject 
maintenance of the characteristic. 
 
2.      You have to select that attribute from the list of possible navigation attributes in 
InfoCube maintenance. 
 
Note the following when using navigation attributes: 
 
• Time-dependency of the navigation attribute. 
 
Navigational attributes enable you to view current data with characteristic values from 
the past or view past data with current characteristic values. 
 
• Navigation attributes used as characteristics in query design. 
 
• Slight loss in query performance when compared to characteristics. 
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Lesson:   Integrating Hierarchies into Reports 
 
Lesson Overview 
 
This lesson deals with using hierarchies and using structures in conjunction with 
hierarchies. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Display characteristics and key figures in a hierarchy 
• Include external hierarchies in your reports 
• Define how the hierarchy is displayed in the report  
• Combine hierarchies and structures 
• Restrict characteristics to hierarchy nodes 
 
Business Example  
 
You can increase the clarity of your reports by arranging several characteristics and key 
figures hierarchically in your reports.  In order to analyze the characteristics values of, 
for example, a cost center or a material, external hierarchies are often used. If may 
also be necessary to combine structures with hierarchies for presentation in the report. 
 
Hierarchical Display in Reports 
 
You have two options for hierarchical displays in reports: 
 
1.      You can display the characteristics included in the query definition as a 
hierarchy.  
 
2.      You can select an external hierarchy as a display hierarchy for a characteristic 
in the query definition. 
 
Hierarchical Positioning of Characteristics and Key Figures 
 
You can display characteristics and key figures in the rows and in the columns as 
hierarchies by selecting Display As Hierarchy from the context menu of the row or 
column header. 
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Hierarchical Positioning of Characteristics 
 
Selecting External Hierarchies 
 
• You create hierarchies for basic characteristics, for example, Cost Center 

(0COSTCENTER). 
 
• External hierarchies are saved in special master data tables. They behave like 

master data and therefore, you can use and modify them in all InfoCubes. 
 
• You can define several hierarchies for a characteristic. You then select the display 

hierarchy from these hierarchies. 
 
In order to make hierarchies available for a characteristic in BW, you can load 
characteristic hierarchies from a source system or create them in the Business 
Information Warehouse. 
 
You determine whether a characteristic can have a hierarchy in the InfoObject 
maintenance.  This is also where you define the properties of the permitted hierarchies 
(for example, hierarchy versions, time-dependent hierarchy structures). 
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Hierarchies in Reports 
 
 

Including Hierarchies in Reports 
 
1.      Choose Properties from the context menu of the characteristic that you want to 
present in a hierarchy. 
 
2.      In the Properties dialog box, choose values from the Display Hierarchy            
area. 
 
3.      In the list of Available Hierarchies, select the required fixed hierarchy and choose 
OK. 
 
Properties of the Display Hierarchy 
 
Each hierarchy has the properties that were determined in the hierarchy definition. 
You can override the following hierarchy properties in the query definition for a 
hierarchy. 
 
Sorting 
Within the hierarchy, you can sort in Descending or Ascending order by 
Key or Name. 
 
Expand to Level 
To determine the hierarchy level to which the hierarchy is expanded in the report, in 
the U column (User Settings), put a check in the checkbox and enter the required 
numerical value. 
 
Position of Lower Level Nodes 
In the U column, put a mark in the checkbox and choose whether the subordinate 
nodes are positioned above (Up) or below (Down) a superior node. 
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Values of Posted Nodes 
In the U column, put a check in the checkbox and choose whether you want to Display 
or Suppress the values of posted nodes. 
 
Nodes with Only One Lower-Level Node 
In the U column, put a check in the checkbox and choose whether you want to Display 
or Suppress nodes with only one lower level node. 
 
Using Hierarchies to Make Restrictions 
You can use hierarchies to select filter values for characteristics by selecting individual 
hierarchy nodes. 
 
If you restrict the characteristic to one hierarchy node, the node hierarchy is 
automatically taken as the display hierarchy.  However, you can switch the display 
hierarchy to not active. 
 
In order to restrict a characteristic to a hierarchy node, from the dialog box, select 
Restrict and then the hierarchy. Select the required hierarchy node and confirm with 
OK. 
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Combinations of Hierarchies and Structures 
 
You can combine hierarchies and structures in the display so that you can choose to 
display the characteristics in non-hierarchical form (example A) and hierarchical form 
(example B). 
 
A: 
If you combine a hierarchy with a structure but do not choose Display as Hierarchy, a 
column and a row are used for both the hierarchy and the structure. 
 
B: 
With the hierarchy display, the hierarchy appears with the structure in a column or a 
row. 
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Lesson:   Creating User-defined Hierarchies 
 
Lesson Overview 
 
This lessons covers creating user-defined hierarchies in SAP BW. It also deals with 
time-dependent hierarchy structures and linked nodes for use in creating hierarchies. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Define your own hierarchies in BW 
• Create time-dependent hierarchy structures 
• Use link nodes in the hierarchy definition 
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Business Example 
 
Along with external hierarchies that are loaded from the source systems, you may also 
need to include user-defined hierarchies in you reports.  The hierarchy structures that 
you require are time-dependent so that they can portray restructuring in reports. 
 
Hierarchy Components 
 
A hierarchy gives an overview and the structure of a characteristic according to 
specific evaluation criteria. 
 
Nodes 
 
A hierarchy is made up of nodes.  The relationship between the nodes is defined as 
follows: 
 
• The uppermost node is the root. 
• There can be several roots. 
• Each node (except for the uppermost node) is assigned to one super-ordinate 

node. 
• There is a distinction between postable and non-postable nodes. 
 
Hierarchy  Levels 
All nodes that are on the same level in a hierarchy (nodes that are the same distance 
away from the root) form a hierarchy level.  The root of a hierarchy forms the first level.  
The level of a node denotes the distance of the node from the root. 
 
Leaves 
Hierarchy leaves contain the characteristic values for the basic characteristic and can 
therefore have entries in the fact table. In contrast to postable nodes, a leaf cannot 
have any subordinate nodes. 
 
Intervals  
Intervals contain a number of leaves that belong together, described by their upper and 
lower limits.  You can create them for a node that has more than one leaf. By defining 
intervals, new characteristic values that are added to the master data automatically 
become assigned to the interval if the characteristic value is included in the interval 
range. 
 
Basic  Characteristic 
You can create hierarchies only for those characteristics that do not relate to another 
characteristic. 
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Creating User-defined Hierarchies 
 
As a prerequisite for creating hierarchies, in the InfoObject maintenance for the 
characteristic concerned, you have to set the With Hierarchies indicator, which states 
that the characteristic can have hierarchies. You also have to determine whether the 
hierarchy or hierarchy structure can be time-dependent, or whether versions can be 
created for it. 
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Creating User-defined Hierarchies 2 
 
Hierarchy nodes appear twice in the hierarchy when nodes that have the same 
technical key and that appear more than once are leaves (postable nodes without 
lower-level nodes), and when they are not attached to the same super-ordinate node. 
 
You can then either set the nodes as link nodes or make the hierarchy structure 
time-dependent and specify that the time intervals of all duplicate nodes with the 
same technical key do not overlap. 
 
Link Nodes 
You use link nodes to include a sub-tree in a hierarchy more than once.  The name, the 
InfoObject and, if necessary, the from/to date fields of the nodes are identical.  
However, the link node is only a link to the original node that you cannot change 
independently.  Link nodes cannot have their own lower-level nodes.  They take on the 
lower-level nodes of the original node. These lower-level nodes do not display in the 
hierarchy maintenance. 
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Creating User-defined Hierarchies 
 
1.      Call the Administrator Workbench and, under Modeling, choose the 
InfoObject tree. 
 
2.      Highlight the characteristic for which you want to create a hierarchy and, from the 
context menu, choose Create Hierarchy. 
 
3.      In the dialog box, enter the technical name of the hierarchy, the hierarchy version 
(if necessary), the time base, and at least a short description 
for the hierarchy.  Once you have confirmed your entries, the Maintain 
Hierarchy screen appears. 
 
4.      To create nodes and leaves, choose the relevant pushbutton for the node that 
you want to create.  You can choose from text nodes, characteristic nodes of external 
characteristics, leaves of the basic characteristic of the hierarchy, or intervals. 
 
Postable nodes (characteristic nodes of the basic characteristic in the hierarchy, 
intervals) are symbolized by the green InfoObject icon. Non-postable nodes (text 
nodes, external characteristic nodes) are symbolized by the yellow InfoObject icon or 
by the file folder icon. 
 
You can arrange the nodes as you wish beneath one another as far as interval level.  
You cannot attach any additional nodes under intervals. 
 
5.      Repeat this step until you have determined the final hierarchy structure. 
 
6.      Save and activate your hierarchy. 
 
Reporting-relevant Settings in the Hierarchy Maintenance 
You have various options for hierarchy settings in the hierarchy maintenance. 
 
Level  Maintenance 
A level encompasses all nodes in a hierarchy that are at the same stage in the 
drilldown. You can use Level Maintenance to determine names for the different levels 
of a hierarchy.  These names are then used in the context menu of the query during 
navigation. 
 
Hierarchy  Attributes 
You can set the presentation parameters for the hierarchy display in the query using 
Hierarchy Attributes. 
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Showing/Hiding the Values of Posted Nodes 
 
Do Not Display Inner Nodes in the Query 
There are various display options for an inner, postable node, that is, an inner node 
that has subordinate postable nodes (lower-level nodes). You can either create a leaf 
for each inner node and insert it directly 
underneath the inner node, or choose not to display the additional nodes. 
 
Changeable Display for Leaves of Inner Nodes 
You can determine whether the user is able to change the display for the runtime of 
the query. The following values are possible: 
 
’ ’: The display cannot be changed in the query. 
 
’X’:  The display can be changed in the query. 
 
Suppress Unassigned Node 
Here you can specify whether to suppress the node under which all postable 
characteristic values that do not appear in the hierarchy display. 
 
Root/Totals Item 
You can determine whether the root and therefore, the totals item display at the end or 
start of the query and whether the leaves appear above or below. 
 
Start Drilldown Level 
You can set the default level to which the hierarchy is drilled down when you first call 
up the query.  You can overwrite this setting in the query definition. 
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Unit Summary 
 
You should now be able to: 
 
• Describe the various properties of characteristics and their use in adjusting reports 

to your requirements 

• Demonstrate the benefit of using display attributes to describe characteristics in 

more detail 

• Describe the difference between using display attributes and navigation attributes 

• Display characteristics and key figures in a hierarchy 

• Include external hierarchies in your reports 

• Define how the hierarchy is displayed in the report  

• Combine hierarchies and structures 

• Restrict characteristics to hierarchy nodes 

• Define your own hierarchies in BW 

• Create time-dependent hierarchy structures 

• Use link nodes in the hierarchy definition 
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Exercise 9  
 

Unit 6 – Properties and Attributes of Characteristics 
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Task  

Define a report that displays the sold-to parties, their materials, the relevant net value of stat.cur for the 
period January 2002 to June 2002 

Display the location, region and telephone number for the sold-to parties as additional information. Make 
the necessary settings so that you can select data based on country and postal code later.  

1. Create a new query based on the SAP Demo Sales and Distribution overview Cube (0D_SD_C03) 

In the columns, include the basic key figure Net Value Stat.Cur.  
In the rows, include the characteristics Sold-to Party and Material.  

 
2. As additional information for the sold-to party, include the attributes location, region and telephone 

number in your report. For the region, define that only the name is to be displayed.  

Alternate: 
 
a)   You can also expand the folder for sold-to party and then expand the attributes folder.  From 

here, you can drag&drop the attributes you want into the report.  Note that you must place the 
attributes under the characteristic they belong to in the query definition. 

 
 

3.  Display only the name of the sold-to party.  In order to structure the report clearly, specify that the 
results rows are not displayed for Cal. Year/Month (0CALMONTH)   

  
 
4.  Save the query and execute it. 
 Description: GR##BW305Characteristics 
 Technical name: BW30510B## 
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Exercise 10 
 

Unit 6 – Integration of Hierarchies 
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Task 1  
You want to display an overview of sales groups for the sales organizations in your report by a company 
code. To structure the report clearly, display the characteristics Sales Organization as a hierarchy.  
 

1. Create a new query based on the SAP Demo Sales and Distribution overview Cube 
(0D_SD_C03)  In the rows, include the characteristic Company Code (0D_CO_CODE) and 
characteristic Sales Group (0D_SALE_GRP)  

 
2. Display the characteristics in the rows as a hierarchy.   

 
3. Save the query: 

Description: GR##BW305Hierarchy1 
Technical name: BW30511A##. 

 
4. Now execute the query. 

 
 
Task 2  
In another report, you want to display Sales Organization as a hierarchy.  Include open orders, Create a 
new query based on the SAP Demo Sales and Distribution overview Cube (0D_SD_C03).  Put the 
characteristic Sales Organization (0D_SALE_ORG) into the rows.  Expand the hierarchy to 3 levels, 
position of lower nodes----down; display values of posted notes and hide nodes with only one lower level 
node. 
Save the query.  
Description: GR##BW305Hierarchy2  
Technical name: BW30511B##.   

Note that the hierarchy is expanded down three levels, as you specified in the properties 
of the hierarchy. 
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Unit 7 - Variables 
 
Unit Overview 
 
This lesson identifies the different types of variables and their various processing 
types.  The lesson also describes how to create variables using the variable Wizard.  
Examples of variables that are delivered with Business Content are presented. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Describe how variables can be used for defining more flexible reports 

• Describe the different types of variables  

• Create different types of variables using the Variable Wizard 

• Use variables that are delivered with Business Content in your query definition 
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Lesson:   The Variable Wizard 
 
Lesson Overview 
 
This lesson deals with the different types of variables and their various processing 
types. 
 
It describes how to create variables using the Variable Wizard. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Describe how variables can be used for defining more flexible reports 
• Describe the different types of variables 
• Create different types of variables using the Variable Wizard 
• Use variables that are delivered with Business Content in your query definition 
 
Business Example 
 
You want to use flexible reports in your company with free selection of characteristic 
values.  In order to do this, you have to define variables using the Variable Wizard.  By 
including text variables that are filled using the replacement path, you receive detailed 
information in your reports. 
 
Using Variables  
 
Variables are query parameters that you define in the Query Designer and that are 
filled with values only when you execute the query or Web application. 
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Creating Queries with Variables 
 
Variables act as placeholders for: 
 

• Characteristic values 
• Hierarchies       
• Hierarchy node 
• Texts 
• Formula elements 

 
Variables are reusable objects. 
 
The variables defined in the Query Designer are available in all InfoProviders for use in 
query definition. Variables do not depend on the InfoProvider, but rather on the 
InfoObject for which they were created. 
 
Variables enable you to set queries more flexibly (query parameterization). When using 
variables in the Query Designer, you do not choose fixed characteristic values, 
hierarchies, hierarchy nodes, texts, or formula elements, but rather you set variables as 
placeholders. These placeholders are then filled with values at query runtime (when 
you insert the query into a workbook, when you refresh a workbook or when you 
launch the query on the Web). If you use variables, a query definition can then serve 
as the basis for many different queries. 
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Processing Types for the Different Types of Variables 
 
There are different variable types, depending on the object (for example, 
characteristic, formula) for which the variable is defined as a placeholder. 
 
Characteristic  Value  Variables 
 
When selecting characteristic values in the query definition, you can select variables 
instead of fixed values. These variables, which act as placeholders, are filled with 
values when you execute the query.  You can use variables to select single values and 
value ranges. 
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Characteristic Value Variables 
  
1.      Selecting Single Value Variables 
 
From the context menu of the characteristic, choose Restrict. The dialog box for 
selecting characteristic values appears. 
 
Select the Variables tab page and transfer the required variables using 
Drag&Drop or the Arrow button. 
 
2.      Selecting Single Value Variables as Variable Value Range Limits  
In the dialog box for selecting characteristic values, in the Selection field, choose 
Value Range and set the required operator (Between, Less than, Greater than, ...).  
Select the Variables tab page. When using the Between operator, you can restrict both 
limits using single value variables or choose a single value variable for one of the 
interval limits and transfer a fixed value for the other interval limit on the Fixed Values 
tab page. 
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When using the operators Greater than or equal to, Less than or equal to, Greater 
than, or Less than from the list of available variables in the left window, highlight a 
variable and move this using Drag&Drop or the Arrow button into the right Selection 
window. 
 

Hint:  Swapping Interval Limits 
If you are using variables when making interval selections, you can swap the limits by 
highlighting the relevant variable in the right Selection window, and choosing Swap 
Interval Limits from the context menu. 
 
3. Selecting Variables with Several Single Values or Value Ranges Depending on 

how they have been defined, you can not only select single values for variables, 
but also several single values, intervals, or selection options. Under Single Values, 
select the relevant variable from the variables window and specify the values or 
interval limits when you execute the query.  

 
Text  Variables 
 
Text variables represent a text. You can use text variables in query descriptions, 
calculated key figures, and structural components. 
 
To include an existing text variable, choose the ’Select Text Variable’ icon 

 and search for the required text variable in the list of existing text variables.  This 
appears with its technical name, enclosed by ampersands (&), in the description. 
 
Formula  Variables 
 
Formula variables represent numerical values. You can use formula variables in 
formulas. 
 
Numerical values are also used for calculating exceptions and conditions. You can 
also use formula variables here.  
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Variables for Formulas 
  
Example: 
 
To calculate bonuses, use a formula variable with the currency unit to process the 
current threshold value for bonus calculation when you execute the query. 
 
Hierarchy  Variables 
 
Hierarchy variables represent hierarchies.  You can use them wherever hierarchies 
can be selected. 
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Hierarchy Variables 
 
To select a hierarchy as a variable, in the Select Hierarchy dialog box, set the flag for 
variables. (To reach the Select Hierarchy dialog box, from the context menu of the 

characteristic, select Properties and then the Value Selection icon .) 
 
You then have the option in the Name field of selecting the required variable from the 
existing hierarchy variables. 
 
Note that the Version and Key Date are only input-enabled if the characteristic can 
contain version or time-dependent hierarchies. 
 
Hierarchy  Node  Variables 
 
Hierarchy node variables represent a node in a hierarchy. You can use them as an 
alternative to hierarchy nodes as fixed values for restricting a characteristic. If you use 
a hierarchy node variable, you can make selections by hierarchy node when you use 
the query. 
 
There are two possible combinations of hierarchies and nodes: 
 
Variable hierarchy node with a fixed hierarchy 
 
For example, a report about any department (variable hierarchy node) 
for the hierarchy valid for 2002 (fixed hierarchy). 
 

1. To restrict a characteristic to a variable hierarchy node, use the context menu of 
the characteristic to call the dialog box for restricting characteristic values. 

2. In the Single Values selection field and the From Hierarchy field, select the 
required hierarchy. 
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3. On the Variables tab page, from the list of variables in the left window, select the 
required variable.  Use Drag&Drop (or the arrow pointing to the right) to move 
these into the right Selection window. 

 
 

Variable hierarchy node with a variable hierarchy 
 
For example, a report about any department (variable hierarchy node) 
for the hierarchy valid for the current calendar year (variable hierarchy). 
 

1. To restrict a characteristic with a variable hierarchy to a variable hierarchy node, use 
the context menu of the characteristic to call the dialog box for restricting 
characteristic values. 

 

In the Single Values selection field and the From Hierarchy field, select a hierarchy 
that contains the required hierarchy node. 
 

2. On the Variables tab page, from the list of variables in the left window, select the 
required hierarchy node variable and transfer this into the Selection field. 

 

Highlight the hierarchy node variable in the right window, and from the context menu 
for hierarchy node variables, choose Select Variable Hierarchy. 
 

3. The Selecting Variables for Hierarchies dialog box appears. You can select a 
variable for hierarchy selection here. 
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Figure 70:  Variables for Hierarchy Nodes 
 
To be able to enter a value for the hierarchy node variable at runtime, set the cursor 
on the greyed-out input field and, using input help or the corresponding icon, select 
the required hierarchy node. 
 
If your are using a hierarchy variable at the same time, you first have to select the 
hierarchy. 
 
Variable Processing Types 
 
The following processing types are available: 
 
• User Entry/Default Value 
• Replacement Path  
• Authorization 
• Customer Exit 
• SAP Exit 
 
 
User Entry / Default Value 
 
If you choose User Entry/Default Value as the processing type for a variable, you can 
manually enter the required value for the variable in a dialog box when you execute 
the query. 
 
You enter a default value when you create the variable.  This default value is then 
displayed for input-enabled variables in the input field of the variable screen.  For fields 
that are not input-enabled, the default value is used as the variable value. 
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Replacement Path 
 
The processing type Replacement Path enables you to specify the value that 
automatically replaces the variable when the query or Web application 
is executed. 
 
For example, when you enter a variable as a characteristic value, you do not need to 
determine the text for the characteristic value straight away, but can let it be filled 
dynamically to match the characteristic that is used when the query is executed for the 
variable. 
 
1. Text variables and formula variables with the replacement path processing type 

are replaced by the corresponding characteristic value. The Variable Wizard 
automatically takes you through the Characteristic dialog step.  This is where you 
select the reference for the replacement value. 

 
2. Characteristic value variables with the replacement path processing type are 

replaced by a query result.  
 
In the Replacement Path dialog box, you select the query containing the results that 
you want to use as a variable. You can now use the data result of the selected query as 
a variable in a different query. 
 
Authorization 
 
The Authorization processing type enables you to fill the variables automatically with 
the values from the authorization of a user. 
 
If you choose the Authorization processing type when you create a variable, the 
variable fills automatically with the values in the user ’s authorization. 
 
When the user opens a query, the data selection is automatically carried out according 
to his or her authorizations. 
 
 
Customer exit 
 
If necessary, you have the option of using a customer exit to set up a processing type 
for variables that is tailored specifically to your needs. 
 
The Customer Exit processing type for variables enables you to determine values for 
variables by means of a function module exit.  The function module used is 
EXIT_SAPLRRS0_001. 
 
You create a project in transaction CMOD by selecting the SAP enhancement 
RSR00001 and assigning this to the enhancement project. Activate the project. 
 
For more information about working with the SAP enhancement for global variables in 
reporting, see the SAP enhancement help.  Call the transaction SMOD. Enter the 
name of the enhancement (RSR00001), choose Documentation and then 
EditDisplay/Change. For general information about working with Customer Exits, see 
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the Application Help in transaction CMOD. 
 
SAP Exit 
 
The SAP exit processing type is contained in variables that are delivered with SAP BW 
Business Content. 
 
Overview of the Variable Types and Processing Types 
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Variable Wizard:  General Information 
 
Introduction 
 
The Variable Wizard takes you through a step-by-step process for defining a new 
variable.  
 
The first dialog step in the Variable Wizard explains that instead of defining fixed 
values for your query, you can define variables as placeholders that are then filled with 
values at runtime.  If you do not want to display this step in the future, put a check in 
the Do not display this step in future box. 
 
General  Information  
 
The type of variable is shown in the second dialog step.  You determine the variable 
type by calling up the Variable Wizard in a specific context. 
 
Context-Sensitive  Entries 
 
The following appear differently, according to context: 
 
Details 
Default Values 
Replacement Path 
Characteristic  
Currencies and Units 
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Details 
 
Details is a dialog step in the Variable Wizard in which all types of variables appear 
except for variables with the replacement path processing type. 
 
The Variable Wizard automatically offers you only those options that are possible and 
useful. 
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Variable Wizard:  Details 
 
1. Under Variable Represents, select the display area that the variable is to 

represent.  You can choose from: 
 

• Single Value 
 

The variable represents one value only. 
 
• Multiple Single Values 
 

The variable represents a range of single values.  
 

You can use this setting with hierarchy nodes, for example, to enable the user 
to enter several single nodes. 

 
• Interval 
 

The variable represents a from-value and a to-value. 
 
• Selection Option The variable represents a combination of single values and 

intervals of your choice. 
 
• Precalculated Value Set 
 

The variable represents a number of values that are stored in a database table 
by the Reporting Agent. 

 
2. Under Variable Entry is, specify whether the variable input is Optional, Mandatory, 

or Mandatory, Initial Value not Allowed. 
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3. Under Ready for input you can determine whether the variable is input-enabled 

when the query or Web application is executed.  If the ready-for-input option is 
active (= default setting), the variables screen is offered when you execute the 
query or Web application.  You can then enter the required values, confirm the 
default values, or change the default values. 

 
4. The option Can be changed in query navigation enables you not only to select 

from values that you entered in the variables screen after you have executed the 
query, but also use other values as dynamic filters in the query. 

 
5. Copy personalization data from variable: You can personalize variable values for 

input-enabled variables for each user.  These personal values are saved for each 
variable and each user. 

 
Default  Values 
 
When you define a variable, you enter one or more default values. These then appear 
in the variables screen when you execute the query or Web application. 
 
Replacement  Path 
 
A dialog step of the Variable Wizard that appears for characteristic value variables, 
formula variables, and text variables with the replacement path processing type. 
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Variable Wizard:  Replacement Path 
 
There are different options for the replacement path, according to the type of variable 
used: 
 
Text variables and formula variables with the Replacement Path processing 
type are replaced by the corresponding characteristic value. The value for a formula 
variable has to be a number.  The value for a text variable has to be a text. 
 
1. Under Replace Variable With, you have the following options: 
 
Key 
 
• External Characteristic Value of the Key 
• Name (Text) Attribute Value Hierarchy Attribute 
 
2. Using the setting With Interval Take, you determine whether the From-Value, the 

To-Value, or the Difference is used as the value when the value to be replaced is 
an interval. 

 
3. The setting Offset Start and Offset Length enables you to determine the start and 

the length of the text output. For example, if the only the first 10 characters of the 
text are to be used, the Offset Start value would be 0 and the Offset Length value 
would be 10. 
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4. The Evaluate as Boolean function (value 0 or 1) 
 

This function is only available for formula variables. 
 

If you select this setting, the formula variable is not replaced by a value (for 
example, key value), but rather it specifies whether a non-zero or non-blank value 
exists. 

 
• The value of the variable is 0 if the value to be replaced is a string with only blank 

characters or a zero. 
• The value of the variable is 1 if the value to be replaced is a string with characters 

that are not blank or a number that is not zero. 
• Characteristic value variables with the Replacement Path processing type 

are replaced by a query result.  
 
You can now use the data result of the selected query in a different query using the 
variable. 
 
Example: You want to insert the result of the query Top 5 Products into another query 
Sales Volume - Calendar Year/Month variably. 
 
1. Highlight the characteristic, for example, Product, and from the context menu, 

choose New Variable. The Variable Wizard appears. 
 
2. Enter a name and a description for the variable and choose the Replacement 

Path processing type. 
 
3. You reach the Replacement Path dialog step. Enter the name of the query (for 

example, Top  5  Products) 
 
4. You reach the Save Variable dialog step. 
 
5. You can now insert the variable into the query (Sales Volume - Calendar 

Year/Month) to determine how the sales volume of the 5 products with the highest 
sales volumes has developed on a month-by-month basis. 

 
Each time that the query Sales Volume - Calendar Year/Month is executed, the pre-
query (Top 5 Products) is executed beforehand. This can lead to long runtimes. If you 
do not absolutely need to execute a pre-query (for example, you do not have to 
calculate the top 5 products every time since these change only monthly), SAP 
recommends that you use a variable that represents a precalculated value set. 
 
Characteristic 
 
A dialog step of the Variable Wizard that appears for text and formula variables with 
the Replacement Path processing type. 
 
In text and formula variables with the Replacement Path processing type, the 
characteristic reference is not clear in the system.  Therefore, select the characteristic 
to which the variable refers. 
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Currencies  and  Units 
 
A dialog step of the Variable Wizard for formula variables. You can select from the 
following dimensions: 
 
Amount 
 
Quantity 
 
Price (= currency/unit) Number (= default setting) Date 
 
Saving  Variables 
 
In the final dialog step, you get an overview of the settings you have made for the 
variable. Choose Finish. The variable is saved and the Variable Wizard closes. 
 
Changing Variables in the Variable Editor 
 
The Variable Editor uses a dialog box to give all of the selection options available for 
changing an existing variable. 
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Variable Editor 
 
The individual fields of the dialog box reflect the dialog steps in the Variable Wizard 
and show the current settings of the variable. The dialog box is context sensitive, which 
means that only the fields and options that are relevant for the variable display, 
depending on the type of variable and the processing type. 
 
If you would rather make your changes using a step-by-step processes with 
explanatory text, you can go to the Variable Wizard. 
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Using the Variable Offset 
 
To analyze key figures that have a fixed time- relationship to one another, you can use 
the variable offset. For example, you want to compare the sales volume from the 
current time period with that of the same time period in the previous year. In your 
report definition, you can use the same variable several times to restrict the key figures 
and determine a difference from the input value. 
 
You can also use the variable offset to select an interval as a restriction with upper 
and lower limits that refer to the same variable. 
 
1. To do this, in the upper-left Selection field, choose Value Range and Between as 

the operator. 
 
2. On the Variables tab page, select the required variable and move this using 

Drag&Drop (or using the arrow key pointing to the right) into the right selection 
window. 

 
3. Now specify variable offsets for the upper and lower limits. 
 
Selecting Variable Offsets 
 
This function is only available for characteristic value variables of the type single value 
or interval. 
 
1. Select the relevant variable from the right Selection window. 
 
2. Using the right mouse button, call the context menu and choose Specify Variable 

Offsets. 
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3. In the Variable Offset dialog box, enter the required variable offset. When using 
value ranges, specify the variable offset for the upper and lower limits. 

 
Content Variables  
 
Business Content variables are delivered for all types of variables. You have to activate 
the variables delivered before you can use them. 
 
Variables that are delivered with Business Content from SAP BW often have the SAP 
exit processing type.  This enables you to create complex queries quickly and easily. 
 
For time characteristics, a range of variables are delivered that replace frequently-
used time periods or specific times, for example, the current month or the comparable 
month of the previous year. 
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Content Variables for Cal.  Year/Month (0CALMONTH). 
 
In the Metadata Repository, you find the variables that were created for the 
InfoObjects used.  You also find information about whether the variable in question is 
actively available in the system. 
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Unit Summary 
 
You should now be able to: 
 
• Describe how variables can be used for defining more flexible reports 

• Describe the different types of variables 

• Create different types of variables using the Variable Wizard 

• Use variables that are delivered with Business Content in your query definition 
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Exercise 11 
 

 Unit 7 – Variables 
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Task 1  

In order to structure your reports flexibly, you want to use variables instead of fixed values to restrict 
your key figures. You want to list the Net Value Stat.Cur for each of your materials for a particular month 
and for a time interval. You want to display the chosen time or time period in the column header of the 
sales volumes.  

 
1. Create a new query based on the 0D_SD_C03 

Place the characteristic Material (0D_MATERIAL) into the rows.  

Include the basic key figure Net Value Stat.Cur in the columns, restricted to the characteristic Cal. 
Year/Month (0CALMONTH). Restrict Cal. Year/month using a variable that you define with the help 
of the variable wizard. Specify that a single month has to be entered at runtime.  

Use the following description for the variable:  

Variable name: BW305F## 

Description: GR##Month1 

 

2.  Define a new text variable that you include in the description of the key figure so that you  can list 
the month, to which the Net Value Stat.Cur is restricted at runtime, as a text (for  example,  Net 
Value Stat.Cur September 2002). Ensure that the text variable relates  to the from-value of the 
characteristic variable.  

 Use the following description for the text variable:  

 Variable name: BW305G## 

          Description: GR##TextVar.Month(from) 

  

 
3.  Drag the  Net Value Stat.Cur  key figure into the columns again and restrict this  using a 

 variable so that the user has to select a month interval at runtime to which the  Net Value 
Stat.Cur is restricted.   Use the following description for the variable:         

  Variable technical name: BW305K## 

  Description: GR##MonthInterval 

  
 
4. In order to specify the selected interval in the column header, you need a to-value text variable in 

addition to the from-value text variable. Create the to-value text variable and use both variables in 
the key figure description.  

Enter the following as the text variable description:  

Variable name: BW305L## 

 Description: GR##TextVar.Month(to) 
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  5. Save the query   Description: GR##BW305Variables1. 

 Technical name: BW30513M##. 

 Execute the query. 

    Keep the query open for the next task. 
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Task 2  

You now want to display the sales organization as a hierarchy in your report and select the hierarchy at 
runtime.  

By using a hierarchy node variable, you can select individual hierarchy nodes flexibly.  

 
1. In the query definition of GR## BW305 Variables1, restrict the sales organization to a hierarchy 

node variable, which you create as new. Define the hierarchy node variable to allow the entry of 
multiple single values and to also allow changes to be made during query navigation.  

Enter the following description:  

Description: GR## Hierarchy Node Var. 

Technical name: BW305N## 

Once you have created the hierarchy node variables, stay in the selection dialog box for sales 
organization to define the hierarchy variable in the second step.  

1. Open the global query definition for GR## BW305   Variables1 (BW30512M##).  From the 
context menu for sales organization choose Restrict → Variables tab page.  You see the 
characteristic value variables in the selection list. You have to select a hierarchy in order to 
switch to the hierarchy node variables.   Select a hierarchy, for example PM sales 
organization: Choose From Hierarchy. From the context menu in the left selection window, 
choose New Variable.  

 
2. You also want to be able to select the hierarchy flexibly at runtime. To do this, define a hierarchy 

variable and include this in the query.  

Description: GR## Hierarchy Var.  Technical name: BW305P##a) In the Selection for     

Sales organization dialog box, transfer your hierarchy node variable into the selection window using  

Drag&Drop, call the context menu for the hierarchy node variables that you transferred and  

choose Select Variable Hierarchy.  Set the flag for variables and choose      

New Variable. 
 
3. Save the query and then execute it. Select a hierarchy and two hierarchy nodes. Set  another 
hierarchy node in the query as a filter for the material.  
 
    
  
4. Which hierarchy nodes can you select?  
 

 

5. Which hierarchy nodes would you be able to select if you had created the hierarchy node variable 
so that the variable cannot be changed during navigation?  

 

Task 3  
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You want to display the Net Value Stat.Cur of your customers for a time period that is selected by the 
user. You also want to display the number of selected months in the interval and the average Net Value 
Stat.Cur per month.  

 
1. Create a new query based on the 0D_SD_C03  

Transfer the characteristic Sold-to Party  into the rows.  

Include the basic key figure Net Value Stat.Cur in the columns, restricted to the characteristic Cal. 
Year/Month (0CALMONTH). Restrict Cal. Year/Month by the characteristic variable that you 
created (GR## Month Interval (BW305K##)).  

In order to list the number of months in the interval in the report, define a new formula variable as a 
new calculated key figure on query level with the following description:  

Variable name: BW305Q## 

Description: GR## Number of Months 

This uses the replacement path to calculate the difference between the interval limits of the 
variable GR## Month Interval (BW305K##) for Cal. Year/Month.  

 
2. Use the formula variable GR## Number of Months to create a new formula that calculates the 

average Net Value Stat.Cur per month in the selected time period.   Save the query Description: 
GR##BW305Variables2. 
Technical name: BW30513R##. 
Now execute the query. 
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Unit 8 - Query Properties 
 
Unit Overview 
 
This unit deals with the display of reports, and query definition and documents for 
meta, master, and InfoProvider data in the backend and frontend. The Unit also 
deals with where queries are used, and with deleting queries and copying queries 
between InfoCubes. 
 
Unit Objectives 
 
• After completing this unit, you will be able to: 

• Show and describe the various settings possible in a query definition 

• Influence the structure of and access to reports in a query definition 

• Display the workbooks or views in which a query definition is stored 

• Explain how to delete query objects 

• Explain how to copy queries between InfoCubes 

• Describe the different document classes for metadata, master data, and 

transaction data 

• Define documents for these document classes 
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Lesson:   Query Properties 
 
Lesson Overview 
 
This lesson deals with the options that a user has in a query definition for 
influencing the presentation of reports. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Show and describe the various settings possible in a query definition 
• Influence the structure of and access to reports in a query definition 
• Display the workbooks or views in which a query definition is stored 
• Explain how to delete query objects 
• Explain how to copy queries between InfoCubes 
 
Business Example  
 
You have been given the task in your company of creating queries with certain 
default settings that will from the basis for future reports. Therefore, you not only 
have to structure the reports clearly, but also consider access to additional documents 
for individual objects in order to create a real picture. 
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Query Properties 
 
You can define default properties in the query definition.  To reach the properties 
dialog box provided for this, go to the toolbar in the BEx Query Designer and choose 
the Query Properties symbol. 
 
The following section gives a few examples of the available features . 
 
Features 
 
In the Query Properties dialog box, the modification options are divided into the 
areas General, Display, Specific and the Documents button with which you can jump 
to document definition. 
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Query Properties:  General 
 
General 
 
This tab page gives information about the technical name of the query definition, the 
InfoProvider used as the basis, the owner, and the person who last changed the 
query. 
 
You can change the description of the query definition here and give it text variables 
(in order to keep the variable restriction in the description at runtime, for example). 
 
A key date, which can be required by time-dependent characteristics, attributes, and 
hierarchies and their nodes for the report display, can be fixed or defined with a 
variable request at runtime. 
 
You can change the sequence of entry variables to ensure a logical order for the 
user. 
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Query Properties:  Display 
 
Display 
 
This tab page is divided into two areas: One is for the display options and the other 
for the number format. 
 
The display options include the following: 
 
–       Adjust Formatting after Refreshing 
 
The query format is used to identify the type of data contained in the cell and 
therefore emphasize the structure of the results.  The Refresh formatting after 
Refreshing function ensures that the format is adapted to the updated query data 
when the query is refreshed. This function activates by default.  If you want to 
deactivate this 
function (this helps to improve performance when calling a report), or use your own 
format templates, remove the check from the box. 
 
–       Suppress Repeated Key Values 
 
This function also activates by default, which means that when the query is 
executed only the first key or description displays for each characteristic and any 
additional identical keys or descriptions are suppressed. 
 
–       Display Scaling Factors for Key Figures 
 
This function enables you to include any scaling factors defined in the row or column 
header (for example, *100 EUR). 
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–       Display Document Links 
 
If you activate this function, you have access to document links using the extra symbol 
that displays in the relevant object within the report. As a prerequisite, a document has 
to already exist for an object in the Administrator Workbench.  The information displays 
in a separate browser window. 
 
–       Display Drag and Relate Links 
 
The Drag&Relate function enables you to execute transactions from an SAP R/3 
system or an external system from within the Enterprise Portal.  Field information is 
used to display additional data in a source system (for example, from CRM or the HR 
area). You have to save a BEx Web application as a iView in a role and also integrate 
it into a role in the Enterprise Portal in order to use Drag&Relate with it. If you activate 
this function in the Query Properties on the Display tab page, an additional symbol 
displays for the characteristics in your report. You can then drag this symbol, for 
example for sold-to party, by holding down the left mouse button, from the iView into 
an R/3 transaction (for example, to the iPanel).  The relevant R/3 system transaction is 
called with the required information for this characteristic. 
 
The number format area includes the following: 
 
–       Results Position 
 
You use this function to define the position in which the results area displays: 
Bottom/Right, Top/Left, Bottom/Left, or Top/Right. 
 
–       Display of +/- Signs 
 
This is where you determine how negative values display: With the minus sign before 
the value -<number> after the value <number>-, or with the value in parentheses 
(<number>). 
 
–       Display or Suppression of Zero Rows and Columns. 
 
You have the following options with regard to the display of zero values:  Display 
Zeros, Zeros Without Currency/Unit, Suppress Zeros or Show Zeros as. With the 
option Show Zeros as, you can enter your own value or text that displays in place of 
zeros. Alternatively, you can suppress zero rows and columns altogether. 
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Query Properties:  Specific 
 
You can release the query results to the OLE DB for OLAP interface here by setting the 
flag, if you want to evaluate data from the Business Information Warehouse using third-
party tools.  All characteristics and key figures in the query are then transferred since the 
release of this interface offers a normalized method for accessing BW data using a 
relevant front-end presentation tool. 
 
Documents button 
 
Use this button to jump to the Documents Query Element...  dialog box, from where you 
can display an existing document, or create or import a new document (from Microsoft 
Word, Microsoft Excel, and so on). You can find these documents in the metadata 
repository of the Administrator Workbench. They display there provided that they were 
created with an editor and marked as being online documentation. 
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Query Where-Used List 
 
You have the option in the Query Designer of displaying a where-used list for the query 
definition in workbooks and views.  To do this, choose the Query Where-Used List 
symbol from the Query Designer toolbar. 
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Deleting Query Objects 
 
 

By choosing Delete , you can remove the query definition from SAP BEx, the BEx 
Query Designer, and also from the SAP menu, which has additional selection 
functions, using the path Business Explorer → Query → Delete Objects. 
 
Caution: In order to delete a query object, there must be at least one query, structure, 
restricted key figure, or calculated key figure. 
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Copying Queries Between InfoCubes 
 
In the SAP menu under Business Explorer, you find a Copy function that enables you to 
copy queries and their subobjects (structures, calculated key figures, restricted key figures) 
between different InfoCubes. 
 
Caution: The target InfoCube must contain all of the InfoObjects in the source InfoCube. 
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Lesson:   Document Integration 
 
Lesson Overview 
 
This lesson deals with defining documents for metadata, master data and 
InfoProvider data. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
•      Describe the different document classes for metadata, master data, and 
transaction data 
•      Define documents for these document classes 
 
Business Example 
 
In view of the meaningful value of analytical reports, it is of an enormous advantage to 
be able to access additional documentation within a report. Additional information 
about the query, individual characteristic values, as well as combinations of 
characteristic values is extremely useful in answering a large number of questions.  
When defining characteristic values, it is often desirable to link technical drawings or 
detailed pictures as documentation. 
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Document Access 
 
Document Integration 
 
For metadata, master data and transaction data, you can define and even link one or 
more documents in various formats, versions and languages. 
 
SAP distinguishes between logical documents, which are linked to BW objects using 
attributes (for example, object type and object name), and physical documents which 
belong to a specific logical document as individual characteristic values (versions) and 
which present meta-descriptions for individual files using their attributes (for example, 
language and format). You can store the individual files either on an SAP database or 
on an external content server using an HTTP interface. 
 
In the Administrator Workbench, you choose Documents to reach the navigation 
window for the three document classes Metadata, Master Data, and InfoProvider Data. 
 
To link one document from any document class to another document, without actually 
linking to this document physically, you have to save both documents in a format that 
supports hyperlinks: such as HTML, Microsoft WORD or Microsoft EXCEL. 
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Metadata Document Class 
 
You can define documents for metadata for the following BW objects: 
 
• InfoObject       
• InfoCube       
• InfoSet       
• ODS Object       
• Query       
 
You can define additional explanations for individual structural components, for changes 
that have been made and the reasons for the changes, for historical developments and so 
on here. 
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Metadata Document Integration I 
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Metadata Document Integration II 
 
Master Data Document Class 
 
You can define documents for single characteristic values for master data. Here, you 
can define pictures for personnel numbers, descriptions, and technical specifications of 
materials, original documents and so on. 
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Master Data Document Integration I 
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Master Data Document Integration II 
 
InfoProvider Data Document Class 
 
You can assign one or more documents to the transaction data of an InfoProvider (a 
query, for example).  You also have the option of assigning any number of documents 
to a combination of characteristic values and key figures. The documents are then 
displayed in the report in a context-sensitive fashion, which means that access to the 
documents adjusts according to the navigational state of the report. 
 
Hint: Characteristic is permitted as an attribute of documents. 
In characteristic InfoObject maintenance on the Shared tab page, you determine 
whether the characteristic is permitted as a property of documents.  You can annotate 
transaction data with relation to a characteristic in SAP BW in this way.  Example:  You 
define the following as a text document for the sales key figure, the month January 
2002 and the country US: The sales for the US in January 2002 were extremely low 
due to a weak exchange rate. The characteristics month and country must have 
these properties activated. 
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InfoProvider Data Document Integration I 
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InfoProvider Data Document Integration II 
 
 



BW Reporting and Analysis  206 

 
Unit Summary 
 
You should now be able to: 

 

• Show and describe the various settings possible in a query definition 

• Influence the structure of and access to reports in a query definition 

• Display the workbooks or views in which a query definition is stored 

• Explain how to delete query objects 

• Explain how to copy queries between InfoCubes 

• Describe the different document classes for metadata, master data, and 

transaction data 

• Define documents for these document classes 
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Exercise 12 
 

 Unit 8 – Query Properties 
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Task  

You want to create a query that contains the sales organization as a variable in the filter area, with a 
variable request for a specific month and the material in the free characteristics. You want to display the 
selected sales organization in the query header. You want to enable the user of the report to define a key 
date variably to display changes to the revenue class of individual customers. In the report drilldown, you 
want to include customers with the revenue class attribute and the sales volume and Open Order net 
value key figure evaluations. You do not want to display the currency in the rows, but rather in the column 
header of each key figure. You want to give zero values the message Check! And give the user the option 
of accessing documents for individual objects. You want to display the overall result in the top-right of the 
report to give an immediate overview.  

 
1. Create a new query based on the 0D_SD_C03 cube with the sales organization characteristic as 

the filter with a variable request (Sales Organization). Use material and calendar year/month as 
free characteristics and give the calendar year/month a variable request (use a variable that you 
created in previous exercise). Include the sold-to party characteristic in the rows and give it the 
country attribute. Select Open Orders key figures and drop it into columns.  

 
2. Use the query properties function to define a text variable (Text Sales Organization) in  the 
query description which will display the name of the sales organization selected.  Write the description as 
follows and place the text variable after the abbreviation of the  sales organization (SLORG):  
Description: GR##BW305PropertiesSLORG 

 
3. Since the key date is to be variable in the query, find the relevant variable for this  
 Key Date.  
 

 
4. Now set the scaling factors, document links and Drag&Relate links and change the  results 
position to the top-right. Also specify the type of zero display in the query  properties and define 
the text "Check!" for this.  
 
5. Now save the query definition  

Description: GR##BW305PropertiesSLORG &0T_CMONT& 

Technical name: BW30515A## where ## corresponds to your group number. Execute the 
query on the web. 
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Exercise 13 
 

 Unit 8 – Document Integration 
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Task 1  
 
As the basis for your task, you need to create a query definition that contains the navigational attribute 
Division in the rows, restricted to High Tech with a drilldown by material. Display the Division by Name 
and the Material by Key. In the rows, list the Sold to Party with an additional breakdown by customer. 
Display the Sold to Party characteristic required here by Name. To enable users to access documents in 
the executed report without the need for additional settings, you have to define this in the query 
definition.  
 
1. Create a new query using the SAP Demo Sales and Distribution InfoCube (0D_DECU). Include the 

characteristics Division and the Material dimension in the rows. Restrict Division to High Tech. 
Select Sold to party for the rows area.  

 
2. Now save the query definition  
 

Description: GR##BW305DocumentIntegration 
Technical name: BW30516A##,  
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Unit 9 – Exceptions and Conditions 
 
Unit Overview 
 
This unit deals with including exceptions and conditions to further analyze a report. 
Exceptions allow you to highlight deviations. Conditions allow you to reduce report 
options to what is really necessary. 
 
Unit Objectives 
 
After completing this unit, you will be able to: 
 
• Explain the purpose of exceptions 

• Use exceptions in a query definition 

• Structure a variable exception 

• Activate and deactivate exceptions within a report 

• Change, enhance, and delete exceptions 

• Explain the purpose of conditions 

• Use conditions in a query definition 

• Focus reports on fundamental data using conditions 

• Activate and deactivate conditions within a report 

• Change, enhance, and delete conditions 
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Lesson:   Exceptions 
 
Lesson Overview 
 
This lesson deals with exception reporting and the definition of exceptions in the 
Query Designer. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Explain the purpose of exceptions 
• Use exceptions in a query definition  
• Structure a variable exception 
• Activate and deactivate exceptions within a report 
• Change, enhance, and delete exceptions 
 
Business Example 
 
In order to make quick, responsible decisions, a company’s data must be prepared 
and presented so that values that deviate from expected values are noticed by 
users at a glance. The management of your organization wants to use a warning 
system within a report and has therefore asked you to define threshold values with 
different colors in an Exception on a query level. 
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Web Application with an Active Exception 
 
Exceptions 
 
The functions in exception reporting enable you to select and highlight unusual 
deviations of key figure values in a query.  You can see deviations from predefined 
threshold values or intervals in the query result displayed in different colors if the 
exception is active.  Early spotting of these deviations provides the basis for timely 
and effective reactions. 
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Defining Exceptions in the Query Designer 
 
Creating  Exceptions 
 
You create an exception in the Query Designer using the         symbol  
Exception → New Exception. 
 
In the dialog box that appears, you can specify a meaningful Description and set 
the exception to Active. The exception is applied as soon as you execute the query. 
If you do not set the active flag, you can activate the exception in the report itself. 

In the BEx Analyzer, from the BW toolbar,  Layout →Display Exceptions, you 
also have the option of adding an additional line between 
the filter and results areas for each exception and activating or deactivating the 
exception from there. There is an item for Web applications that you can integrate 
into your template for the same purpose. 
 
You can use exceptions to evaluate one or all key figures in your query definition.  
If you want to use exceptions selectively on specific key figures in your query 
definition, you have to define an exception for each key figure accordingly. 
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Exception Values 
 
On the Exception Values tab page, you enter your values by first choosing New.  An 
alert level Row always consists of a From field, a To field and an Alert Level field.  If 
you leave the From or the to Value empty, this gives an infinite value definition. You 
choose Transfer to add your entries to the list of threshold values. 
 
You can proceed as follows to make entering large values with many zeros easier: 
 
An apostrophe after the value means multiply by a thousand, two apostrophes means 
multiply by a million and three apostrophes means multiply by a billion (for example: 1’ 
= 1,000, 1.5’’ = 1,500,000). 
 
By defining variables as threshold values, you can influence defined exceptions 
flexibly.  You can allocate the available alert levels as you wish. You can set the alert 
colors red, yellow, and green, each in three shades, as required.  The colors relate to 
the color characteristic values of the format templates delivered by SAP and 
symbolize traffic light colors. 
 
If you want to assign your own symbol colors, in the BW toolbar in the BEx Analyzer 
choose Format → Patterns.  So that these changes are kept in the query, you have to 
save them in a workbook. For Web applications, the formats are stored in the MIME 
Repository under BWReports.css.  You can modify them there. 
 
Ensure that the character of a warning remains even if the color is altered. 
 
You can include all values or specific intervals (for example, only those falling below 
the threshold value in the red area) in the threshold value catalog. You can enter fixed 
point or floating point numbers for the values you are defining. With key figures that 
exceed the threshold value and are on the border between two intervals, the worst alert 
level is always shown (for example with interval 0 to 1000 alert level 9 and 1000 to 
5000 alert level 8, with the sales volume key figure equal to 1000, then the alert level 9 
is used as the basis for identification. 
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Cell Restrictions 
 
On the Cell Restrictions tag page, you can specify whether a restriction with regard 
to the use of the exception applies Only to the Totals (default setting) or to All values 
(therefore, not a restriction). 
 
You can choose New to define an operator for each characteristic in the query 
definition, and a value for each operator.  You also choose Transfer to add your 
restrictions to the list. 
 
You have the following selection options for the operators: 
 
Everything 
The cell context is not restricted.  The exception applies for every drilldown state of 
the characteristic. 
 
Totals Only 
 
The exception affects only the aggregated values of the characteristic. 
 
Everything Except Totals 
 
The exception affects all values except for the aggregated values of the 
characteristic. 
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Fixed Value 
 
The exception applies only to a specific characteristic value of the characteristic, 
which you can determine in the search help in the Value field.  You can also use a 
characteristic value variable here.  To do this, select Variables Entry. You are then 
given the option of using or changing an existing characteristic value variable, or of 
creating a new one. 
 
Level  
 
The exception applies only to specific hierarchy levels of the characteristic. You enter 
the required hierarchy level in the Value field here. 
 
You have to list all characteristics that you defined in the Cell Restrictions in the 
drilldown of the report because the exception takes effect only then.  If there is a 
characteristic in the drilldown that is not recorded in the cell restrictions, the effect 
that the exception 
has depends on whether you selected Totals Only or All on the Cell Restrictions tab 
page. If you selected All, it does not matter where you integrate the characteristic in 
the drilldown, the exception is applied accordingly.  However, if you selected Totals 
Only, you have to place this characteristic at the end of the drilldown, otherwise the 
exception does not take effect. 
 
Changing  Exceptions 
 
You can change exceptions in the Query Designer using the symbol  
Exception → Change Exception. 
 
If you want to delete or change a list entry, highlight the entry using your cursor and 
choose Delete, or OK if you want to make changes. 
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Changing and Deleting Exceptions 
 
Deleting  Exceptions 
 
You can change exceptions in the Query Designer using the symbol  
Exception → Change Exception.  Use the cursor to highlight the exception that you 
want to delete and choose Delete to confirm. 
 
If you execute your report on the Web, you can create, change, activate, and 
deactivate exceptions using the List of Exceptions Web item. You can delete an 
exception using the context menu only if you created the exception in the Web 
application itself. 
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Lesson:   Conditions 
 
Lesson Overview 
 
This lesson deals with defining threshold values and ranked lists in the Query 
Designer. 
 
Lesson Objectives 
 
After completing this lesson, you will be able to: 
 
• Explain the purpose of conditions 
• Use conditions in a query definition 
• Focus reports on fundamental data using conditions 
• Activate and deactivate conditions within a report 
• Change, enhance, and delete conditions 
 
Business Example 
 
The sales department wants the flexibility to restrict a report so that only the most 
important information displays.  This should enable a more efficient analysis of data 
when large amounts of data are analyzed. You now have the task of using 
conditions within a query definition in order to meet the aims of the sales 
department. 
 
 



BW Reporting and Analysis  220 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Focusing Data Using Conditions 
 
By defining a condition, you have the option of analyzing the query results in more 
detail. You can analyze combinations of characteristics using ranked lists, thereby 
displaying your ten best customers by sales revenue, for example. By defining value 
limits, you can display all key figure values above or below a certain value. The data is 
restricted accordingly in the results area of the query so that you only see the area that 
interests you.  You can define multiple conditions for a query, and then activate or 
deactivate them in the report itself to create different views of the data. 
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Defining Exceptions in the Query Designer 
 
You can make restrictions in the Query Designer, using Condition .  As  a 
prerequisite, you have to have created a query definition for which one or more 
conditions can be defined. 
 
In the dialog box that appears, you specify a meaningful Description and set the 
condition to Active.  If the condition has the status Active, that condition is used in 
the report as soon as you execute the query.  If you do not set the active flag, you 
can activate the condition in the report itself.  In the BEx Analyzer, from the BW 
toolbar Layout → Display Conditions, you also have the option of adding an 
additional line between the filter and results areas for each condition and activating 
or deactivating the condition from there. There is an item for Web applications that 
you can integrate into your template 
for the same purpose. 
 
You can set conditions for all characteristics, single characteristics, and 
characteristic combinations in the report drilldown, that is, in the results area in the 
BEx Analyzer or in the table item. 
 
If you restrict conditions for a report to Single Characteristic or Combinations of 
Characteristics, you have to ensure that the characteristic or the combination of 
characteristics is integrated into the report drilldown for the restrictions defined to 
take effect. 
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Defining a Condition 
 
Features 
 
In Display all values for which at least one of the following conditions applies, choose 
New to select a Key Figure for which a condition is to be used.  In the second field, 
you can see the operators for specifying value definitions.  You choose Transfer to 
add your entries to the list of conditions and choose New to define more conditions.  
You save your conditions by choosing OK; you can then display your report in the 
BEx Analyzer or in the browser. 
 
A condition row consists of a key figure, an operator, and a value for the operator. In 
query definitions that contain two structures, there is an additional field for defining a 
structural component. 
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You can use the following operators for threshold value conditions: 
 
• Equal to 
 

Example:  Invoiced quantity equals 1000 
 
• Not Equal to 
 

Example:  Line item not equal to 5 
 
• Less than 
 

Example: Sales revenue less than 100,000 EUR 
 
• Greater than 
 

Example: Incoming orders greater than 1,000,000 EUR 
 
• Less than or equal to 
 

Example: Sales revenue less than or equal to 100,000 EUR 
 
• Greater than or equal to  
 

Example: Incoming orders greater than or equal to 1,000,000 EUR 
 
• Between 
 

Example: Sales from/to, with the option of defining these values using a variable 
request 

 
• Not Between       
 

Example:  Sales from/to excluded from display, with the option of defining these 
values flexibly at runtime. 

 
In the variable definition, select Variable Entry.  You are then given the option of 
choosing an existing variable from the drop-down list, changing the variable or 
creating a New Variable. 
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Defining Variable Threshold Values 
 
You can use the following operators for ranked list functions: 
 
• Top N 
 

Example: Display the sales revenue of the top 5 customers 
 
• Bottom N 
 

Example: Display the bottom 3 (lowest) incoming orders 
 
• Top % 
 

Example: Restriction to 20% of the best revenue, in order 
 
• Bottom % 
 

Example:  List of 15% of the customers with the lowest sales revenue, in order 
 
• Top Sum 
 

Example: You get a list of the products with the highest sales revenues where 
the total sales revenue makes up 20,000 EUR. All sales revenues are sorted in 
descending order and then the sum is calculated until the threshold value of 
20,000 EUR is exceeded.  All products, including the product that takes the sales 
volume over the 20,000 EUR mark, are listed. 
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• Bottom Sum 
 

Example:  Same as the Top Sum but here, a ranked list is sorted in ascending 
order of products with the weakest sales revenue until a sum greater than or 
equal to 20,000 EUR is reached. All products, including the product that takes 
the sum over the 20,000 EUR mark are also listed here. 

 
Caution:  When you execute a report with an active condition, you always see the 
query result in the Overall Result row (overall result without filter).  If you do not want 
to see the query result, from the context menu in the BEx Analyzer, you can choose 
Calculate → Result As → Summation. If you are using the browser, you can call 
the context menu and then choose Properties→ Local Properties → Calculate 
Result As → Summation . 
 
Using Several Conditions in a Report 
 
If you are using several conditions in one report, conflicts can arise that lead to 
automatic deactivation.  The following status descriptions appear in the display: 
 
Variant 
 
Reason: The condition relates to a characteristic or characteristic combination that is 
not included in the drilldown. 
 
Not Used 
 
Reason: The condition relates to a characteristic that is drilled down using an active 
display hierarchy. 
The condition relates to a characteristic that is included through the activation of 
another condition, leading to a collision, and is therefore deactivated (however, you 
can reactivate this condition and automatically deactivate the last condition 
activated). 
 
Caution: If you activate a condition for a combination of characteristics, the results 
row no longer displays. 
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Changing and Deleting Conditions 
 
To change existing conditions, in the Query Designer, choose Condition 
→ Change Condition.  The Selection dialog box appears. Highlight the required 
condition and confirm with OK. In the Define Condition dialog box, you can add new 
conditions to the list, or highlight existing conditions to change or delete them. 
 
You can also delete conditions from the Selection dialog box by highlighting the 
relevant conditions and choosing Delete to remove it from the list. 
 
If you execute your report on the Web, you can create, change, activate, and 
deactivate conditions using the List of Conditions Web item.  You can delete a condition 
using the context menu only if you created the condition in the Web application itself. 
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Unit Summary 
 
• You should now be able to: 
 
• Explain the purpose of exceptions 

• Use exceptions in a query definition  

• Structure a variable exception 

• Activate and deactivate exceptions within a report 

• Change, enhance, and delete exceptions 

• Explain the purpose of conditions 

• Use conditions in a query definition 

• Focus reports on fundamental data using conditions 

• Activate and deactivate conditions within a report 

• Change, enhance, and delete conditions 
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Exercise 14 
 

 Unit 9 – Exceptions  
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Task 1  
You need to create a query to track your purchasing habits with various vendors and set warnings for 
your management.  
 
You need to create two exceptions for this query definition.  
 
1. Create a new query using the SAP Demo Purchasing Data (0D_PU_CO1) cube.  Please 
include  material group and vendor from the characteristics.  Set free characteristic for country.  
 
2. In the BEx Query Designer, using Exception, create a New Exception. Define the description 
 Exception Absolute Values and put a check in the Active checkbox. For Evaluation for → Key 
 Figures choose Order Values and on the Exception Values tab, define the following absolute 
 values:  

 
 

From  To  Alert Level  

(Leave field empty)  
10000  Bad 9  

10000  100000  Bad 7  

100000  500000  Medium 5  

500000  1000000  Good 3  

1000000  (Leave field empty)  Good 1  
 
 Confirm your exception by choosing OK.  
 
3. Now save the query definition  
 Description: GR##BW305Exceptions 
 Technical name: BW30517A##,  
 
4. You now see that only the overall result of your key figure Order Value is in color. To include 
 other results in your exception, return to the query definition and to your exception and from the 
Cell  Restrictions tab page, select All (Recommended with Relative numbers)  
 

 
5. Now your report shows all the entries shaded for the exception.  Create a new selection Half 

Year for the period January 1999 to June 1999 in the key figure context menu.  Include the 
Order Value key figure in the selection. Save and execute the query, now you see results only 
for that half a year. 

 
 
Save the query.  View it in BEx. 
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Exercise 15  

 
Unit 9 – Exceptions (optional) 
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Task 
You require a query showing the sales for June 2002 for all customers. You want to use an exception 
to report on the key figure Open order net value. In the query, different levels of sales should receive a 
different color. 
 
1. Create a query using Info cube SAP Demo Sales and Distribution overview Cube 
(0D_SD_C03).   Put the key figure Net Value in stat.Cur (0D_NETVAL_S) in the columns and the 
characteristics Sold- to Party and Calendar Year/Month in the rows.  Restrict the characteristic 
Calendar Year/Month to  June 2002. 
 
2.  Assign different colors to the key figure values to highlight the different levels of sales volume. 
 Create an exception called GR##Sales for the key figure Net Value in Stat. Cur. Test for the  
 exceptional characteristic levels. Specify the following alert levels: 
 

From To Alert Level 

0 10,000 Bad9 

10,000 100,000 Bad8 

100,000 300,000 Bad7 

300,000 500,000 Medium6 

500,000 600,000 Medium5 

600,000 800,000 Medium4 

800,000 1,000,000 Good3 

1,000,000 2,000,000 Good 2 

2,000,000 10,000,000 Good 1 
 

3. To standardize the basis of the exceptions, translate the currency into US Dollars (5 Dec) 
(USDN) for the key figure Sales Volume using the mean exchange rate based on today’s date. 
  

4. For the characteristic Calendar Year/Month, suppress the totals rows to avoid the same 
information being displayed repeatedly. 

 
5. Save and execute the query using the values below: 
 

Technical Name: GR##09 
 Description: BW305GR## Exceptions 
 

Note that when you run the query you might get warnings saying conversion rates are not 
available.  This is why some of the data is not converted to US dollars. 

 
6.  Sort the results of the Net Value in stat.Cur (0D_NETVAL_S) column in descending orders so as 
to  get a better overview. 
 
7.  Save the query in your Favorites folder as a new work book named BR505GR## Exceptions.  
After  saving the work book, close the BEx Analyzer. 
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Exercise 16 
 

 Unit 9 – Conditions 
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Task 
In this exercise, you will create a condition to select only the top ten customers that placed the largest 
orders with you for June 2002. 
 
1. Begin by creating a new query using the Info Cube Demo Sales and Distribution overview Cube 

(0D_SD_C03) found in the SAP Demo Info Area. 
Create the query to show the top ten customers based on Net Value in stat.Cur in the month of June 
2002. 

 
2. Hide the totals rows in your local query view.  
 

 
3. Save the query in your Favorites folder as a new work book named GR## Conditions. 
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Solution 1 
 
 

Unit 2 – Navigation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



BW Reporting and Analysis  236 

Task 1  
Display the sales revenue data for all regional codes Average Delivery Time( 0D_PU_C01_Q001) set a 
filter for material Logic Monitor Flat 17CN and then remove the filter again.  

Steps to Carry out 
 

1. Open the query Average Delivery Time ( 0D_PU_C01_Q001).  Right click on Material------Filter 
Value ------Drag and Drop Logic Monitor Flat 17CN 

 
Task 2  

In the same query swap vendor with material and keep filter value on one of the key figures.  Save as a 
new workbook with the description BW305GR## Sales Spirit. 
 
Steps to carry out 

1. Use the same query 
2. From the context menu for Vendor, choose Swap with Material 
3. From the context menu choose Keep Filter Value 
4. Save  as a new workbook by clicking Save as Workbook with description 

BW305GR##SalesSpirit 
 
Task 3 

In this task by using the same query you want to pick a range from 2/2001 to 12/2001.  From the BEx 
menu, save as a new workbook BW305GR## SalesRegion1. 
 
Steps to carry out 

1. Use the same query 
2. From Free characteristic menu right click on Cal.year/month-----select Filter Value 
3. From Tab Selection-pick Value range---(the next window automatically chose display) 
4. Pick by Drag and Drop or by double click 2/2001 and 12/2001 
5. Save as a new workbook BW305GR##SalesRegion1 
 

Task 4  

Now you want to know to know actual delivery time to Frankfurt 1612 plant.  Save your results as a new 
workbook BW305GR## SalesRegion2.  

Steps to carry out 
 

1. From the Free characteristic region select the filter value for Plat 
2. Please pick Frankfurt 1612 
3. Click ok and save as BW305GR##Sales Region2 
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Solution 2  
 

Unit 2 – BEx Browser 
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Task 1 
Please create a folder, internet address, change the color and a picture and add a transaction 

 
Steps to carry out 
 

a) Go to Start--------Programs------Business Explorer--------BEx Browser 
b) Log in 
c) Right click anywhere---------New Folder---------call it My Folder-------when you done click 

anywhere   
d) Right click gray picture---------choose symbol or color---------pick picture and color-OK 
e) Right click -----------New---------Internet Address that you would like (an example you can use 

would be http://cygnet.schwans.net) 
f) Right click-------------New--------------SAP Transaction-----------Name   BEx--------Transaction 

RRMX 
 
 
When you are done creating everything, please go to all your shortcuts to be sure they work 
correctly. 

 
 
Task 2 
 
Please, create a Folder in the navigation menu Web Queries.  Create a path to a query of your choice 
and place it into Web Queries folder 
 
Steps to carry out 
 

a) Right click on the Favorites-----------New Folder--------Name it My Queries 
b) Display any query on the web by publishing it from a Query Designer.   

a. Open Query designer from the Business Explorer program group. 
b. Open any query. 

c. Publish it to the web using the button - . 
c) Copy paste the web address of the Query 
d) Right click anywhere in BEx Browser-----------New------------Internet Address--------paste Query 

address into Internet Address Space---------Name the Query 
e) Drag and Drop newly created shortcut into you’re my Queries folder 

 
 

When you are done, check that your shortcut is working. 
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Solution 3  
 

Unit 3 – Business Content 
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Task 
 
Obtain an overview of the SAP Demo Sales and Distribution:  Overview (0D_SD_C03).  Have a look at the 
list of characteristics and key figures for this InfoCube.  Display the network display for the data flow, and 
obtain an overview of the queries that are structured on this InfoCube. 
 
Determine which roles the Complete Overview Sales and Distribution (0D_SD_C03_Q007) query is 
assigned to.  Go to the Activated Objects folder in the metadata repository, and check whether the Billing 
Documents (0D_SD_C03_Q007) query is already actively available in the system. 
 
1.   Log on to the BW server.  Choose SAP Menu to reach the SAP menu.  Call the Administrator 
 Workbench under BW Administration.  Open the metadata repository, and look for the InfoCube 
SAP  Demo Sales and Distribution: Overview (0D_SD_C03) in the content objects. 
             
            Steps to carry out 
 

a) Log on to the BW system and take the following path in the SAP Easy Access menu:  
SAP Business Information Warehouse-> Modeling-> RSA1 - Administrator Workbench: 
Modeling, or transaction rsa1.  
Once you are in the Administrator workbench click on the metadata repository 

button to the go to the metadata repository. 
 

b)      When you reach the metadata repository, under the Business Content heading, choose 
Local Objects. 

 
 c)       You obtain a list of object types. Select the object type InfoCube. 
 

d) All InfoCubes delivered in Business Content are listed alphabetically. Scroll down, and find 
the 
InfoCube SAP Demo Sales and Distribution: Overview (technical name:0D_SD_C03).  

Select it. 
 
2.      Have a look at the list of characteristics and key figures for this InfoCube. 

Use the network data flow to obtain an overview of the queries that are structured on this 
InfoCube. 

   Steps to carry out 
a)     Scroll down using the mouse. The characteristics and key figures of the InfoCube are  

 listed in tabular form, as are the objects that receive data from the InfoCube, and the  
 objects that pass data to it. 

 b)     Under the Graphical display choose Network display of data flow. 
 c)       Scroll to the right.  The queries that draw data from the InfoCube 

  SAP Demo Sales and Distribution: Overview are indicated with arrows. 
 
3.      Find the Billing Documents query (technical name 0D_SD_C03_Q007), and display the 

information on this query. Determine which role it is assigned to. 
 

 Steps to carry out 
a)      From the network display of the data flow, choose the Billing Documents query (technical  

  name: 0D_SD_C03_Q007) by clicking on it. 
The tabular overview gives you information on the role that this query is assigned to, and the 
InfoCube that feeds it with data. 

 
The query preview link gives you a preview that shows you the characteristics of the query. 

     
 Hint:  You can use the context menu (secondary mouse button) to return to the previous view by  

     choosing Back. 
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4. Branch to the activated objects of the metadata repository and check whether the Billing 
Documents query is actively available in the system. 

 
 Steps to carry out 

a)     From the metadata repository, choose Activated Objects Local Objects.  
 b)      You obtain a list of object types. Select the object type Query. 

c)       All queries that are available in the active version in the system are displayed. 
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Unit 4 – Introduction to BW Query Designer 
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Task1  

You are interested in finding out the incoming order values and the incoming order quantities of your 
customers for specific materials between January and April 2002. You want to enable the users of your 
report to select by specific countries. Create a new query with the following layout:  

1. Create a new query using the InfoProvider SAP Demo Sales and Distribution Cube Overview 
Cube in the SAP Demo InfoArea with the characteristic Sold-to party (0D_SOLD_TO) in the rows.  

  Use the basic key figures Net value in statistic currency (0D_NETVAL_S) and Open Order 
quantity   (0D_OORQTYBM) in the columns.  

 Steps to carry out 
 a)  To open the BEx Analyzer, choose SAP Menu→SAP business information warehouse 

→ Business Explorer → Analyzer.  
In BEx Analyzer, choose open, and choose Queries.  

Choose InfoArea SAP Demo → SAP Demo Sales and Distribution overview  → SAP 
Demo Sales and Distribution overview Cube.  

Choose New.  

From the Customer dimension, transfer the Sold-to Party (0DSOLD_TO) into the Rows 
using Drag & Drop.  

From the Key Figures folder, transfer Net val. in statCur (0D_NETVAL_S) and Open 
Order qty (0D_OORQTYBM) into the Columns using Drag &Drop.  

2. Save the query Description: GR##BW305CustomerQuery1. 

 Technical name: BW3054F## 

 Execute the query and close your application. 

 Steps to carry out 
 a) Save the query Description: GR##BW305CustomerQuery1. 

  Technical name: BW3054F##. 

  Choose Save. 

  Execute the query as a report in the BEx Analyzer. Then close the 

  report without saving it.  

3. In the next step, you want to change the query definition. Find the query you created (GR## 
BW305 Customer Query1) using the search function. Try out the various criteria for restricting 
the search. (For example, search for all queries created by your user ID or all query 
definitions defined today.)  
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4. Include the material in the report in order to display the incoming orders for each material for 
the customers. You also want to filter the data globally to the months 01.2002 to 04.2002.  

 
Steps to carry out 

 a) Choose   

 Test the various search restrictions. For example, search for:  

 The queries that you defined. Choose Created: → By User.  

 Enter your user: BSC-## 
 Queries that fall within a specific time interval. Choose Time Interval: → Today.  
 The technical name of your query. As the Search String:, enter BW3054F 

 Select the query GR## BW305 Customer Query1 from the selection list and choose Change  

 b)  In the Query Designer, move Material (0D_MATERIAL) (from the Product dimension) into 
the rows, under the sold-to party.  

 
 c) Choose Cal. year / month (0CALMONTH) characteristic (from the Time (0D_SD_C03T)  
  dimension), and place it into the Filter using Drag & Drop.  

  From the context menu for Cal year / month, choose Restrict.  In the selection screen,  
  choose Value Range.  Choose Between.  Select 01.2002 and 04.2002, and transfer the  
  selection using the arrow button. Choose OK.  

 
4. Enable the users of your report to select data related to specific countries. Execute the query.  

 Use the local definition to remove the material from the drilldown and to include the country in the 
 drilldown to list the sold-to parties by country.  

 Then use the global definition to restrict the country in the free characteristics to Germany, for  

 example.  Execute the report and make a note of which sold-to parties are listed in your report.  

 Steps to carry out 
a) From the Country Key dimension, transfer the Country (0D_COUNTRY) into the Free   

Characteristics using Drag & Drop.    

  Save the query and then execute it.  

 b) Choose Change Query  Choose Change Query (Local View). 

Use Drag&Drop to transfer Material into the Free Characteristics and Country from the 
free characteristics into the Rows.  

Place the Sold-to Party below the Country.  

 c) Click the change global query definition button.    

From the context menu for Country, choose Restrict.  
In the selection  screen choose Single Values.  
Select Germany and adopt the selection using the arrow button.  
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Choose OK.  
   Save and execute the query.   
   
5. Now view your query on the Web.  

 Steps to carry out 

a) From the query results screen Choose  tools-> Launch in Web Browser-> Query 
(default view)  

 
 
Task 2  

(Optional)  

Create a report using the same InfoCube for the time period from May to July 2002 about the sales 
volumes of your customers from the sales organization Germany Frankfurt, with the option of navigating 
by division, and a drilldown for the sales volumes on the months May to June.  

1. Define a new query using the SAP Demo Sales and Distribution: Overview Cube (0D_SD_C03) 
and Include the Sold-to Party (0SOLD_TO) and the key figure Open Order (0D_OORVALSC)) in 
your query definition. Choose Sales Organization (0D_SALE_ORG) as the global filter, restricted 
to Germany Frankfurt (1512). Use Division and the time characteristic Cal. Year/Month as free 
characteristics. You are only interested in the months May to July.  

 Steps to carry out 

a) Open the Query Designer.  

From the Sales Area dimension, place the Sales Organization (0D_SALE_ORG) 
characteristic into the Filter section using Drag&Drop.  

In the context menu for Sales Organization, choose Restrict.   
In the selection screen, choose Single Values.   
Select Germany Frankfurt (1512) And transfer it into the selection window. 

Choose OK.  

From the Sales Area dimension, transfer the Division (0D_DIV) characteristic into the 
Free Characteristics section using Drag&Drop.  
From the Time dimension, transfer the Cal. year / month (0CALMONTH) characteristic 
into the Filter using Drag&Drop.  
From the context menu for Cal year / month, choose Restrict . 

In the selection screen, choose Value Range.  

Choose Between.  

Select 05.2002 Hold down the CTRL key and select 07.2002  

Adopt the selection using the arrow button .  

Choose OK.  

Transfer the key figure Open Orders (0D_OORVALSC) into the Columns using 
Drag&Drop.  
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From the Customer dimension, place the Sold-to-party(0D_SOLD_TO) characteristic into 
the Rows section using Drag&Drop.  

 
2. Save the query in your favorites:  
 Description: GR##BW305CustomerQuery2. 
 Technical name: BW3054G##. 

 Now execute the query. 

 Steps to carry out 

 a) To save the query, choose Save As and save into your favorites..  

Choose Roles → Unit: G 

  Description: GR##BW305CustomerQuery2. 

  Technical name: BW3054G##. 

  Choose Save. 
  Execute the query. In order to list the sales volumes for the 
  individual months in your report, include Cal. Year/Month in the 
  horizontal drilldown. 

3 Now display your query on the Web.  

a)  From the query results screen Choose  tools-> Launch in Web Browser-> Query 
(default view) 
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Solution 5  

 
Unit 4 – InfoProviders and InfoObjects 
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Task  

InfoProviders in SAP BI  

1. What type of infoprovider can you use to create reports?  

Answer: You can define reports based on the following InfoProviders:  

• InfoCubes  
• ODS Objects  
• InfoObjects (characteristic InfoObjects with master data)  
• InfoSets  
• Remote Cubes  
• MultiProviders  
 
2. What objects does the term Infoproviders refer to?  

Answer: The term InfoProvider can describe objects in which data is physically present. These 
objects are called data targets:  

• InfoCubes  
• ODS Objects  
• InfoObjects  
InfoProviders can also be objects that do not store data physically, but that display a logical view:  
• InfoSets  
• Remote Cubes  
• MultiProviders  
 
3. Which conditions does an InfoObject have to fulfill in order to be used as an InfoProvider?  

Answer: A characteristic InfoObject needs to have master data (attributes and/or texts) and be 
assigned to an InfoArea in order to be an InfoProvider.  

4. Which InfoProviders are available for master data reporting?  

Answer: Infoset, characteristics with master data 

Complete master data reporting is not possible using InfoCubes. Master data reporting is 
possible with InfoSets if the InfoSet refers to characteristic InfoObjects with master data.  

 
5. Which InfoProviders can contain generated characteristics or key figures?  

Answer: ODS Objects, Infoproviders for characteristics objects, infosets, multiproviders.  
MultiProviders contain generated characteristics or key figures, if at least one InfoProvider in it 
contains these.  

 
6. Which InfoProviders can I combine in a BI InfoSet?  

Answer:  You can structure BI InfoSets only from ODS objects and/or characteristic InfoObjects.  
 
8. How many dimensions are displayed for an InfoSet in the Query Designer, if the InfoSet consists 
of an ODS object and a characteristic InfoObject?  

Answer:   Two dimensions are created for each ODS Object and characteristic InfoObject.  
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Unit 5 – Restricted Key Figures 
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Task 1  
Define two restricted key figures that depict the sales volume for the period leading up to 2002 and for the 
year 2002 itself. For the definition of two further key figures, you use the enhanced selection conditions to 
restrict the sales volume for each sold-to party to the selected materials.  

2. Create a new query using 
3. InfoProvider: SAP Demo Sales and Distribution overview Cube (0D_SD_C03) in the BW305 

Reporting InfoArea with the characteristic Sold-to  party (0D_SOLD_TO) in the rows.  
As global filter user Division (0D_DIV) restricted to High Tech, and  
Sales Organization (0D_SALE_ORG) restricted to Sales Organization 1616 
Define a new restricted key figure at InfoProvider level.  We will limit the basic key figure Sales 
Volume to a certain period. 
Description: GR01 OpenNetValue2002 
Technical name: BW3057A01. 

  
 Steps to carry out 

a) Click  and choose Queries. 

b) Choose New  Query.   
c) Choose Cube SAP Demo Sales and Distribution: Overview 

(0D_SD_C03)→ OK.  It is found under SAP Demo  SAP Demo Sales and 
Distribution: Overview. 

d) Place the Sold-to party (0D_SOLD_TO) characteristic under the Customer 
dimension into the Rows section using Drag & Drop.   

e) Drill down into Sales Organization (0D_SALE_ORG) characteristic under 
Sales Area dimension and into Values, choose 1616 (show technical 
names to find this number) and drop it into the Filter section using Drag & 
Drop.   

f) To define the first restricted key figure at InfoProvider level, choose New 
Restricted Key Figure in the context menu of the Key Figure folder.   (Right 
click on Key Figure and choose New Restricted Key Figure). 

g) Description: GR## OpenNetValueBefore2002   
h) Use Drag & Drop to place Net Value in stat.Cur under Key Figures into the 

description area on the right. 
i) Choose the Cal. year / month (0CALMONTH) characteristic under the Time 

(0D_SD_C03T) dimension, and place it into the description area using Drag 
& Drop.   

j) In the context menu (right click) for Cal year / month, choose Restrict .In the 
selection screen, choose Value Range.  Choose Less than. Select January 
2002 and adopt the selection using the right arrow button. Choose OK. 

k) Click OK again to bring up the properties screen.  In the Properties of the 
Restricted Key Figure dialog box, enter:  

    Technical name: BW3057A##.  
    Confirm with OK.  
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3. In the same query, define another restricted key figure Sales2002 at query level. This key figure 

is to display Net Value in stat.Cur for the year 2002.  
 
Steps to carry out 

d) To define the second restricted key figure at query level, choose Net Value 
in stat.Cur from the Key Figure folder, and place it into the Columns section 
using Drag & Drop.  

e) In the context menu for Net Value in stat.Cur, choose Edit. 
f) Choose the Cal. year / month (0CALMONTH) characteristic under the Time 

(0D_SD_C03T) dimension, and place it into the description field using Drag 
& Drop.   

g) In the context menu for Cal year / month, choose Restrict . 
h) In the selection screen, choose Value Range.   
i) Choose Between and select January 2002 and adopt the selection using 

the arrow button.  
j) Select December 2002 and adopt the selection using the arrow button. 

Choose OK. 
k) Description: GR##Net Value in stat.Cur 2002. 

Confirm with OK. 
l) You need the additional key figure for the sales volume before 2002 for 

FlatScreen.   To define this restricted key figure at query level, select  
GR## OpenNetValueBefore2002. Drag and Drop into Columns. 

m) Choose Edit in its context menu. 
n) Choose the characteristic Material from the Product (0D_SD_C033) 

dimension and place it into the Description field using Drag & Drop.   
o) In the context menu (right click) for Material, choose Restrict.   
p) The characteristic values needed for the restriction are not offered in the 

first 100 values. Click arrow button (Display other values) at the bottom of 
the screen next to number “100”. 

q) In the Restrictions area, choose Text from the drop down.   
r) Choose Contains Pattern.   
s) Enter *Monitor flat* as the search string.  Click OK. 
t) You are presented with a screen of Fixed Values.  Select all of them and 

click the right arrow to move them to the Selection area.  Click OK. 

Caution: You must distinguish between upper and lower case when searching. 

u) Description: OpenNetValue2002MonitorFlat. 
Choose OK.    

v) Save the query by clicking  
w) Description: GR##BW305RestrictedKeyFigures. 

Technical name: BW3057B##. 
Now execute the query       
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Task 2  
You use selections when defining the restricted key figure to determine the data that you want to 
display at runtime. Use the Constant Selection function to easily select reference sizes that can not 
change at runtime.  
1. Create a new query based on the InfoProvider Cube (0D_SD_C03).  Place the characteristic 

Material (0D_MATERIAL) into the rows. Use the characteristics Sales Organization 
(0D_SALE_ORG) as the global filter, restricted to the sales organization Germany Frankfurt (1512).  
Place the InfoObject Cal. year / month (0CALMONTH) into the free characteristics, and restrict it to 
the single values 06/2002.  
Define two new key figures.  
Description: SalesCurrentQuarter.  
Description: SalesValueCurrentQuarter.  

 
For the second key figure, use the Constant Selection function.  
      Steps to carry out 

a) To define a new query for the same InfoProvider, open the Query Designer, and choose Queries 
→ New → History → SAP Demo Sales and Distribution overview Cube (0D_SD_C03)→ New.  

 
b) Place the Sales Organization (0D_SALE_ORG) characteristic under the Sales area dimension 

into the Filter section using Drag & Drop.  
 

c) In the context menu for Sales Organization, choose Restrict.   
 

d) In the selection screen,  choose Single Values. Select Germany Frankfurt (1512) and adopt the 
selection using the arrow button. Choose OK.   

 
e) Choose the Cal. year / month (0CALMONTH) characteristic under the Time dimension, and place 

it into the Free Characteristics field using Drag & Drop.   
 

f) In the context menu for Cal year / month, choose Restrict.   
 

g) In the selection screen, choose Single Values.  
 

h) Select 03/2002 and adopt the selection using the arrow button. Choose OK. 
 

i)  Use Drag & Drop to place Material (0D_MATERIAL) Under Product from the Material dimension 
into the rows.  

 
j) To define the restricted key figures, place the key figure Open Order in the Columns section using 

Drag & Drop.  
k) In the context menu for Open Order, choose Edit.  
l) Choose the Cal. year/month (0CALMONTH) characteristic under the Time dimension, and place 

it into the description field using Drag & Drop.  
m)  In the context menu for Cal year / month, choose Restrict.   
n) In the selection screen, choose Single Values.  
o) Choose 06/2002, and adopt the selection using the arrow button.  
p) Change the Description to: SalesValueCurrentQuarter.  

 Choose OK.  
q) You create the second key figure as a copy of the one you just defined. Choose the 
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SalesValueCurrentQuarter, click copy and then paste.  
 

r) Edit the copied key figure. 
s) Choose Cal year/Month,choose restrict. 

t)  Making sure to be on tab Fixed Values, go to Display Other Values  and make sure 
Only Values in InfoProvider is checked.  Confirm OK.   

u)  Right click on Calendar  and choose Constant Selection for both of the key figures
 Description: SalesValueCurrentQuarterSelectionofConstants.  

Save the query  

Description: GR##BW305SelectionofConstants. 

 Technical name: BW3057C##. 

 

v) Now execute the query.  
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Task 1  
Generate a report that represents the sales volumes and Net Value of the first two quarters of 2002 as 
well as the first half-year with percentage changes.  

1. Create a new query based on the InfoProvider SAP Demo Sales and Distribution overview Cube 

in the SAP Demo InfoArea. In the rows, create a structure with the following name: Description: 

GR## Quarterly Comparison 

 Technical name: BW3059A##. 
 This query contains the first and second quarters of 2002. The structure should also  include 
the first half-year as a sum of the first two quarters.  You define the fourth part as  a formula for calculating 
the percentage variance of the two quarters contained in the  structure. 
 
 Steps to carry out 

a) To define a new query, open the Query Designer from the Analyzer. Choose 
Open →New  →and choseSAP Demo Sales and Distribution overview Cube 
from History (0D_SD_C03)→ OK.  

b) Call up the context menu in the heading of the Rows directory by right clicking 
the heading “Rows”.   

c) Choose New Structure. 

d) Choose Properties from the context menu of the New  structure.  
 Description: GR## Quarterly Comparison 
 Technical name: BW3059A##. 
 Choose OK. 

b) To define the first quarter as part of the structure, go to the context menu of the 

GR## Quarterly Comparison structure, and chose New Selection.  

c) Under  the Time dimension, choose the Cal. year / month characteristic, and 

place it in the selection screen using Drag&Drop.    

d) In the context menu  for Cal. year / month, choose Restrict. 

e) Selection: Value Range, Between.  

f) Use Drag & Drop to pull dates between January 2002 and March 2002.Choose 

OK.  

g) Enter Quarter1/2002 as the description.    

h) For the definition of the second quarter, right click with the mouse on the quarter 

that you already created and click copy.   

 

i) Then highlight the structure, right click and choose Paste.  Identical Quarter 
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appeared.   

j) Now right click -> Edit and change date ranges for April 2002 and June 2002.   

k) Change the name.  Description: Quarter2/2002.   

l) Choose OK.  
e) For the definition of the two new formulas in the structure, choose New Formula 

in the context menu for the Quarterly Comparison.Description: HalfYear1/2002. 
 

f) Use Drag&Drop to place Quarter 1/2002 into the formula field.  
 

g) Choose Plus (the button ). 
 

h) and place Quarter 2/2002 into the formula field.  
 
 

 
2. In the columns, include the basic key figures Open Order  net value and Net value in 
 statistic currency. Define a new calculated key figure that calculates the percentage  share 
of the Open Order in relation to net value of Net Value.  Description:   %Share Open Order of 
Net Value 

 
 Steps to carry out 

A)  Use Drag&Drop to place the basic key figures Open Order  and Net  value in statcur 
into the columns.  
b)  From the context menu for the key figures entry in the columns, select New formula. 
c)  Use drag & drop to place Open Orders into the formula field. 
d)  Under the percentage functions folder, find Percentage share.  Place it into the 

formula. 
e)  Place Net val in statCur into the formula. 
f) Name your formula %Share Open Order s of net value. 

3.  Save the query  

 Description: GR##BW305FormulaCollision. 

 Technical name: BW3059C##. 

Now execute the query. If necessary, carry out a currency translation. At the point where the 
1st half 2002 and % share open orders of net value calculations cross, there is a formula 
collision.  Decide which of the formulas you want to be valid for the calculation of the values 
at the point of collision, and make the appropriate setting in the properties of the key figure or 
calculated formula.  

a) To save the query, choose Save Query  

 Description: GR##BW305FormulaCollision. 

 Technical name: BW3059C##. 

 Execute the query. 
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B) The currency translation takes place in the properties dialog of the key figure you 

want to convert. 

1) Right click on the key figure Open orders.  Select properties 

2) Find the currency translation drop down.   

3) Choose Average rate, current date. 

4) Select US dollars (5 dec) from the target currency drop down. 
 

 Target currency: US Dollars Choose OK. Repeat steps for key figure  net 

value.  

 Conversion type: MEANTODAY Fixed target currency, Current date. 
C) To fix the formula collision do the following 

1) Right click on the calculated key figure %Share Open Order s of net value 
and choose properties. 

2) In the formula collision  drop down, choose results from this formula. 
 
Note how this causes the calculation to do the percentage calculation defined 
for the column instead of summing the first and second quarters together to 
create the “half year” entry. 

 
Task 2  
You need information on the share of the sales volume for the individual quarters in relation to the 
first half -year. You define a new calculated key figure that uses the value from a particular cell for 
calculation.  
1. In the query definition GR## BW305 Formula Collision (BW3059C'##), define a new 
 formula that calculates the share of the sales volumes for the individual quarters in 
 relation to the sales volume for the first half-year. Use the cell editor to do this. Select  the 
sales volume for the first half year there as a reference cell.    
 Description: Share of Open Order of Overall Open Order forHalfYear1.  

 
Steps to carry out 

a) Open the global query definition for GR## BW305 Formula Collision 
 (BW3059C##).  

1. Use the Define Cells icon  to call up the Cell Editor.  
2. At the place where the Half Year 1 and Open Order calculations cross, 

choose New Cell Reference in the context menu.  
3. Choose OK.  
4.  Choose New Formula in the context menu for the key figure structure.  

Description: Share of Open Order of Overall Sales Volume for Half Year 
1.  
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5.  Use Drag&Drop to place Open Order net value into the formula field. 6.  
Choose / (divided by). 
7.  Place Net val. in statCur / OpenOrders/HalfYear from the Cells section into 

the formula field  
8.  Choose OK.  
9. Call up the Cell Editor again. 
10.  At the intersection of Share of Open Order of Overall Sales Volume for Half 
Year 1 and first half, choose New Selection in the context menu.  
11. Enter No Entry as the description, and choose OK.  
12.  In the context menu for No Entry, choose Properties. 
13.  Select the Hide checkbox.  
14.  Choose OK.  
15.  In the Cell Editor, choose OK.  
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Task 1  
Generate a report that represents the sales volumes and Net Value of the first two quarters of 2002 as 
well as the first half-year with percentage changes.  

1. Create a new query based on the InfoProvider SAP Demo Sales and Distribution overview Cube 

in the SAP Demo InfoArea.  

In the rows, create a structure with the following name:  

Description: GR## Quarterly ComparisonB 

 Technical name: BW3059B##. 
 This query contains the first and second quarters of 2002. The structure should also  include 
the first half-year as a sum of the first two quarters.  You define the fourth part as  a formula for calculating 
the percentage variance of the two quarters contained in the  structure. 
 
 Steps to carry out 

a) To define a new query, open the Query Designer from the Analyzer. Choose 
Open → SAP Demo Sales and Distribution overview Cube (0D_SD_C03)→ OK.  

 Call up the context menu in the heading of the Rows directory.  Choose New 
Structure and then choose Properties from the context  menu of the structure.  

To define the first quarter as part of the structure, go to the context menu of the 
GR## Quarterly Comparison structure, and chose New Selection.  

b) Under the Time dimension, choose the Cal. year / month characteristic, and 
place it in the selection screen using Drag&Drop.    
In the context menu for Cal. year / month, choose Restrict  
For the selection: Value Range, Between.  
Use Drag & Drop to adopt January 2002 and March 2002. 
Choose OK.  

Enter Quarter1/2002 as the description.   
c) For the definition of the second quarter, right click with the mouse on the quarter 

that you already created and click copy.   
Then highlight the structure, right click and choose Paste.  Identical Quarter 
appeared.   
Now right click Edit and change date ranges for April 2002 and June 2002.  Don’t 
forget to choose value range and between for the selection 

Change the name.  Description: Quarter2/2002.   

Choose OK.  
 .  
d) For the definition of the two new formulas in the structure, choose New Formula in 

the context menu for the Quarterly Comparison.   
Description: HalfYear1/2002.   
Use Drag&Drop to place Quarter 1/2002 into the formula field.  
Choose Plus (the button with the ‘+’ sign) and place Quarter 2/2002 into the formula 
field.   
Click ‘OK’ to save the formula. 
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In the context menu for the Quarterly Comparison structure, choose New Formula. 
           Description: PercentageVarianceofQuarters1and2/2002  

Use Drag&Drop to place Quarter 2/2002 into the formula field.  
Choose the Percentage Variance from the Percentage functions folder.  
Use Drag&Drop to place Quarter 1/2002 into the formula field.  
Choose OK.  

2. In the columns, include the basic key figures Open Order and Net value in stat cur. Define a new 
calculated key figure that calculates the percentage share of the Open Order in relation to net 
value of Net Value.  Description: %Share Open Order of Net Value.  Make sure only formula 
is visible 

 
 Steps to carry out 

a) Use Drag&Drop to place the basic key figures Open Order and Net value in stat cur 
into the columns.   
For the calculation of the key figure percentage share of the sales volume in 
relation to incoming orders, choose New Formula in the context menu for the key 
figure structure.   

Description: %Share Open Order s of net value.   
Use Drag&Drop to place Open Order from the structure elements folder into the 
formula field.  
Under Percentage Functions choose Percentage Share and use Drag&Drop to 
place it into the formula field.  
Use Drag&Drop toplace Net Value in stat cur into the formula field.  
Choose OK.  

  b)      Right click on Open Order and Net Value in stat.cur go to Properties and   
          check Hide. 

3.  Save the query  

 Description: GR##BW305FormulaCollisionB. 

 Technical name: BW3059CB##. 

Now execute the query. If necessary, carry out a currency translation. At the point where the 
Half Year 1 and Percentage Variance of Quarters calculations cross, there is a formula 
collision with the calculated key figure % Share Open Order of Net Value.  Decide which of 
the formulas you want to be valid for the  calculation of the values at the point of 
collision, and make the appropriate setting in the properties of the key figure or calculated 
formula.  

b) To save the query, choose Save Query  
 Description: GR##BW305FormulaCollisionB. 
 Technical name: BW3059CB##. 
 Execute the query. 

To perform the currency translation, go back into the global definition of the 
query. 
Right click on the Net val. in statCur key figure and go to its properties. 
In the currency conversion key dropdown, select Average rate – current rate. 
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In the target currency dropdown, select US Dollars (5 dec). 
Click OK, save the query, and execute it.  You may get some warnings saying a 
particular exchange rate can not be found.  This is due to the exchange rate not 
being loaded into the IDES training system. 

 
c) Go back to the global query definition.   

In the context menu for % Share Open Order of Net Value, choose 
Properties →Formula Collision. 
Result from this Formula. Choose OK.  

   
 
Task 2  
You need information on the share of the sales volume for the individual quarters in relation to the 
first half -year. You define a new calculated key figure that uses the value from a particular cell for 
calculation.  
1. In the query definition GR## BW305 Formula CollisionB (BW3059CB'##), define a new 
formula that calculates the share of the sales volumes for the individual quarters in relation to the 
sales volume for the first half-year. Use the cell editor to do this.   Select the sales volume for the first 
half year there as a reference cell.    
 Description: Share of Open Order of Overall Open Order forHalfYear1.  

 
Steps to carry out 

a) Open the global query definition GR## BW305 Formula CollisionB 
(BW3059CB##). Note: You may already have this query open from the last 
exercise.  

 Use the Define Cells icon  to call up the Cell Editor. At the place  where 
the Half Year 1 and Open Order calculations cross, choose  New Cell Reference in 
the context menu. Choose OK.  

For the definition of the share of the sales volume in relation to the sales volume 
of the first half year, choose New Formula in the context menu for the key figure 
structure.  

Description: Share of Open Order of Overall Sales  
Volume for Half Year 1.  
Use Drag&Drop to place Open Order into the formula field.  
Choose / (divided by). 
Place Open net value/Half Year 1/2000 from the Cells section into the formula 
field.  
Choose OK.  
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2. Save the key figure structure you defined as a reusable structure. Description: GR## 

 OpenNetValue AnalysisB Technical name: BW3059HB##.  
 Save the query and then execute it. Take a look at your report.  
  

Steps to carry out 
a) To save the structure you created as a reusable structure, choose Save as in the 

context menu for the GR## quarterly comparison structure.  
  Description: GR## OpenNetValue AnalysisB 
  Technical name: BW3059HB##.  

 Save the query and then execute it.  
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Task  

Define a report that displays the sold-to parties, their materials, the relevant sales revenues, and the 
costs for the first two quarters of the year 2002.  

Display the location, region and telephone number for the sold-to parties as additional information. Make 
the necessary settings so that you can select data based on country and postal code later.  

1. Create a new query based on the SAP Demo Sales and Distribution overview Cube (0D_SD_C03) 

In the columns, include the basic key figure Net Value Stat.Cur.  
In the rows, include the characteristics Sold-to Party and Material.  

Restrict the data to the first six months two quarters of the year 2002 and enable navigation 
using both of these quarters.  
 

Steps to carry out 
1)  Open the Query Designer  

2) Use Drag&Drop to transfer the basic key figure Net Value Stat.Cur into the columns.  

a) For the characteristics, choose:  
b) Use Drag&Drop to transfer Dimensions → Customer → Sold-to Party  to the Rows.  

c) Use Drag&Drop to transfer Dimensions -> Material -> Material (0D_MATERIAL) to the 
rows. 

d) Use Drag&Drop to transfer Dimensions→ Time → Cal. Year/Month (0CALMONTH) into 
the Free Characteristics. 

e) Restrict Cal. Year/Month (0CALMONTH)  to January 2002 and June 2002. 
a. Right click on Cal. Year/Month (0CALMONTH) and select Restrict. 
b. Choose Value Range and between. 
c. Ctrl+click January 2002 and June 2002.   
d. Transfer your selection using the right arrow button.  
e. Choose OK.  

 
2. As additional information for the sold-to party, include the attributes location, region and telephone 

number in your report. For the region, define that only the name is to be displayed.  

Steps to carry out 

a) To include display attributes in the query definition, from the context menu for the sold-to 
party, choose Attributes and then select the required attributes Region and Telephone 1.   

Alternate: 
a)   You can also expand the folder for sold-to party and then expand the attributes folder.  From 

here, you can drag&drop the attributes you want into the report.  Note that you must place the 
attributes under the characteristic they belong to in the query definition. 

 
3.  Display only the name of the sold-to party.  In order to structure the report clearly, specify that the 

results rows are not displayed for Cal. Year/Month (0CALMONTH)   
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Steps to carry out 
a) Right click on the characteristic Sold-to Party and select properties. 
b) Under Display As choose Name.   
c) Click OK to accept your changes. 
d) To hide the results rows for the characteristic Cal. Year/Month, Right Click on Cal. Year/Month 

and choose Properties. 
e) In the Display of Results section, change Suppress Results Rows to Always. 
f) Click OK to accept your changes.  

 
4.  Save the query and execute it. 
 Description: GR##BW305Characteristics 
 Technical name: BW30510B## 
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Task 1  
You want to display an overview of specific sales volumes for the sales organizations in your report. To 
structure the report clearly, display the characteristics Sales Organization as a hierarchy.  

5. Create a new query based on the SAP Demo Sales and Distribution overview Cube 
(0D_SD_C03)  In the rows, include the characteristic Company Code (0D_CO_CODE) and 
characteristic Sales Group (0D_SALE_GRP)  
 

     Steps to carry out 
a) Open query 0D_SD_C03 
b) Use Drag & Drop to transfer characteristic Company Code (0D_CO_CODE) and Sales 

Group (0D_SALE_GRP) into the rows.  
6. Display the characteristics in the rows as a hierarchy.   

a)  In the header row of the rows window (the gray part, above the actual listing of 
characteristics), call the context menu and choose Display as a Hierarchy. 

7. Save the query: 

a)  Description: GR##BW305Hierarchy1 
Technical name: BW30511A##. 

8. Now execute the query. 

Steps to carry out 

a)  In the header row of the rows window, call the context menu and choose Display as a 
Hierarchy.   

Description: GR##BW305Hierarchy1 
Technical name: BW305911A##. 

Execute the query.  

Task 2  
In another report, you want to display Sales Organization as a hierarchy.  Create a new query based on 
the SAP Demo Sales and Distribution overview Cube (0D_SD_C03).  Put the characteristic Sales 
Organization (0D_SALE_ORG) into the rows. 
 
Steps to carry out 

a) Create a new query based on the SAP Demo Sales and Distribution Overview 
(0D_SD_C03) cube.   

b) Use Drag&Drop to transfer characteristic Sales Organization (0D_SALE_ORG) into the 
rows.  This characteristic is in the Sales Area dimension. 

c) Drag&drop Open Orders into the columns. 
d) Display the sales organization as a hierarchy. 

a. Right click on Sales Organization and select properties. 

b. Under the display Hierarchy heading, click the values button ( ). 
c. This will bring up a new window showing available hierarchies for the characteristic.  

Choose the only available hierarchy – PM Sales organization 
(PM_SALES_ORGANIZATION).   

d. Click OK to confirm using this hierarchy.  Ensure that the Active checkbox is filled in so 
that your hierarchy will be displayed in your report. 

e. Specify that the hierarchy is sorted by name and in descending order.  These settings are 
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directly below the Hierarchy Name dialog box. 
f. In the Hierarchy Properties area, there are four settings you can change. 

i. Expand to level – This setting tells the query how many levels to expand the 
hierarchy to when it is initially displayed.  Click the checkbox to turn this option on and 
specify 3 for the number of levels to display. 

ii. Position of lower level nodes – This option tells BEx to either display the children 
of nodes below or above the parent.  We want our hierarchy to expand downward.  The 
default is down, so you can leave this option alone, or fill in the checkbox and select 
down  from the dropdown. 

iii. Values of Posted nodes – This option tells BEx to display a parent node as a 
child of itself if it has a value assigned to it for the key figure being displayed.  Fill in this 
checkbox and select display from the dropdown. 

iv. Nodes with only one lower level node – This tells BEx how to display nodes that 
have only one child.  Setting this to Hide will display the lower level child in place of the 
parent when you expand the hierarchy.  Fill in this checkbox and select Hide. 

g. Save the query.  
i. Description: GR##BW305Hierarchy2  
ii. Technical name: BW30511B##.   
iii. Now execute the query.   

h. Execute the query. 
 
 Note that the hierarchy is expanded down three levels, as you specified in the properties of the 
hierarchy. 
 
Note that the hierarchy expands downwards.  You can change the properties of the Sales 
Organization, specifically position of lower level nodes to see how the hierarchy can expand 
upwards as well as down. 
Unfortunately, there are no examples of a posted node in this data.  If  
Canada had a value for Open Orders, it would be displayed along with Toronto and Vancouver 
when you expand its hierarchy. 
 
To see the effects of the Hide Lower Level Nodes option we selected, expand Switzerland. 

 
Return to Query Designer.    

 
Steps to carry out 

 Note that we have a hierarchy called “Not assigned nodes”.  These are nodes that do not 
have a rollup defined in the hierarchy.  We do not want to display these in our results. 

a) Return to the query definition.   
b) Right click on the Sales Organization and select Restrict.   
c) Transfer all the entries, except “Not assigned sales organizations” in the selection. 
d) Click ok . 
e) Save and execute the query. 

Description: GR##BW305Hierarchy2 
Technical name: BW305911B##. 
Execute the query. 
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Task 1  

In order to structure your reports flexibly, you want to use variables instead of fixed values to restrict 
your key figures. You want to list the Net Value Stat.Cur for each of your materials for a particular month 
and for a time interval. You want to display the chosen time or time period in the column header of the 
sales volumes.  

1. Create a new query based on the 0D_SD_C03 

Place the characteristic Material (0D_MATERIAL) into the rows.  

Include the basic key figure Net Value Stat.Cur in the columns, restricted to the characteristic Cal. 
Year/Month (0CALMONTH). Restrict Cal. Year/month using a variable that you define with the help 
of the variable wizard. Specify that a single month has to be entered at runtime.  

Use the following description for the variable:  

Variable name: BI505F## 

Description: GR##Month1 

 

Steps to carry out 

a) To define a new query, open the Query Designer. New.  

b) Use Drag&Drop to transfer Material from the Product dimension into the rows.  

c) Use Drag&Drop to include the basic key figure Net Value Stat.Cur in the columns.  

d)  From the context menu for Net Value Stat.Cur choose Edit. 

e) From Dimensions→ Time, transfer Cal. Year/Month from the Time dimension into the right 
window using Drag&Drop.  

f) From the context menu for Cal. Year/Month choose Restrict and go to the Variables tab page.  

g) In the left window, call the context menu and choose New Variable.  

h) On the General Information page, enter:  

a. Variable name: BI505F## 
Description: GR##Month1 
Processing by: User Entry/Default Value 
Choose Next. 

i) On the Details page, choose the following settings: 
Variable Represents: Single Value 
Variable Entry: Mandatory 
Ready for Input: Set the flag to active 
Can be changed in query navigation: Not active 
Choose Next. 

j) On the Default Values page, enter: 

Default Value: 6/2002 

Choose Next. 
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k) On the Save Variable page, you get an overview of the 

settings you have made. Choose Finish.  

l) Transfer the variable that you have defined into the selection 

window and choose OK. The window is closed and you return 

to the Edit Selection dialog box.  

2.  Define a new text variable that you include in the description of the key figure so that you  can list 
the month, to which the Net Value Stat.Cur is restricted at runtime, as a text (for  example,  Net 
Value Stat.Cur September 2002). Ensure that the text variable relates  to the from-value of the 
characteristic variable.  

 Use the following description for the text variable:  

 Variable name: BI505G## 

          Description: GR##TextVar.Month(from) 

  

Steps to carry out 

a) In the Edit Selection dialog box, position the cursor at the end of the key  figure 

description. Choose the Select Text Variables icon In the selection box  

 Select New (first entry in the list) and choose OK. On the General Information page, 
enter: Variable name: BI505G## 
  Description: GR##TextVar.Month(from) 
  Processing by: Replacement Path Choose Next.  

b)  On the Characteristic page, choose the following settings: 
 Characteristic Cal. Year/Month (0CALMONTH) 
 Choose Next. 

 
c) On the Replacement Path page, enter: 

Replace Variable With: Name (Text) 
For Intervals Use: From Value 
Choose Next. 

 
d) On the Save Variable page, you get an overview of the settings you have made.  

Choose Finish.  The text variable that you have defined appears in the description with 
its technical name enclosed in &. 

 
3.  Drag the  Net Value Stat.Cur  key figure into the columns again and restrict this  using a 

 variable so that the user has to select a month interval at runtime to which the  Net Value 
Stat.Cur is restricted.   Use the following description for the variable:         

Variable technical name: BI505K## 

Description: GR##MonthInterval 
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Steps to carry out 
a) Use Drag&Drop to include the basic key figure Net Value Stat.Cur in the columns.  
b) From the context menu for Net Value Stat.Cur choose Edit . 
c) From the Time dimension, transfer the Cal. Year/Month into the right window using Drag&Drop.  
d) In the context menu for Cal year / month, choose Restrict . 
e) Select the Variables tab page.  
f) In the left window, call the context menu and choose New Variable.  
g) On the General Information page, enter:  

• Variable name: BI505K## 
• Description: GR## Month Interval 
• Processing by: User Entry/Default Value  

h) Choose Next.  
i) On the Details page, choose the following settings:  

• Variable Represents: Interval  
• Variable Entry: Mandatory  
• Ready for Input: Set the flag to active  
• Can be changed in query navigation: Not active  

j) Choose Next.  
 

k) On the Default Values page, enter (for example):  
• Default Value: 1/2002  
• To Default Value: 12/2002  

l) Choose Next.  
 

m) On the Save Variable page, you get an overview of the settings you have made.  
n) Choose Finish.  
o) Transfer the variable that you have defined into the selection window and choose OK.  

 
The window is closed and you return to the Edit Selection dialog box.  

 
  
 
4. In order to specify the selected interval in the column header, you need a to-value text variable in 

addition to the from-value text variable. Create the to-value text variable and use both variables in 
the key figure description.  

Enter the following as the text variable description:  

Variable name: BI505L## 

 Description: GR##TextVar.Month(to) 

Steps to carry out 

a) In the Edit Selection dialog box, position the cursor at the end of the description Net Value 

Stat.Cur and choose .   

b) Then select the text variable that you created GR## Text Var.  Month(from) (BI505L##).   

c) After the text variable, add the word to.  In the description window, enter the following: &.From 
the context menu, choose New Variable.   
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d) In the selection box, select New from the start of the list and choose OK.  On the General 
Information page, enter: 
 Variable name: BI505L## 
 Description: GR##TextVar.Month(to) 
 Processing by: Replacement Path 
 Choose Next. 

e) On the Characteristic page, choose the following settings: 
 Characteristic Cal. Year/Month (0CALMONTH)  

f) Choose Next. 

g) On the Replacement Path page, enter: 

 Replace Variable With: Name (Text) 

 For Intervals Use: To Value  

h) Choose Next. 

i) On the Save Variable page, you get an overview of the settings you have made.   Choose 
Finish.  The text variable that you have defined appears in the description with its technical 
name enclosed in &. 

  5.        Save the query   Description: GR##BI505Variables1. 

 Technical name: BI50513M##. 

 Execute the query. 

    Keep the query open for the next task. 
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Task 2  

You now want to display the sales organization as a hierarchy in your report and select the hierarchy at 
runtime.  

By using a hierarchy node variable, you can select individual hierarchy nodes flexibly.  

1. In the query definition of GR## BI505 Variables1, restrict the sales organization to a hierarchy node 
variable, which you create as new. Define the hierarchy node variable to allow the entry of multiple 
single values and to also allow changes to be made during query navigation.  

Enter the following description:  

Description: GR## Hierarchy Node Var. 

Technical name: BI505N## 

Once you have created the hierarchy node variables, stay in the selection dialog box for sales 
organization to define the hierarchy variable in the second step.  

2. Open the global query definition for GR## BI505   Variables1 (BI50512M##).  From the 
context menu for sales organization choose Restrict → Variables tab page.  You see the 
characteristic value variables in the selection list. You have to select a hierarchy in order to 
switch to the hierarchy node variables.   Select a hierarchy, for example PM sales 
organization: Choose From Hierarchy. From the context menu in the left selection window, 
choose New Variable.  

 
Steps to carry out 

a) Add the sales organization characteristic of the sales area dimension to the rows. 

 
b) From the sales organization context menu, select Restrict. 

c) Click on the variables tab and create a new variable. 
 

d) On the General Information page, enter: 
Variable name: BI505N## 
Description: GR## Hierarchy Node Var. 
Processing by: User Entry/Default Value 
Choose Next. 

e) On the Details page, choose the following settings: 
Variable represents: Multiple Single Values 
Variable Entry: Mandatory 
Ready for Input: Set the flag to active 
Can be changed in query navigation: Set the flag to active 
Choose Next. 
On the Default Values page, choose Next: 

f) On the Save Variable page, you get an overview of the settings you have made. 
Choose Finish. Do not leave the Selection for sales organization dialog box.  
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2. You also want to be able to select the hierarchy flexibly at runtime. To do this, define a hierarchy 
variable and include this in the query.  

Description: GR## Hierarchy Var.  Technical name: BI505P##a) In the Selection for     

Sales organization dialog box, transfer your hierarchy node variable into the selection window using  

Drag&Drop, call the context menu for the hierarchy node variables that you transferred and  

choose Select Variable Hierarchy.  Set the flag for variables and choose New Variable. 
 

Steps to carry out 
a)  

    Create a New variable. 

On the General Information page, enter: 
Variable name: BI505P## 
Description: GR## Hierarchy Var. 
Processing by: User Entry/Default Value 
Choose Next. 

c) On the Details page, choose the following settings: 

Variable represents: Multiple single values 

Variable entry is: Optional 

Ready for Input: Set the flag to active 

Choose Next. 

On the Default Values page, choose Next: 

d) On the Save Variable page, you get an overview of the settings you have made. Choose 
Finish.  

e) From the list in the Name field, select the hierarchy variable that you defined. Choose OK. 
Close the Selection for Sales Organization dialog box by choosing OK.  

 
3. Save the query and then execute it. Select a hierarchy and two hierarchy nodes. Set  another 
hierarchy node in the query as a filter for the material.  
 
Steps to carry out 
 a) Save the query and then execute it. Using the context menu, set another    

 hierarchy node in the query as a filter for the sales organization.  
  
4. Which hierarchy nodes can you select?  
 

Answer: All hierarchy nodes in the selected hierarchy can be used as filter values.  

5. Which hierarchy nodes would you be able to select if you had created the hierarchy node variable 
so that the variable cannot be changed during navigation?  

Answer: If the variable cannot be changed during navigation, you can also choose the nodes 
beneath the selected node.  
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Task 3  

You want to display the Net Value Stat.Cur of your customers for a time period that is selected by the 
user. You also want to display the number of selected months in the interval and the average Net Value 
Stat.Cur per month.  

1. Create a new query based on the 0D_SD_C03  

Transfer the characteristic Sold-to Party  into the rows.  

Include the basic key figure Net Value Stat.Cur in the columns, restricted to the characteristic Cal. 
Year/Month (0CALMONTH). Restrict Cal. Year/Month by the characteristic variable that you 
created (GR## Month Interval (BI505K##)).  

In order to list the number of months in the interval in the report, define a new formula variable as a 
new calculated key figure on query level with the following description:  

Variable name: BI505Q## 

Description: GR## Number of Months 

This uses the replacement path to calculate the difference between the interval limits of the 
variable GR## Month Interval (BI505K##) for Cal. Year/Month.  

Steps to carry out 

a)  Use Drag&Drop to transfer Sold-to Party from the Customer  

 dimension into the Rows.  

 Use Drag&Drop to include the basic key figure Net Value Stat.Cur  in the 
 columns.  

 From the context menu for Net Value Stat.Cur   
choose Edit → Dimensions→ Time.  
Transfer Cal. Year/Month to the right window using Drag&Drop.  
From the context menu for Cal year / month, choose Restrict .  
Choose the Variables tab page and transfer the variable GR## Month Interval 
(BI505K##) using Drag&Drop.  

   
 
c)  From the context menu for the Key Figure structure, choose New  
 Formula.  
 In the Operands field, from the context menu for Formula Variables,  
 choose New Variable.  
 
d)  On the General Information page, enter:  
 Variable name: BI505Q## 
 Description: GR## NumberOf Months 
 Processing by: Replacement Path  
 Choose Next.  
 
e)  On the Characteristic page, choose the following settings:  
 Characteristic Cal. Year/Month (0CALMONTH)  
 Choose Next.  
 
f)  Replace variable with: Name(Text) 

On the Replacement Path page, enter:  
 For Intervals Use: Difference  
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 On the Currencies and Units tab page, the dimension ID is set as  
 A number.  
 Choose Next.  
 
g)  On the Save Variable page, you get an overview of the settings you  
 have made.  
 Choose Finish.  
 
h)  Open the formula variables directory and use Drag&Drop to transfer the   formula 
variable that you defined(GR## Number of Months).   Enter Number Of  Months as the 
description. Choose OK. 

2. Use the formula variable GR## Number of Months to create a new formula that calculates the 
average Net Value Stat.Cur per month in the selected time period.   Save the query Description: 
GR##BI505Variables2. 
Technical name: BI50513R##. 
Now execute the query. 

 
Steps to carry out 

 a)  To create the new formula, choose New Formula from the context 
menu for the key figure structure.  
Name it Ratio of net value to number of months. 
Use Drag&Drop to transfer Net Value Stat.Cur into the formula field.  
Choose Divided by"/"  
Choose Formula Variable: GR## Number of Months.  
Choose OK.  

 Save the query, Description: GR##BI505Variables2. 
 Technical name: BI50513R##. 
 Execute the query.  
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Task  

You want to create a query that contains the sales organization as a variable in the filter area, with a 
variable request for a specific month and the material in the free characteristics. You want to display the 
selected sales organization in the query header. You want to enable the user of the report to define a key 
date variably to display changes to the revenue class of individual customers. In the report drilldown, you 
want to include customers with the revenue class attribute and the sales volume and Open Order net 
value key figure evaluations. You do not want to display the currency in the rows, but rather in the column 
header of each key figure. You want to give zero values the message Check! And give the user the option 
of accessing documents for individual objects. You want to display the overall result in the top-right of the 
report to give an immediate overview.  

1. Create a new query based on the 0D_SD_C03 cube with the sales organization characteristic as the 
filter with a variable request (Sales Organization). Use material and calendar year/month as free 
characteristics and give the calendar year/month a variable request (use a variable that you created 
in previous exercise). Include the sold-to party characteristic in the rows and give it the country 
attribute. Select Open Orders key figures and drop it into columns.  

Steps to carry out 

a) In the Query Designer: New Query dialog box, make the following definition:  

a. Use Drag&Drop to include Dimensions → Sales Area → Sales Organization in the 
Filter area.  

b. Click with the right mouse button on Sales Organization → Restrict. 

c. On the variables tab, choose the existing variable Sales Organization (0D_SA_OR).  

d. Add this to your selection and choose OK.  

e. Use Drag& Drop to include Dimensions → product → Material in the Free Characteristics 
area.  

f. Use Drag& Drop to include Dimensions → Time → Cal. Year/Month→ in the Free 
Characteristics area 

g.  Click with the right mouse button on Cal. Year/Month → Restrict. 

h. Go to the Variables tab and choose a time variable you created in a previous exercise.  
Add this to the selection and choose OK.  

i. Use Drag&Drop to include Dimensions → Customer → Sold-to Party in the Rows  

j. With the right mouse button, select Sold-to Party → Attributes → Country.  

k. Use Drag& Drop to include Key Figure → Open order in the Columns.  

2. Use the query properties function to define a text variable (Text Sales Organization) in the query 
description which will display the name of the sales organization selected.  Write the description as 
follows and place the text variable after the abbreviation of the  sales organization (SLORG):  
Description: GR##BW305BW305BW305BW305PropertiesSLORG 
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Steps to carry out 

a) From the Query Designer toolbar, choose Query Properties  and make the following 
settings:  

General tab → Description: GR##BW305BW305BW305BW305PropertiesSLORG, 

select the Select Text Variables symbol ( ). 

 highlight the variable Text Variable Month (from) and confirm with OK.  

3. Since the key date is to be variable in the query, find the relevant variable for this Key Date.  
 
Steps to carry out 

a)    On the same tab page, go to Key Date using the Values button ( ). 
b) On the Variables tab, select Key Date (technical name zkey_date).  

 
4. Now set the scaling factors, document links and Drag&Relate links and change the results position to 

the top-right. Also specify the type of zero display in the query properties and define the text "Check!" 
for this.  

 
Steps to carry out 

a. Still in the query properties, go to the Display tab.   

b. In Display Options put a check in the boxes for:  

a. Display Scaling Factors for Key Figures  

b. Display Document Links  

c. Display Drag&Relate Links  

c. Under Number Format → Results Position select Top/Right  

d. In the dropdown that currently says “display zeros”, choose “Show Zeros as” 

e. In the Show zeros as entry box, put the text “Check!”.  

5. Now save the query definition  

Description: GR##BW305BW305BW305BW305PropertiesSLORG &0T_CMONT& 

Technical name: BW305BW305BW305BW30515A## where ## corresponds to your group number. 
Execute the query on the web. 

Steps to carry out  

a. You have already defined the description for the query under Query 
Properties. The query name defaults to this.  Therefore, you only have to enter 

the technical name when you save the query.  
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Task 1  
As the basis for your task, you need to create a query definition that contains the navigational attribute 
Division in the rows, restricted to High Tech with a drilldown by material. Display the Division by Name 
and the Material by Key. In the rows, list the Sold to Party with an additional breakdown by customer. 
Display the Sold to Party characteristic required here by Name. To enable users to access documents in 
the executed report without the need for additional settings, you have to define this in the query definition.  
 
1. Create a new query using the SAP Demo Sales and Distribution InfoCube (0D_DECU). Include the 

characteristics Division and the Material dimension in the rows. Restrict Division to High Tech. 
Select Sold to party for the rows area.  

Steps to carry out 
a) Select SAP Menu → choose New.  Base your query off of SAP Demo Sales and 

Distribution -> SAP DemoCube.  
b) In the Query Designer, make the following definition:  

i. Transfer Division (from the organization dimension) and Material (from the product 
dimension) characteristics to the Rows using Drag&Drop.  

ii. Right click on Division, choose Restrict. 
iii. Choose High Tech for the restriction and click OK.   
iv. Transfer Sold to Party (from the customer dimension) into the rows.    
v. Transfer from Key Figures Net Value and Billed Quantity into the columns. 

 
C) From the context menu for material, choose → Properties  

D) Under Display As, choose Key 

E) Use the same process for Division and Sold to Party, but change the display as to be name. 

F) Under Query Properties, set the flag for Display Document Links on the Display tab.  

 
2. Now save the query definition  

Description: GR##BW305DocumentIntegration 
Technical name: BW30516A##,  

Steps to carry out 
a) In the Query Designer, click the Save Query button. 

b) Make the entries described above, Quit and Use Query or Display Query on Web.  
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Task 1  
You need to create a query to track your purchasing habits with various vendors within the first half of 
1999 and set warnings for your management.  
You need to create two exceptions for this query definition.  
1. Create a new query using the SAP Demo Purchasing Data (0D_PU_CO1) cube.  Please 
include  material group and vendor from the characteristics.  Set free characteristic for country.  
 
Steps to carry out 

Select SAP Menu → SAP Demo Purchasing Cube (0D_PU_CO1) and choose New.  
            
  

a) In the Query Designer, use Drag&Drop to include the characteristics Material Group (From 
the Material Group dimension) and Vendor (from the Vendor Group dimension) in the rows.  

b) Drop Country (from the Country Key dimension) into free characteristic.   
c) Drop Key figure Order Value and characteristic Ca.Year/Month into columns. 

 
2. In the BEx Query Designer, using Exception, create a New Exception. Define the description 
Exception Absolute Values and put a check in the Active checkbox. For Evaluation for → Key Figures 
choose Order Values and on the Exception Values tab, define the following absolute values:  

 
 

From  To  Alert Level  

(Leave field empty)  
10000  Bad 9  

10000  100000  Bad 7  

100000  500000  Medium 5  

500000  1000000  Good 3  

1000000  (Leave field empty)  Good 1  
 
 Confirm your exception by choosing OK.  
 

Steps to carry out 

a) From the main screen of the BEx Query Designer, click the Exception  button. 
b) If you don’t have any exceptions created yet (which we don’t) you are automatically 

brought to the New Exception definition. 
a. For the Description put Exception Absolute Values  
b. Make sure the Active check box is filled in 
c. In the Evaluation for → Key Figures drop down, select Order Value. 
d. Go down to the Exception Values tab 
e. Click New 
f. Enter the first from and to values and the corresponding alert level listed above, 

then confirm with Transfer to place your entries in the list.  To define an open 
value, leave the field empty.  Enter the rest of the entries in the table above. 

g. Save your exception by choosing OK.  
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3. Now save the query definition  
 Description: GR##BW305Exceptions 
 Technical name: BW30517A##,  
 
4. You now see that only the overall result of your key figure Order Value is in color. To include 
 other results in your exception, return to the query definition and to your exception and from the 
Cell Restrictions tab page, select All (Recommended with Relative numbers)  
 
 
Steps to carry out 

a. From the main Query Designer screen click the Exceptions button.  
b. You can either click the little arrow on the exceptions button and select Change Exception or 

you can click the main part of the button and select Exception Absolute Values then click 
OK.  

c. Go to the Cell Restrictions tab and find the default operator used for all characteristics that 
are not displayed. 

d. Select All (Recommended with Relative Numbers) from the drop down and confirm the 
exception with OK.  

 
5. Now your report shows all the entries shaded for the exception.  Create a new selection Half 

Year for the period January 1999 to June 1999 in the key figure context menu.  Include the 
Order Value key figure in the selection. Save and execute the query, now you see results only 
for that half a year. 

 
Steps to carry out 

a. From the context menu of Key Figures, select New Selection. 
b. For the Description type Half Year.   
c. Drag&drop the key figure Order Value into the description window. 
d. Drag&Drop Cal.Year/Month into Description 
e. Right click on Cal. Year/Month and choose Restrict. 
f. SelectValue Range and Between 
g. Cntl+click January 1999 and June 1999 and add them to the selection. 
h. Click OK. 
i. Click OK again to save your selection.  

 
 
Save the query.  View it in BEx. 
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Unit 9 – Exceptions (optional) 
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Task 
You require a query showing the sales for June 2002 for all customers. You want to use an exception 
to report on the key figure Open order net value. In the query, different levels of sales should receive a 
different color. 
1. Create a query using Info cube SAP Demo Sales and Distribution overview Cube (0D_SD_C03).  

 Put the key figure Net Value in stat.Cur (0D_NETVAL_S) in the columns and the characteristics 
Sold-to Party and Calendar Year/Month in the rows.  Restrict the characteristic Calendar 
Year/Month to June 2002. 

 
2.  Assign different colors to the key figure values to highlight the different levels of sales volume. 

 Create an exception called GR##Sales for the key figure Net Value in Stat. Cur. Test for the 
exceptional characteristic levels. Specify the following alert levels: 

From To Alert Level 

0 10,000 Bad9 

10,000 100,000 Bad8 

100,000 300,000 Bad7 

300,000 500,000 Medium6 

500,000 600,000 Medium5 

600,000 800,000 Medium4 

800,000 1,000,000 Good3 

1,000,000 2,000,000 Good 2 

2,000,000 10,000,000 Good 1 
 

Steps to Carry out  
a) In the query definition screen, choose exception -> New exception. 

 
Enter the following values: 
Field Value 

Description Sales  

Active checked  

Evaluation for Key Figures Net Value in stat.Cur 
(0D_NETVAL_S)  

 
 b) On the Exception values tab strip, select the New button and enter the specified values in 

the  columns. Confirm your entries each time you complete arrow using the Transfer button. 
Use  the drop-down arrow to assign the Alert Level. 
c) On the Cell Restrictions tabs trip, in the field Default operator used for all, choose All 

(recommended with relative numbers). 
 d) Confirm your entries with OK. 

3. To standardize the basis of the exceptions, translate the currency into US Dollars (5 Dec) 
(USDN) for the key figure Sales Volume using the mean exchange rate based on today’s date. 
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Steps to carry out 
a) In the BEx Query Analyzer on the context menu of Net value in stat.Cur select 

properties. 
b) Find the currency translation section of the window that pops up and enter the data 

below. 
Field Value 

Target Currency US Dollars (5 Dec) (USDN) 
  

Conversion Type Average Rate – Current date  
 

Confirm your entries with OK. 
 
4. For the characteristic Calendar Year/Month, suppress the totals rows to avoid the same 

information being displayed repeatedly. 
 
Steps to carry out 

 a) In the query definition, right-click Cal. Year/Month and select Properties 
b) In the Result display section, change Suppress results rows to Always 
c) click OK. 

 
5. Save and execute the query using the values below: 

Technical Name: GR##09 
 Description: BW305GR## Exceptions 
 

Note that when you run the query you might get warnings saying conversion rates are not 
available.  This is why some of the data is not converted to US dollars. 

 
 

6.  Sort the results of the Net Value in stat.Cur (0D_NETVAL_S) column in descending orders so as 
to  get a better overview. 

 
Steps to carry out 

 a)  Place the cursor in any cell in the Net Value in stat.Cur (0D_NETVAL_S) column, right-
click and select Sort→ Descending. 

  
7. Save the query in your Favorites folder as a new workbook named BR505GR## Exceptions.  

After saving the workbook, close the BEx Analyzer. 
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Task 
In this exercise, you will create a condition to select only the top ten customers that placed the largest 
orders with you for June 2002. 
1. Begin by creating a new query using the Info Cube Demo Sales and Distribution overview Cube 

(0D_SD_C03) found in the SAP Demo Info Area. 
Create the query to show the top ten customers based on Net Value in stat.Cur in the month of June 
2002. 

 
 

Rows Sold-to party 

Columns 
 Net value in statistic currency 

Free Characteristics Cal. Year/Month 

Filter None 
 

Steps to carry out 
a) From the BI Easy Access Menu, choose Business Explorer→ Query Designer 

b) Open→ Queries→ 0D_SD_CO3→ New  

c) Take Sold-to Party from the Customer Dimension and drag it to Rows . 

d) Drag the key figure Net value in stat. cur to Columns. 

e) Drag the cal. Year/month characteristic from the Time Dimensions to Free 
Characteristics.  

f) Right-click Cal. Year/Month and choose Restrict 

g) Select Single values selection and select June 2002. Confirm your entries withOK.  

h) On the query definition screen, select Condition→ New condition.  

i)  Enter the following values: 

Field Name Value 

Description GR## June 2002  

Active checked  

Evaluate the 
conditions...for 

all characteristics in the drilldown 
independently  

Key figures Click ’New’ button then  
 select Net Value Stat.Cur  
Operator Top N  

Values 10  
 

Confirm your entries with Transfer, then OK. 
2. Save and execute the query using the following names: 
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b) Enter the Technical name and Description as specified. 

c) Execute the query. 

3. Hide the totals rows in your local query view.  
 
Steps to carry out 

a) Right-click one of the Sold-to party values and choose Sold-to party→ Suppress results row→ 
Always. 

 
4. Save the query in your Favorites folder as a new work book named GR## Conditions. 
 
Steps to carry out 

a) On the BEx tool bar, choose Save→ Save as new work book.... 

b) Select the Favorites folder. 

c) Enter GR## Conditions in the Description field. 

d) Confirm your entries with OK. 
 

 


